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1 INTRODUCTION 

1.1 Product Overview 

Perception is a software product designed to assist power plant personnel in the 

maintenance and management of oil-insulated equipment used in the transmission and 

distribution of electrical power. It is used primarily for diagnosing fault conditions as well 

as trending measurements taken from transformers, circuit breakers and tap-changers. 

The software accepts data from either manual or automated programs of regular 

sampling and condition analysis of the equipment’s insulating oil as well as other 

performance data. Several well-established and recognized empirical diagnostic rules 

are used to present information to the user on the condition of the insulating oil used in 

the electrical equipment. This assists in the running of a maintenance program and in 

the identification of potential fault conditions. It allows both the maintenance engineer 

and asset manager to monitor and diagnose transformer data collected by GE’s range of 

on-line monitoring units. The data includes Dissolved Gas Analysis (DGA), calculated 

models, bushing and other transformer measurements. By providing access to this 

valuable data along with powerful diagnostic tools, Perception delivers clear transformer 

condition information. This enables decisions to be made quickly and reliably, helping to 

extend the life of transformers, reduce unplanned outage, and avoid catastrophic failure. 

Although Perception is an expert analysis and information system, it is only an aid and 

should not be regarded as a replacement for the knowledge of a subject matter expert in 

the analysis of insulating oil used in electrical equipment and the operation of oil filled 

power equipment. 

1.2 Software Family 

There are four members of the Perception family. 

▪ Perception Desktop — A standalone software application that provides customized 
access to the centrally located asset database. It provides advanced diagnostic 
profiles on device data, a multi-page transformer report containing key transformer 
information as well as the facility to launch external applications. Additionally, 
Perception Desktop can operate standalone or as part of a larger centralized asset 
management suite in conjunction with Perception Server. 

▪ Perception Server — The pinnacle of transformer asset management software. 
Perception Server provides a fleet-wide network overview via a wallboard display, 
automatic data downloading with configurable scheduling, email notifications of 
device condition changes and a TOA4 data export facility. It uses a centralized data 
storage location based on SQL Server to which Perception Desktop links seamlessly 
via secure OPC UA communications. 

▪ Perception Web — A web-based solution that provides read-only access to the 
centrally located asset database. This offers a convenient way to obtain readings and 
consolidated data analysis across a variety of platforms including mobile devices. This 
includes transformer dashboards, wallboards and an overview to the status of the 
entire transformer fleet. 

▪ Perception Workflow Designer — The workflow designer uses common flowcharting 
techniques to express transformer diagnostic processes as a model. These models 
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are known as workflows and in turn drive the Perception dashboard. The Designer 
brings easily modifiable workflow-enabled capabilities to the Perception software 
suite allowing control over the diagnostic process and customization of how data is 
presented on the Perception dashboard. 

Note: Perception Express is no longer available and should be removed since 
Perception Desktop includes all this functionality and more. 

1.3 What’s New in Version 2.2.1? 

▪ DGA 900 Plus — support for the latest GE monitoring device. 

▪ Asset Hierarchy updates — DGA 900 Plus, Plant, 845 Relay, Motor and 869 Relay – 
these new asset hierarchy nodes are supported, but an additional installer is required 
to create or manage 845 Relay, Motor and 869 Relay nodes. Hydran M2 asset also 
renamed to Hydran M2\M2-X. 

▪ MS 3000 — download the onboard Risk Index results from MS 3000 monitoring 
devices so that the Risk Index data can be visualised in Perception on the 
transformer’s Dashboard worksheet. Also a new Overvoltages worksheet plots any 
spikes in voltage over time. Perception also alerts users of service notifications 
received from the MS 3000. Some minor usability and performance enhancements to 
the Web Browser worksheet. 

▪ CB Watch 3 — download additional circuit breaker measurements points to log and 
trend over time. Perception applies special logic to control the download of data on 
the opening, pumping and closing operations, as well as continuous measurements of 
the circuit breaker, and allows configuration of the polling frequency. 

▪ DGA 900-family — assign a network port number for the HTTP/HTTPS connection. 

▪ BMT 300 / 330 — support for multiple BMT 300 / 330 monitors on a single 
transformer. 

▪ Relative Saturation percentage (RS%) — the RS% value is downloadable from Transfix 
and DGA 900-family devices. 

▪ Data Table tool tip — includes a description of PGA error codes and measurement 
flags. 

▪ Event type — a new data point type that represents the occurrence of an event. 
Supported in the 869 Relay and MS 3000. 

▪ Localisation — Perception automatically detects the current regional language mode 
of the host Windows operating system and displays the Perception text in the native 
regional language. If the regional language is not supported Perception reverts to the 
English language. The Perception user manuals are also available in these supported 
languages. 

▪ User Manuals — access to the Perception user manuals can be invoked directly from 
the Perception Server Configuration tool and Perception Desktop software. 

Note: If upgrading to Perception Desktop/Server 2.2.1 from version 1.X, please 
contact GE Support before commencing as depending upon the size and 
complexity of the existing database, a service visit may be required to make the 
transition. 
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1.4 Desktop Features 

Perception Desktop offers the following: 

▪ Can be used as a stand-alone application or as a client application in a large 
centralized Perception Server environment 

▪ Wallboard facility gives an overview to the entire fleet 

▪ Trend charts for any measured parameters, including polar plots for Bushing Monitors 
and Partial Discharge (Intellix BMT devices) 

▪ Current status and data history displays 

▪ Configure the data upload frequency from remote monitors 

▪ Pre-set trend and diagnostic graphs for dissolved gases 

▪ User-configurable trend graphs for any monitored parameters 

▪ Gas Ratio trend charts 

▪ Preset fault monitoring displays utilising Gas ratios (IEC60599 & IEEE C57.104, 
Transformer Condition, Rogers Ratio and Doernenburg Ratio), Duval’s diagnostics and 
Japanese ETRA standards 

▪ Models for Intellix MO150 & Hydran M2 devices (see Section 4.15) 

▪ Transformer Report for an overview to key information on a transformer’s condition 
based on the dissolved gas measurement analysis and user input (see Section 5.5) 

▪ Facility to launch external applications from within Perception Desktop (see Section 
5.7) 

1.5 System Requirements 

The minimum PC and system requirements for Perception Desktop are: 

Operating System: Windows 7 with .NET Framework 4.5 

CPU: 2 GHz Processor 

Memory: 2 GB RAM 

HDD: 10 GB free 

Graphics Card: 64 MB graphics, update to the latest driver for your hardware to 

ensure that it can provide all the facilities of NET Framework 4.5 

Note: Windows 8 does not enable Microsoft .NET 3.5 features by default. However, all 
Perception installers require .NET 3.5, so you will be prompted to enable it. 
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1.6 Software Licensing 

Perception Desktop uses a tier-licensing model when used with Perception Server. This 

provides greater flexibility to add devices and manage license expiry. There are six tiers 

in the model, as listed in Table 1-1, with each tier supporting an increasing number of 

devices according to a range of accumulated device weightings. 

Table 1-1: Tier scores 

Tier Accumulated 
weightings 

1 0-50 

2 51-100 

3 101-150 

4 151-250 

5 251-500 

6 501+ 

The weighting scores for each type of device are listed in Table 1-2. 

Table 1-2: Device scores 

Device Weighting 
Score 

Offline 1 

201Ti 2 

Hydran M2 3 

MO150 4 

Minitrans 4 

CB Watch 4 

Transfix 5 

DGA 500 5 

DGA 900 5 

BMT 300 5 

Dualtrans 6 

Taptrans 6 

Multitrans 6 

Transfix Plus 6 

TMS 7 

MS 3000 7 

You can add any number of devices and assets within the limits set by the Perception 

fleet license tier. To add further devices or assets requires a license upgrade — contact 

Customer Support. 

Note: Customers on an existing annual fleet licensing agreement can add assets and 
devices beyond the limits set by the new license tier. However, once the annual 
fleet license agreement expires, the license tier is recalculated and may require 
an upgrade to service all devices. 

Note: When connected to Perception Server, the Fleet Summary window becomes 
available in Perception Desktop and provides details on the Perception license 
tier including expiry date and a summary of the devices and assets that have 
been added to the database. 
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1.6.1 License Expiry 

A License Expiry message appears in Perception Desktop 90 days before the Perception 

fleet license is due to expire as shown in Figure 1-1. Reminder messages are 

automatically scheduled to reappear at 60 days, 30 days, 15 days and 5 days, or on each 

first launch of the application within the set days of the expiration period. 

 
Figure 1-1: License expiry notification 

A yellow warning icon also appears in the lower right corner of the application window 

with a tooltip when you rest the mouse pointer over it as shown in Figure 1-2. 

 
Figure 1-2: License warning indicator 

Perception Server restricts functionality after license expiration. The following features 

are disabled: 

▪ Transformer Risk Evaluations 

▪ Fleet Ranking 

▪ Transformer and Fleet Dashboard 

▪ Wallboard Fleet Visualisation 

▪ Perception Web 

▪ Expert Email Notifications 

2.2.1 
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1.6.2 Fleet Summary 

Perception provides a useful summary dialog with license tier details and all assets and 

devices that comprise the Perception Fleet. Select Help > Fleet Summary as shown in 

Figure 1-3. 

 
Figure 1-3: Help menu 

The Fleet Summary dialog displays as shown in Figure 1-4. 

 
Figure 1-4: Fleet Summary dialog 

1.7 Customer Support 

E-mail: GA.support@ge.com 

United Kingdom +44 1785-250-070 

North America toll-free: 1-800-361-3652 

Worldwide: +1 514-420-7460 
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2 INSTALLING & CONFIGURING 

2.1 Overview 

There are two main steps to installing and setting up Perception Desktop: 

▪ Install the Perception Desktop software on your PC. 

Note: It is advisable to use Windows Update to check that your PC is running an up-
to-date version of the ‘.NET Framework’ before launching the Perception 
Desktop installer. 

▪ Set up the connections to the Perception databases or Perception Server. 

Note: If you install Transport X software on your PC, you can also incorporate data 
from the Transport X portable range. 

2.2 Run the Perception Desktop Installer 

2.2.1 To install Perception Desktop, double click the 
Perception.Desktop.Setup.exe file. The Setup / Upgrade Wizard opens to 
guide you through the process as shown in Figure 2-1. Click Next to proceed. 

Note: The Perception.Desktop.Setup.msi file must also be available in the same 
location. 

 
Figure 2-1: Welcome to the Perception Desktop Setup Wizard 
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2.2.2 If the License Agreement is acceptable, select I accept the terms in the 
License Agreement and click Next as shown in Figure 2-2. 

 
Figure 2-2: License Agreement 
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2.2.3 Browse to select the installation folder or accept the default folder and click 
Next to continue as shown in Figure 2-3. 

Note: If your PC is shared with other users, you can choose to install Perception 
Desktop for use under your login account only, or for all user accounts of the 
PC. 

 
Figure 2-3: Select Installation Folder 
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2.2.4 Click Next to start the installation, Back to backtrack and change some of the 
selections, or Cancel to quit the process entirely, as shown in Figure 2-4. 

 
Figure 2-4: Confirm Installation 
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2.2.5 If you click Next, then the installation commences and a progress bar indicates 
the progress so far as shown in Figure 2-5. The installation may take some 
minutes. 

 
Figure 2-5: Installing Perception Desktop 
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2.2.6 The Setup Wizard completes the installation and presents the following 
message as shown in Figure 2-6. Click Finish to exit. 

 
Figure 2-6: Installation Complete 

Perception Desktop is now successfully installed. Other related software installations 

include: 

▪ Transport X: the data storage software supplied with the portable Transport X 
products. It is used to read the data from the portable devices. Perception Desktop 
can automatically interface with the Transport X software to incorporate that data 
into the main Perception database. To do so, the Transport X device must previously 
be installed on your PC. See the Transport X device manual for details and 5.8 for 
installation details. 

▪ Intellix BMT 300/330: the software used to configure and monitor Intellix BMT devices. 

▪ TransCom: the software used by Perception to support Transfix 1.0/1.5 devices. 
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2.3 Firewall Settings 

Perception Desktop must be allowed to communicate with Perception Server through 

your firewall. This requires opening certain ports for inbound connection on the 

Perception Server firewall. The UA Discovery Server application should also be added as 

a permissible program to send and receive through the firewall. Note: Your firewall 

settings are maintained by your IT administrator. 

2.3.1 Perception Server ports 

Perception Server requires the following ports to be opened: 

▪ 502 (for Taptrans devices) 

▪ 5000 (for Hydran devices) 

▪ 62541 (to allow the client to read the server configuration via Discovery Server) 

It is recommended that the Perception database be located on the same server as 

Perception Server. If not, then the following additional port needs to be opened: 

▪ 1433 TCP (to allow the client to connect with the SQL Server) 

2.3.2 Perception Client ports 

Perception Desktop requires the following ports to be opened: 

▪ 4840 (for Perception Server to be discovered) 

▪ 62541 (to allow the client to read the server configuration via Discovery Server) 

▪ 1433 TCP (to allow the client to connect with the SQL Server) 

2.4 Create a New Database Connection 

Launching the Perception software for the first time prompts for a database connection 

in order to use the software as shown in Figure 2-7. 

 
Figure 2-7: Getting Started 
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Having installed and authenticated the Perception Desktop software, you should now 

establish a database connection Note: This task need only be performed once. 

Perception Desktop allows the user to connect to a Perception Server database (as 

outlined in Section 2.4.1) or to a local (file-based) database as outlined in Section 2.4.1.1. 

2.4.1 Create a new connection to a Perception Server database 

Note: Perception Server must be installed prior. The Perception Server database is 
created and administered by your System Administrator. 

To establish a new connection with a Perception Server database, start Perception 

Desktop and select File > Connect as shown in Figure 2-8. 

 
Figure 2-8: Connect to an existing database 

The ‘Login’ dialog box as shown in Figure 2-9 allows you to specify the connection details. 

Click the (…) browse button to configure the server connection. 

 
Figure 2-9: Login 
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The ‘Configure a Server Connection’ wizard opens as shown in Figure 2-10 and is 

designed to assist you with the configuration. Click Next to proceed. 

 
Figure 2-10: Configure a Server Connection 

Type the Discovery IP Address or Discovery hostname and click Next as shown in Figure 

2-11. 

 
Figure 2-11: Enter Discovery Server 

The Server Name 
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The Discovery Server lists all Perception Server databases that it finds as shown in Figure 

2-12. Select the database that you wish to establish a connection with and click Next. 

 
Figure 2-12: List of Perception databases 

The ‘Configure Options’ step of the wizard then invites you to confirm the security 

settings for the connection. Figure 2-13 shows the default security settings — make any 

changes if required and click Next. 

Note: Consult with your network administrator to confirm if any of these settings 
should be changed. 

 
Figure 2-13: Configure Options 

urn: server name:Perception.Server.AAA-123ABCD 
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A confirmation message displays the chosen settings and indicates that the server 

configuration is now complete as shown in Figure 2-14. Click Finish to proceed. 

 
Figure 2-14: Server Configuration Complete 

You are returned to the Login prompt as shown in Figure 2-15. Choose the 

Authentication method to be associated with this connection, and finally, enter the user 

name and password and click OK. 

Note: Your System Administrator will have these login details. 

 
Figure 2-15: Login prompt 

When connecting for the first time, you will also need to ensure that the respective 

certificate on both the client and server are trusted. See Section 2.4.2.1 for trusting the 

Server certificate and speak to your System Administrator for trusting the client 

certificate. 

2.4.1.1 Trusting Perception Certificates 

As a security measure, Perception uses electronic credentials known as certificates to 

authenticate clients and servers. Every time a new Perception Desktop client is added, 

both the client and the server administrator must trust each other’s certificates (or 

physically exchange certificates as outlined below). This ensures that the requisite trust 

The server address / Perception Server 

The server address / Perception Server 
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exists between client and server. Once the certificates have been exchanged, seamless 

communication can take place. 

When you try and connect a Perception Desktop client to the server for the first time, 

the connection will be rejected as shown in Figure 2-16. 

Note: With every attempted connection, the Server’s certificate is automatically 
copied to the client’s rejected folder and the client’s certificate is automatically 
copied to the server’s rejected folder. 

 
Figure 2-16: Server certificate not trusted 

This is because the client does not trust the server. To trust the server certificate, the 

certificate must be moved from the client’s rejected certificate store and added to the 

client’s trusted certificate store. 

To do this, open File Explorer and navigate to the rejected folder at this location: 

C:\ProgramData\GE_Energy\Perception\RejectedCertificates\cert

s 

Note: In Windows 10, the ProgramData folder may be hidden. If so, show hidden 
items in the File Explorer View menu. 

Look for a certificate of the following format: 

Perception.Desktop.<computer name>[key].der 

Where <computer name> is the computer name of the server, and [key] is the public 

certificate key. 

Move this certificate to the “TrustedCertificates\certs” folder at this location: 

C:\ProgramData\GE_Energy\Perception\TrustedCertificates\certs 

When you try to connect again you will get another connection error as shown in Figure 

2-17. 

 
Figure 2-17: Client certificate not trusted 

This is because the server does not trust the client. To trust the client certificate, the 

certificate must be moved from the server’s rejected certificate store and added to the 

server’s trusted certificate store. 
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Note: Contact your Server Administrator to have the relevant steps taken on the 
Server side. 

All these steps must be performed after every first connection attempt of a new user 

and so requires both client user and Server Administrator to move the respective 

certificate to the “trusted folder” on their respective machine in order to establish a 

trusted relationship and thereby permit communication. 

2.4.2 Create a new local database 

To create a new local database for Perception Desktop, select File > New Database as 

shown in Figure 2-18. 

 
Figure 2-18: New Database option 

In the Create New dialog, navigate to the save location, enter a name for the local 

database file and click Save as shown in Figure 2-19. 

Note: The file type uses the file extension “.kpd” to denote a Perception Desktop 
database file. 

 
Figure 2-19: Save the local database 
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The new database is represented in the Asset Explorer pane of Perception Desktop as 

shown in Figure 2-20. See Section 3.2 for methods of adding data to the local database. 

 
Figure 2-20: New local database 

2.4.2.1 Connect to an older version KPD local database (for the first time) 

When you open an older Perception local database* for the first time (i.e. after upgrading 

to version 2.2.1), it will be upgraded to the latest format. You will be prompted as shown 

in Figure 2-21. 

*Note: This is not suitable for SEI files from Perception 0. For details of how to upgrade 
an SEI database, please contact GA.support@ge.com or a GE technical 
engineer. 

 
Figure 2-21: Upgrade Local Database Format 

If you click Yes, the local database is upgraded to the latest format. A progress bar 

indicates progress, but it can take considerable time depending on the database size. If 

you click No, the Load operation is aborted. 

Note: The upgraded database can no longer be read by previous versions of 
Perception. During the upgrade process, a backup copy is created in the original 
format, but using “3325” as the file extension instead of ‘.kpd’ (this number 
represents the original database schema version number.) If you wish to use 
this database for historical/archival reasons, then it can be read into a previous 
Perception version. Before attempting to do so, change the database filename, 
or move its location and change its file extension back to ‘.kpd’. 
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3 ORGANISING ASSETS 

3.1 Introduction 

Upon successful connection to a database, Perception opens on the Database node 

showing a Fleet Overview page with a useful summary of the status of the entire fleet. 

See Section 3.2 for more details. 

If you have opened a new database, then no information will be shown until you add 

assets and set up the asset properties. See Section 3.2 and Section3.8. 

 
Figure 3-1: Fleet Overview 

3.1.1 Managing Database Connections 

Perception Desktop allows the user to connect to a Perception Server database or to a 

local database. 

Note:  You can only be connected to one database at a time. To connect to another 
database requires disconnecting from the current database. 

Note: For more details on the advantages of upgrading to a Perception Server 
database, please contact a GE sales representative. 

3.1.1.1 Connect to the Server 

To connect with a Perception Server database, select File > Connect… as shown in 

Figure 3-2. 
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Figure 3-2: Database Connect option 

The ‘Login’ dialog box displays as shown in Figure 3-3 with the Server field populated 

with the Perception Server if you have connected previously. 

Note: If the Server field is not populated or if you wish to change it, see Section 2.4.1. 

 
Figure 3-3: Perception database login 

Enter the username, password and click OK. 

Note: If forgotten, contact the System Administrator. 

Alternatively, if the Administrator has enabled anonymous access, sign on as an 

‘Anonymous’ user without the need for a user name or password (but with 

corresponding Observer status i.e. read-only permissions). This is accessed via the 

‘Authentication’ dropdown menu. 

Note: Refer to Section 2.4.1.1 if you receive a connection error relating to trusting 
certificates. 

3.1.1.2 Disconnect from the Server 

To disconnect from Perception Server, select File > Disconnect as shown in Figure 3-4. 
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Figure 3-4: Disconnect from Perception Server 

This action closes the connection to the Perception Server database and clears the Asset 

Explorer of all assets. 

3.1.1.3 Open a local database 

To connect to a local Perception database on your PC, select File > Open Database… as 

shown in Figure 3-5. 

 
Figure 3-5: Open local database 

This displays a list of local databases (those with the ‘kpd’ file extension), for example, as 

shown in Figure 3-6. 
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Figure 3-6: Local databases 

Select the local database that you wish to open and click Open. 

3.1.1.4 Close a local database 

To close a local database, select File > Close Database as shown in Figure 3-7. 

 
Figure 3-7: Close a local database 

This closes the local database and clears the Asset Explorer of all assets. 

3.1.2 Interface 

The main screen of the Perception Desktop is divided into two parts as shown in Figure 

3-8. 

▪ The Asset Explorer (denoted by the blue border) 

▪ The Data Area (denoted by the green border) 

The Database node is located at the top of the Asset Explorer hierarchy with all nodes 

structured below it. Select a node in the Asset Explorer on the left e.g. 

GE_Trans_Gen_02A to make it the active node (as highlighted in blue), and its details 

display in the Data Area to the right as shown in Figure 3-8. 
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Figure 3-8: Perception Desktop main screen 

3.1.2.1 Asset Explorer 

The Asset Explorer uses a tree-like structure to represent the hierarchy of assets and 

monitoring devices across multiple areas. Distinct graphical nodes represent Areas, 

Substations, Transformer Banks, Transformers, Circuit breakers and monitoring devices 

across the entire fleet. This tree-like structure provides a logical means of organising the 

assets and a useful means by which to navigate the hierarchy and find an asset. The 

Asset Explorer also features a Search box as shown in Figure 3-9 (left). Type the first few 

characters (minimum 2) of the asset name to filter the asset hierarchy as shown in 

Figure 3-9 (right). 

Figure 3-9: Asset Explorer – Search & results 

Click a side right-pointing arrow to expand a node and reveal its hierarchy or associated 

monitoring device. Typically an ‘Area’ sits at the top of the hierarchy, while a ‘monitoring 

device’ sits at the bottom of the hierarchy. 

The asset icons (or nodes) have a status indicator: 
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▪ Green Tick: All monitored parameters within bounds. 
 

▪ Amber Exclamation Mark: A parameter(s) has exceeded the 
High or Low thresholds.  

▪ Red Cross: A parameter(s) has exceeded the “High-High” or 
“Low-Low” or Ratio thresholds.  

▪ Purple: Indicates that there is uncertainty in the latest 
measurement accuracy, or the latest measurement is 
considered to be in error. Refer to the device data table. 

 

▪ Blue: Indicates the device has experienced a fault and 
requires a service.  

Note: The device status is reproduced up the asset tree so that the related 
Transformer, Substation and Area also reflect the status of its worst 
subordinate device. 

3.1.2.2 Data Area 

The Data Area shows the corresponding details as calculated or retrieved from the 

database for the selected node in the hierarchy. For example, Figure 3-8 shows the 

details for the transformer GE_Trans_Gen_02A (as selected in the Asset Explorer). 

The relevant data for the selected node is displayed across a series of tabs on the 

bottom of the screen (denoted by the purple border in Figure 3-8). The number and type 

of tabs vary according to the node. Selecting a tab opens the relevant tabbed page or 

worksheet. 

The last activated tab opens the next time the node is selected. The default tab for 

assets and monitoring devices is Properties. 

Note: To remove a tab, click the ‘X’ on the tab. It can be restored via the View menu, 
but a custom display tab can only be recreated manually. See Section 4.3.1. 

3.1.3 User Roles (Network databases only) 

Perception downloads the sampling data from your monitoring devices and stores it in a 

database. The database can be stored on your PC (known as a ‘local’ database), or stored 

at a remote location when used in conjunction with Perception Server (known as a 

‘network’ database). 

Note: A local database can only be accessed by users of that PC. 

When used in conjunction with Perception Server, there are three user roles: 

▪ Observer: ‘Read-only’ permissions to view the data of all devices, but cannot make any 
changes to the data or device settings. 

▪ Supervisor: ‘Read-write’ permissions, so can alter device settings including deletion of 
a device. 

▪ Architect: All the Supervisor permissions plus the rights to manipulate workflows 
including scheduling workflows. 

Note: A user of a local database always has full permissions for that database. 
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The User role for network databases is controlled by the Administrator of Perception 

Server. A Supervisor or Architect role can make changes that affect all users of the 

database. They can alter the data upload schedule, change the device hierarchy and 

delete devices and data. Therefore, it’s important to restrict the assignment of such roles 

to those that need this functionality and can be trusted with these permissions. 

Wherever the database is stored, local or network, it is the Perception Desktop 

application that downloads the data from the monitoring devices, whereas Perception 

Server is used to manage access to a network database. 
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3.2 Managing Assets 

You use the Asset Explorer to manage the network of assets and monitoring devices. 

Note: A Supervisor role (or higher) allows you to create, move and delete assets and 
devices (if used in conjunction with Perception Server). Those changes will then 
be visible to all other users of the database at the next refresh (normally within 
a few seconds). 

3.2.1 Adding Assets 

To add a new node to the hierarchy, right click on the node under which the new node 

will sit and select New as shown in Figure 3-10. You have the option of adding a new 

Area, Substation, Plant, Transformer, Transformer Bank, Circuit Breaker or a 

variety of monitoring devices. 

 
Figure 3-10: New nodes 

Plant is available by default as shown above, while support has been added for GE’s 

Multilin 845 transformer protection relay running firmware version 1.7 or later, and GE’s 

Multilin 869 Motor protection relay. 

Note: An additional installer is required to create and manage 845 Relay, Motor or 
869 Relay nodes. (Contact a GE sales representative to avail of this 
functionality.) 
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The 845 Relay device can be added as a child of the transformer allowing users to 

compare the data received from the 845 Relay with other monitored transformer data 

using the transformer worksheets. 

Motor assets are created at the same level in the asset hierarchy as a Transformer and 

behave in a similar manner. The 869 Relay device is the only child of the Motor that can 

monitor a Motor asset. 

The new node is added to the top of the Asset Hierarchy. For assets and monitoring 

devices, complete their properties via the Properties tabbed page as shown in Section 

3.8. 
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3.2.2 Renaming Assets 

To rename an existing asset, right click on it and select Rename as shown in Figure 3-11. 

 
Figure 3-11: Rename a node 

3.2.3 Deleting Assets 

To delete an asset, right click on it and select Delete as shown in Figure 3-12. 

 
Figure 3-12: Delete a node 

 

Warning: This action will delete the asset from the database entirely, 
including all data downloaded from that device. 

 

Warning: The deletion of an asset will also delete all its subordinate assets. 
If you are reorganising the hierarchy into new groupings, ensure that you 
move all the subordinate assets to new areas within the Asset Hierarchy 
before the deletion of a grouping. 

Before the asset is deleted, you must confirm your action as shown in Figure 3-13. Click 

Yes to delete the asset or No to cancel the operation. 
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Figure 3-13: Confirm Delete 

3.2.4 Moving Assets 

The nodes in the Asset Hierarchy can be grouped using drag-and-drop methods. You can 

move individual nodes, or move a tree of nodes under another node in the asset 

hierarchy, depending on the hierarchical level selected. 

To move a node, rest the mouse pointer over the node, then click and hold the left 

mouse button. Drag the node to its new position in the hierarchy before releasing the left 

mouse button. 

Before the node is moved, you must confirm your action as shown in Figure 3-14. Select 

Yes to move the node or No to cancel the operation. 

 
Figure 3-14: Confirm Move 

In the example shown in Figure 3-14, the asset “SubStation1” has been moved from the 

same level as “Area1” to a subordinate level under “Area1” (denoted by the indentation). 

 
Figure 3-15: Asset Explorer drag and drop 
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3.3 Fleet Overview 

If you select the top-level database node in the Asset Explorer, a Fleet Overview page 

displays with useful information summarising the health of the entire fleet as shown in 

Figure 3-16. 

 
Figure 3-16: Fleet Overview 

You can search for specific monitoring events using keywords in the Event Search box 

located at the top of the Fleet Overview page as shown in Figure 3-17. If you enter the 

name of an area, plant, substation or transformer, you will obtain all related transformer 

events for that area, plant, substation or transformer. Use the ‘Navigate to Asset’ link (as 

highlighted below) to navigate directly to the affected asset in the Asset Explorer. Use 

the Date boxes to filter events by date or click More to filter the search by event type as 

shown in Figure 3-17. 

 
Figure 3-17: Event Search 

Note: A similar Fleet Overview page exists at the database node level for Circuit 
Breakers. 
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3.4 Areas, Plants & Substations 

Assets can be arranged hierarchically in the Asset Explorer under Areas, Plants and 

Substations. Areas, Plants and Substations contain just one tabbed page called a 

Wallboard. A Wallboard is a visual overview of all assets and their status shown on an 

image, typically a map. A Wallboard can be configured for an Area, Plant, Substation, 

Transformer Bank, Transformer or Circuit Breaker. An example of an Area wallboard is 

shown in Figure 3-18. 

Note: A Plant represents a large industrial site where one or more Transformers or 
Motor assets reside. A Motor asset is a child asset of a Plant. 

 
Figure 3-18: Area wallboard example 

If used in conjunction with Perception Server, a Wallboard becomes a useful way to 

continuously monitor assets, for example, in a control room scenario. Perception Server 

facilitates a dynamic picture that updates as the condition of the assets change during 

automatic data download. See Section 3.9 

 for more information on setting up a Wallboard. 

3.5 Transformer 

Within a typical Asset Hierarchy there are multiple assets, such as Transformers and 

their monitoring devices. If you select a Transformer, a series of tabs display in the 

tabbed list at the bottom of the Data area. The default active tab is Properties as shown 

in Figure 3-19, but the asset opens on the last activated tab for the asset. See Section 

3.8.1 for populating Transformer properties. 
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Figure 3-19: Transformer > Properties 

3.5.1 Dashboard example showing Minitrans 

Select the Dashboard tab to display a page with useful information summarising the 

measurement data and ranking history for an individual transformer via two sub tabs – 

‘Devices Summary’ and ‘Ranking Graph’, as shown in Figure 3-20. 

The Dashboard tabbed page opens on the Devices Summary sub-tabbed page of the 

Transformer asset as shown in Figure 3-20. This lists each device monitoring the asset 

on a separate panel with summarised results from the various monitoring functions and 

an overall risk assessment. In this example, Transformer 02A has just one monitor, a 

Minitrans device, attached. 

 
Figure 3-20: Transformer > Dashboard > Devices Summary – Minitrans 
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Select the Ranking Graph sub tab to display the Risk and Ranking History as shown in 

Figure 3-21. 

 
Figure 3-21: Transformer > Dashboard > Ranking Graph – Minitrans 

3.5.2 Dashboard example showing Intellix BMT 330 

The device summary for an Intellix BMT device is shown in Figure 3-22. Depending on the 

inputs, there are multiple tabs, Primary Input (HV) and Partial Discharge (an additional 

tab is shown if the Secondary Input is in use e.g. Low Voltage). 

 
Figure 3-22: Transformer Dashboard > Devices Summary – BMT 330 

In the example shown in Figure 3-23, the Primary Input labelled HV displays the following 

information: 

▪ BMT device ID and Last Measurement timestamp 

▪ A graphic summary of the bushing input set; namely ΔC1(%) (the imbalance of the 

displacement current amplitudes at the test taps of the three bushings, see Section 
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4.16 Bushing Monitor), and the angles AB() and AC() (the test tap currents Inter-
Phase Angles, see Section 4.19). 

▪ An extended numerical overview of the bushings’ status. 

 
Figure 3-23: BMT 330 Device Summary > Primary Input (HV) 

In the example shown in Figure 3-24, the Partial Discharge tab displays the following 

information: 

▪ The Last Measurement timestamp 
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▪ A graphic summary of the Partial Discharge activity for all three Primary Inputs 
namely PDI (mW) (the Partial Discharge Index) and the PD Avg. (pC) (Average Partial 
Discharge Apparent Charge) for all three inputs. See Section 4.17. 

▪ An extended numerical overview of the PD status. 

 
Figure 3-24: BMT 330 Device Summary > Partial Discharge 
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3.5.3 Dashboard example showing MS 3000 

The device summary of an MS 3000 device is shown in Figure 3-25. Depending on the 

inputs, there are multiple tabs – Load currents, deltaC, Ageing, Gases & Moisture, Tap 

changer1 and Temperatures. 

 
Figure 3-25: MS 3000 Device Summary 

Perception downloads and visualises the Risk Index results along with the other data 

stored on the MS 3000. The Risk Index results are calculated directly on the MS 3000 

monitor running master template 3.6.4.22p0_ 3.2.2.13p0_4.5p0 or later. 

Perception can be configured to use and display only the Risk Indexes downloaded from 

the MS 3000, or only the Risk Index calculated in Perception or a combination of both. 

When both Risk Index options are configured, Perception automatically selects and 

displays in the most critical Risk Index result and information regardless of its origin. 

Figure 3-26 shows how to assign the MS 3000 Risk Index workflow to the transformer so 

that the MS 3000 device’s onboard Risk Index can be utilized. 
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Figure 3-26: Transformer > Properties > Workflow Associations 

Risk Index data downloaded from the MS 3000 can be exported and imported via the 

existing mechanism as outlined in Section 5. 

3.6 Transformer Bank 

A Transformer Bank is a grouping of single-phase transformers and their associated 

monitoring devices under a single visual entity in the Asset Explorer and is represented 

on the Area wallboard as a single node. 

A Transformer Bank is treated the same as any other asset in that data can be 

imported/exported, alarms raised etc. An alarm status (and email notification) on any 

child asset propagates up to represent the status of the entire Transformer Bank with 

the most significant alarm determining the overall status of the Transformer Bank. A 

new Transformer Bank asset can be added to the Asset Hierarchy under an Area or 

Substation node. Right click the desired node and select New > Transformer Bank as 

shown in Figure 3-27. See Section 3.8.2 for populating Transformer Bank properties. 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 48 of 199 

 
Figure 3-27: New > Transformer Bank 

3.7 Circuit Breaker 

A Circuit Breaker is another type of asset that can be added to the hierarchy. When a 

Circuit Breaker is selected in the Asset Explorer, a similar tabbed list of worksheets 

display in the Data area to the right. The default active tab is Properties as shown in 

Figure 3-44. See Section 3.8.3 for populating Circuit Breaker properties. 

 
Figure 3-28: Circuit Breaker properties 

Select the Dashboard tab to display a page with useful information summarising the 

measurement data and ranking history for an individual circuit breaker via two sub tabs 

– ‘Devices Summary’ and ‘Ranking Graph’, as shown in Figure 3-20. 

The Devices Summary for a Circuit Breaker asset is shown in Figure 3-29. This lists each 

device monitoring the asset on a separate panel with summarised results from the 

various monitoring functions and an overall risk assessment. 
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Figure 3-29: Circuit Breaker asset – Devices Summary – CB Watch 3 

The CB Watch 3 monitoring device is not limited to downloading risk index and alarms 

data, but can also download data on the opening, pumping and closing operations, as 

well as the continuous measurements of the circuit breaker as shown in Figure 3-30. 

Perception regularly polls the CB Watch 3 device and checks if an operation has 

occurred. If there has been an operation, Perception then downloads the recent opening, 

pumping and closing data. Irrespective of any operation taking place, the continuous 

measurement data and risk index data is always downloaded and stored every four 

hours. The user can configure fast polling of the circuit breaker to allow CB Watch 3 to 

obtain the latest data. The polling interval will depend on the customer network, number 

of devices etc. 
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Figure 3-30: Circuit Breaker asset – CB Watch 3 – Status worksheet 

3.8 Setting up Asset Properties 

Transformers, transformer banks, circuit breakers and devices have several properties 

that are configured using the Properties worksheet. 

3.8.1 Transformer Properties 

When a transformer is selected in the Asset Explorer, the data area to the right lists all 

the worksheets (on the bottom) of which the Properties tab is first as shown in Figure 

3-31. Since transformers do not have data that can be automatically downloaded, the 

transformer properties must be manually entered here. 
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Figure 3-31: Transformer properties 

The Transformer properties fields depend on whether the connection is to Perception 

Server or a local KPD database file. For example, there is no Workflow Associations 

section for a local KPD database file. The sections within the Properties worksheet are 

explained below. 

▪ Transformer Name 

The Transformer Name is a free text field where you can change the default name and 

enter more descriptive text as shown in Figure 3-32. 

 
Figure 3-32: Transformer name 

▪ Main Transformer Details 

The main transformer name plate details are entered in Figure 3-33 and allow the 

identity and corresponding details to be stored in the database. 
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Figure 3-33: Main Transformer Details 

Scroll to the right to enter primary and secondary Bushing details as shown in Figure 

3-34. 

 
Figure 3-34: Bushings 

▪ Voltage Sides 

The Voltage Sides section as shown in Figure 3-35 allows information on the 

transformer’s Voltage Sides to be stored in the database. To add a Side to the 

description, click the Add button. 

 
Figure 3-35: Voltage Sides 

▪ Compartments 

The Compartments section as shown in Figure 3-36 allows information on the 

transformer’s compartments to be stored in the database. To add a Compartment to the 

description, click the Add button. To remove a Compartment, click on the compartment 

line to be removed and click the Remove button. 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 53 of 199 

 
Figure 3-36: Compartments 

▪ Criticality Details 

The Criticality Details section as shown in Figure 3-37 allows additional information to be 

stored about the transformer, such as its physical location and the availability of spare 

parts. These properties may be unique critical factors or more general transformer 

characteristics or observations, but nonetheless could have a bearing on risk. The 

Criticality Details are used by the fleet ranking algorithms for a better risk assessment 

and more accurate transformer rankings. 

 
Figure 3-37: Criticality Details 

▪ Workflow Associations 

The Workflow Associations section as shown in Figure 3-38 contains settings that are 

applied at the workflow level. The top line fields control how the Criticality Details 

influence the calculations. The default is to use an ‘Auto criticality calculation’, but this 

can be changed to any percentage (0-100%). The bottom field specifies the workflow 

associated with the transformer and the weighting of that workflow on the transformer 

calculations. Note: Click ‘Remove’ to remove a workflow association. The Ranking 

Influence field allows you to control the magnitude of effect that the transformer 

measurement parameters have on the data analysis through a sliding five-point scale. 

The default is ‘Normal’, but you can also minimize the effect by selecting ‘Extra Rough’ or 

maximize the effect by selecting ‘Extra Sensitive’. 

 
Figure 3-38: Workflow Associations 

The next step is to add the monitoring devices that are associated with the transformer. 

See Section 3.2.1 and Section 3.8.4. 

Note: Transformer measurement data can also be imported via a TOA formatted CSV 
file (See Section 5.1). 
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3.8.2 Transformer Bank Properties 

The Transformer Bank’s Properties worksheet allows the user to configure phase 

associations as shown in Figure 3-39. Phase associations allow the user to assign a 

transformer to its respective phase. 

 
Figure 3-39: Phase Associations 

Each phase configuration automatically creates an annotation at the association date in 

the Data Table and Trend Chart worksheets when you rest the mouse on the relevant 

timestamp as shown in Figure 3-40 and Figure 3-41. 
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Figure 3-40: Phase Association annotation on Data Table 

When a data source assignment changes for any transformer that is part of the 

Transformer Bank, an annotation is added to the Trend Chart to reflect the assignment 

change. An indication will also be made on the diagnostic worksheets to show the data 

being displayed crosses over a change of single phase assignment for the online device. 
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Figure 3-41: Phase Association annotation on Trend Chart 

The Properties worksheet can also be used to make algorithm assignments for data 

sources so that the Transformer Bank and associated single phase transformers can be 

risk evaluated and ranked. Figure 3-42 shows how to associate the BMT Standard 

workflow with a Transformer Bank. 
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Figure 3-42: Transformer Bank 

The Ranking tab shows the Transformer Bank with its condition determined by the 

combined risk indexes and conditions of its children including Intellix BMT devices. 
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Figure 3-43: Ranking 

3.8.3 Circuit Breaker Properties 

When a Circuit Breaker is selected in the Asset Explorer, the data area to the right lists 

all the worksheets (on the bottom) of which the Properties tab is first as shown in 

Figure 3-44. Since circuit breakers do not have data that can be automatically 

downloaded, the circuit breaker properties must be manually entered here. 

 
Figure 3-44: Circuit Breaker properties 

The Circuit Breaker properties fields depend on whether the connection is to Perception 

Server or a local KPD database file. For example, there is no Workflow Associations 

section for a local KPD database file. The sections within the Properties worksheet are 

explained below. 

▪ Circuit Breaker Name 

The Circuit Breaker Name is a free text field where you can change the default name and 

enter more descriptive text as shown in Figure 3-45. 
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Figure 3-45: Circuit Breaker name 

▪ Main Transformer Details 

The Main Circuit Breaker Details are entered in Figure 3-48 and allow the identity and 

corresponding details to be stored in the database. 

 
Figure 3-46: Main Circuit Breaker Details 

▪ Workflow Associations 

CB Watch 3 support is available for the Perception Workflow Risk Indexing and Ranking 

mechanism. A new algorithm called CB Watch has been created under the Workflows 

dropdown list as shown in Figure 3-47. When selected, Perception uses the Risk Index 

results received from the CB Watch 3 to present a Risk Index overview and rank position 

within the asset ranking table. 

 
Figure 3-47: Workflow Associations 

3.8.4 Device Properties 

When a device is selected in the Asset Explorer (E.g. a Transfix 1.6), the data area to the 

right lists all the worksheets (on the bottom) of which the Properties tab is first as 

shown in Figure 3-48. The Properties worksheet is used to configure the device. 

Note: If used in conjunction with Perception Server, ‘Supervisor’ status or higher is 
required to change device properties. 
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Figure 3-48: Device Properties 

The Properties worksheet contains several sections that are explained below: 

3.8.4.1 Identity 

The Identity section details the identity of the device. It contains two read-only fields as 

shown in Figure 3-49: 

 
Figure 3-49: Identity 

▪ Device Type: The device type is defined by the type of asset added using the Asset 
Explorer (see Section 3.2.1). 

▪ Serial Number: The serial number is populated when the first download is performed 
from the device. 

3.8.4.2 Communications 

The Communications section allows the communication method to be defined and 

configured as shown in Figure 3-50. Other configuration fields are available depending on 

the device and your choice of Media as outlined below: 

Note: When used in conjunction with Perception Server, you specify the 
communications with the device here. Perception Server downloads the 
monitoring data, but Perception Desktop is the controlling application used to 
specify all the configuration parameters. 
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Figure 3-50: Communications 

▪ Media: Defines what type of connection is used to connect with the device. Available 
options are: 

➢ Network 

This adds three additional fields: 

o Hostname (or IP address): The devices host name or IP address. 

o MODBUS/TCP Port: The MODBUS/TCP port defines the port used for 
communication with the host name or IP address (the default value is 502). 

o Protocol: When adding a DGA 900, MS 3000 or CB Watch 3 there is the option to 
use either the HTTP (default port 80) or HTTPS (default port 443) protocol. The 
selected protocol must match the protocol set on the device. For DGA 900-family 
devices, it is possible to define a non-standard port, select the checkbox Define 
network port and specify a port from 0 to 65535 as shown in Figure 3-51. 

 
Figure 3-51: Communications > Define network port 

➢ Modem 

This adds one additional field: 

o Phone Number: The phone number of the modem in the device. 

➢ Serial 

This adds eight additional fields: 

o Slave Address: The address of the device on a multi-drop network. 

o Protocol: The MODBUS protocol to use to communicate with the device. 

o COM Port: The local COM port to use when connecting to the device. 

o Baud Rate: The maximum speed at which the device talks. 

o Data bits: The number of data bits in each character being sent. 

o Parity: Turn on error correction. 

o Stop Bits: Use the hardware to detect stop bits (end of messages) and re-
synchronize the character stream. 

o Flow Control: Allow the transmission of data to be paused / resumed. 

If a Hydran M2 or Intellix MO150 device is selected, an additional Protocol field 
appears on the Properties worksheet: 

➢ Protocol: Selects the protocol method used to communicate with the device. 
Perception Desktop supports the DNP3 protocol and three Modbus protocols 
(RTU, ASCII and TCP/IP). 

If a Hydran 201Ti device is selected, an additional Protocol field appears on the 
Properties worksheet: 
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➢ Protocol: Selects the protocol method used to communicate with the device. 
Perception Desktop supports the Hydran Native Protocol and three Modbus 
protocols (RTU, ASCII and TCP/IP). Note: To facilitate TCP/IP communication, the 
unit requires an RS-485 to Ethernet conversion. 

Note: For Hydran devices, the Media field displays after you select the Protocol. Serial 
refers to a USB or RS-485 connection. 

▪ Connection Timeout: Defines the time to wait before reporting a connection timeout. 
Enter a value in seconds. 

Note: A default value is created in this field when you select the Media type. 

▪ Password: The password for the device. 

3.8.4.3 Auto-Download 

When used in conjunction with Perception Server, the Auto-Download section becomes 

available in the device Properties as shown in Figure 3-52. 

Note: A local database permits only manual downloads. See Section 5.1. 

The Auto-Download section allows the connection and downloading from devices to be 

automatically scheduled. The schedule settings are unique to the device allowing a 

simultaneous download to be scheduled. 

 
Figure 3-52: Auto-Download 

▪ Enabled: Enables/disables the scheduling of downloads from the device. 

▪ Based on device sample rate: Ensures that the auto-download takes place based on 
the device sampling rate rather than the Perception schedule, meaning that data is 
downloaded as soon as new measurements become available. This effectively means 
the Perception schedule below is ignored. This option is useful if the online monitor 
goes into alarm mode and starts to sample more regularly. Previously, Perception 
would not have been aware that more regular samples were being taken, so would 
only have downloaded data based on the Perception schedule. 

Note: Users may notice that there is a time difference of one hour between the 
download time and measurement schedule time. This difference is required as 
it can take up to 1 hour for a measurement sample to complete fully. 

▪ Schedule: Defines the download schedule in terms of specific days and times using 
the “Unix Cron” notation.  The essential Unix Cron field values supported in 
Perception scheduling are the “*” character and the “0” value. 

➢ “0” means “at the top of” e.g. if used in the hour field, then “at the top of the hour”. 

➢ “*” means “every” e.g. if used in the hour field, then “every hour”. 

Table 3-1 shows some example Cron values used in Perception scheduling and the 

corresponding meaning in terms of the expected download result. 

Table 3-1: Examples illustrating scheduling using Cron values 

Minutes Hours Week Days Download Result 

30 08 * 08:30 every day 

0 * Mon On the hour, every hour on Mondays 
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0 0 Wed At 0:00 every Wednesday 

0 * * On the hour, every hour, every day of the week 

▪ Next Scheduled Time: Time of the next scheduled download. 

3.8.4.4 Auto-Export 

When used in conjunction with Perception Server, the Auto-Export option becomes 

available in the device Properties page as shown in Figure 3-53. 

 
Figure 3-53: Auto-Export 

You can enable the auto export to occur at scheduled intervals. The Perception Server 

export table is empty by default, which results in the use of the default Perception export 

format. To define a custom CSV format, you must define the export table with 

appropriate mappings for the data using the Perception Server Configuration Tool. See 

Section 5.1. The data is automatically exported to the following location: 

C:\ProgramData\GE_Energy\Perception 

Note: Use the shortcut “%programdata%”to access C:\ProgramData. 

3.8.4.5 Email 

When used in conjunction with Perception Server, e-mail notification options become 

available in the device Properties page as shown in Figure 3-54. 

 
Figure 3-54: Email 

Note: This is device specific, so if you need to be on the distribution email list for 
several devices, complete this field for all required devices. 

▪ Notification E-Mail Address: defines the email address of the person who receives 
condition alerts (or communication issues) for that device. To add more than one e-
mail address to the list, separate the addresses with “;“. If on subsequent data 
downloads the condition of the device changes or Perception Server fails to 
communicate with the device, an automatic email is generated and sent to the 
recipients specified in this field. 

▪ Segregate Notification emails: allows the user to define the recipients of the emails 
based on the notification type. Select the checkbox to specify the three types of 
notification address as shown in Figure 3-55. 

 
Figure 3-55: Email – Segregate Notification emails 

➢ Alarm – notification that an alarm level breach has occurred on the online monitor. 
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➢ Service – notification that the online monitor requires service attention. When a 
service alarm is triggered on a Transfix, TapTrans, MultiTrans, MiniTrans, or Hydran 
M2, M2-X & 201Ti device, the service log files are automatically downloaded from 
the device and included as an attachment in the service notification email. 

➢ Communication issue – notification that Perception was unable to communicate 
with the online monitor. 

▪ Expert E-mail Address: (if enabled in Perception Server) defines the email address 
of the person who receives enhanced alarm notification emails. The e-mail is a 
comprehensive account of a transformer’s details so that any expert within or outside 
the organisation has all the necessary detail at hand. This includes transformer 
nameplate details, triggered alarm information for High High, Low Low, Digital Alarms 
and ROC alarms. It also includes ambient temperature, top oil temperature and load 
currents information. A CSV attachment with data records for the device in alarm is 
also included. Note: For the MO150 device, excessive measurement data could 
exceed the allowable attachment size as defined on the mail server. 

3.8.4.6 Device Connection 

The Device Connection section displays the state of automated downloads to the user as 

shown in Figure 3-56. 

 
Figure 3-56: Device Connection 

▪ State: Displays the current state of the connection to the device. E.g. Connecting, 
Connected, Downloading, Disconnected. 

▪ Progress: A progress bar shows the overall progress of a download, if one is in 
progress. 

▪ Response: Textual error message showing the last communications error that has 
occurred. This may be from a previous communications session. 

▪ Last download time: Updated with the last download time. 

The Intellix BMT devices have an additional field in the Device Connection pane, called 

Service Alarm: 

▪ Service Alarm: Reports the nature of a service alarm that has been flagged by the 
Intellix BMT devices. The possible alarms are listed below: 

➢ High Comms cpu temperature status 

➢ High FPGA temperature status 

➢ Field Devices Comms Error 

➢ Rejected Phase Packet Status 

➢ Rejected PD Packet Status 

➢ Low Bushing Current Warning Status  

➢ Power System Frequency Warning Status 

➢ Inter cpu CANBUS device error status 

➢ High Bushing Adapter Temperature Status  



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 65 of 199 

➢ Modbus comm. error status 

➢ No Signal warning status 

➢ Bushing R Failure Warning status 

If the Intellix BMT devices have any of these alarms triggered, the Blue service icon will 

show on the device icon in the Asset Explorer. See Section 3.1.2.1 for an example. 
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3.8.5 Setting up the Device 

Once the communications settings have been established, the device-specific setup can 

be run. To set up the device, right click on the device in the Asset Explorer and select 

Setup… as shown in Figure 3-57. This loads a setup utility specific to the device. 

 

Figure 3-57: Setup 

Note: If you are connecting to the device via Modem or Serial, then the Setup option 
must be performed on an instance of Perception Desktop running on the 
Perception Server. This is because it will be using the local Perception Desktop 
resources to communicate with the device. 

3.8.6 Workflows 

The following workflows are available: 

▪ DGA Standard: Evaluates dissolved gas analysis and moisture absolute 
concentrations compared to IEEE C57.104 & IEC 60422 (2013) standards, as well as 
dissolved gas Rate of Change compared to the IEC 60599 standard. Along with best 
practice information taken from Cigré TB227. 

▪ Simplified DGA: Uses alarm breach information sent from DGA 900, MS 3000, Transfix, 
Multitrans, Taptrans, Minitrans, Hydran M2 & Hydran 201Ti for absolute dissolved gas 
concentrations and moisture. 

▪ DGA Standard OLTC (Non-vacuum): Evaluates dissolved gas concentration and 
dissolved gas rate of change for resistor type tap changer diverter, using gas ratio 
information taken from EPRI (Electronic Power Research Institute). 

▪ Simplified DGA OLTC: Uses alarm breach information sent from DGA 900, MS 3000, 
Transfix, Multitrans, Taptrans, Minitrans, Hydran M2 & Hydran 201Ti for absolute 
dissolved gas concentrations and moisture. 

▪ Bushing Standard: Evaluates the alarm limits configured on the BMT devices for 
Power Factor, Capacitance, PD Count, PD Index & PD Average Apparent Power and 
compares it to the measured values for proximity to alarm breach as well as 
breaches. Evaluates the alarm limits configured on the MS 3000 device for DeltaC, 
tanDelta and Voltages and compares it to the measured values for proximity to alarm 
breach as well as breaches 
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▪ Offline DGA and Oil Quality: Evaluates oil dissolved gas analysis, quality and 
properties data received from a lab compared to a variety of international standards. 
Refer to Appendix F for more information on the Offline DGA & Oil Quality Workflow. 

For more information on workflows, see the Perception Workflow Designer manual. 

3.9 Adding a Wallboard 

At an Area, Plant, Substation, Transformer Bank or Transformer level, you can add a 

wallboard to give an instant overview of the status of all subordinate assets. Each client 

PC with an instance of Perception Desktop that connects to Perception Server must 

have its own wallboard configured. The image used for the wallboard background is user 

defined and can be any BMP, JPEG, GIF or PNG file. 

To add a wallboard, select an Area, Plant, Substation, Transformer Bank or Transformer 

in the Asset Explorer and from the menu bar, select View > New > Wallboard as shown 

in Figure 3-58. A new Wallboard tab then appears in the list of tabs. 

 
Figure 3-58: Wallboard 

Right-click in the wallboard area and choose Change map file to browse to the location 

of a suitable image to use as a map file. The chosen image is displayed at minimum zoom 

within the workspace on the right along with randomly placed subordinate assets for 

you to position as required. 

It is recommended that the resolution of the image file matches the display resolution of 

the monitor that will display the wallboard. For example, if the monitor displaying the 

wallboard has a resolution of 1920x1080, then the image file used should also have the 

same resolution. 
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Figure 3-59: An example wallboard 

Perform any of the following actions to alter the map display: 

▪ To drag the map in any direction, left click while the mouse pointer is within the map. 

▪ To zoom in and out, use the scroll wheel while the mouse pointer is within the map. 

▪ To drag the asset to a new location, left click while the mouse pointer is over the 
asset location icon. Note: The mouse pointer changes to a hand. 

▪ A useful way to distinguish assets is to change the icon used to depict the asset 
location. Right click while resting the mouse pointer over the asset location icon and 
choose from a circle or a square. 

▪ For other display options as shown in Figure 3-60, right click on the map. 

 
Figure 3-60: Display options 

▪ Dialogs: Each asset has a titled information dialog that lists all attached monitoring 
devices and corresponding statuses. This option allows you to show or hide all asset 
dialogs. A single dialog box can also be manipulated independently as follows: 

➢ To show or hide a dialog box, double click its asset location icon. 
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➢ To change the size of a dialog box, rest the mouse pointer over the lower-right 
corner symbol of the dialog box (the mouse pointer changes to a double-headed 
arrow) and then left click-and-drag to resize. 

➢ To move a dialog box, left click-and-drag the dialog box. Note: A dashed connecting 
line indicates the relevant asset location icon. 

➢ To change the dialog box title, right click and choose Edit title. 

➢ To view the ranking details, right click and choose Ranking. 

Note: The size and position of the dialog boxes are retained. 

▪ Change map file… allows you to browse for a new map file. 

▪ Legend: toggles the display of the legend for the asset status. 

▪ Show time: toggles the display of the current time and date. 

▪ Full screen: shows the wallboard in full screen mode. To revert to normal display, 
press Escape or right click and select Exit full screen. 

A fully configured Wallboard in full screen mode is shown in Figure 3-61. 

 
Figure 3-61: Fully configured wallboard 

Other examples of wallboard images are shown from Figure 3-62 to Figure 3-66. If the 

condition of any of the monitoring devices changes to reflect an alarm, service or bad 

sample condition, this will be denoted by a change in color of the respective device node. 

This change will also be reflected in the asset hierarchy and on the wallboard asset node 

(where an animation causes the node to pulse as shown in Figure 3-62 — if configured in 

Perception Server). Note: By default, all animations are disabled. 

Note: In conjunction with Perception Server, the wallboard dynamically changes to 
reflect condition updates if the monitoring devices are configured with 
automatic download schedules. 
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Figure 3-62: Wallboard with pulsing node 

The wallboard asset node will match the status of the device with the worst result. This 

helps alert the user to a problem in that area, plant, substation, transformer bank or 

transformer at the earliest opportunity. Right-click any pulsing device in the asset 

summary box to acknowledge the alarm (at the device level only) as shown in Figure 

3-63 — this turns off the pulsing animation. 

 
Figure 3-63: Acknowledge an alarm 
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Any movement in the asset risk index for transformer or circuit breakers nodes is 

denoted by a corresponding colour-coded directional arrow (up or down accordingly) 

next to the asset label as shown in Figure 3-64, which also has a ripple animation. 

 
Figure 3-64: Asset node showing increased movement up the asset risk index 

To acknowledge an asset’s change in position in the asset risk index, right click the asset 

and select Acknowledge Risk Index as shown in Figure 3-65 to turn off the ripple 

animation. 

 
Figure 3-65: Acknowledge Risk Index 
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The shortcut menu in Figure 3-65 also offers customization options to display an 

individual node as a circle or a square to provide a further visual differentiation of assets, 

if required, as shown in Figure 3-66. The default node for all assets is a circle. 

Asset labels on the wallboard or asset summary box are also active hyperlinks as shown 

in Figure 3-66. Click the asset label to see where the asset sits in the Asset Hierarchy, for 

example as shown in Figure 3-67, and if required, examine its properties etc. 

 
Figure 3-66: Customizing asset nodes 

 
Figure 3-67: Asset Hierarchy 

3.10 Ranking Assets 

The Ranking page in the Asset Explorer as shown in Figure 3-68 automatically ranks 

assets according to an algorithm in the Perception workflow to give an overall health 

index. Assets are colour-banded accordingly with the least healthy transformers listed at 

the top in red and the healthiest in green at the bottom. Unranked transformers appear 

at the bottom of the list without a colour band. A transformer is unranked if it is not 

associated with the relevant Perception workflow, has no measurement devices 

connected to it or there is no measurement data e.g. a new install with the first 

measurement cycle yet to occur. 

Ranking movement at each periodic refresh is denoted by colour-coded arrows. A red 

up-pointing arrow denotes that the transformer has moved up in ranking order, a green 

down-pointing arrow denotes that it has moved down in ranking order and a blue 

double-headed horizontal arrow denotes no change in ranking order. 

Note: Rest your mouse on any transformer to reveal its actual health index. 
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Figure 3-68: Ranking 

To review the Risk and Ranking history for an individual transformer, select the 

transformer followed by the Dashboard tab. Then select the Ranking Graph tab as 

shown in Figure 3-69. Rest your mouse pointer on any data point for more information. 

 
Figure 3-69: Risk and ranking history 

Note: Data points may refer to ‘EPRI’ (Electrical Power Research Institute). 
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4 ANALYSING DATA 

4.1 Data Area Worksheet Tabs 

The Data Area contains several worksheets that are used to visualise the data and 

diagnose faults. The worksheets are accessed via a series of tabs at the bottom of the 

screen. The available worksheets depend on the type of item selected in the Asset 

Explorer. For example, Figure 4-1 lists the worksheets for a Transformer. 

 
Figure 4-1: Transformer worksheet tabs 

All available worksheets and a link for further details are listed below: 

Properties: See Section 3.8. 

Wallboard: See Section 3.9. 

Dashboard: See Section 3.5.1. 

Trend Chart: Line charts are used to display the raw data for user-selected 

measurements. Multiple trend charts can be created, each displaying different sets of 

gases or peripherals. See Section 4.3. 

Data Table: Lists the individual samples for each parameter. You can select the data 

range and the parameters to suit. See Section 4.4. 

Status: Lists the latest downloaded values of the measured parameters and their status 

against the alarm thresholds. See Section 4.5. Note: The alarm thresholds can be set by 

launching the device setup in Perception Desktop. 

Rate of Change: Displays multiple line charts depicting the rate of change for each gas 

based on raw data for user-selected measurements on Transfix-family and Minitrans 

devices. Multiple trend charts can be created, each displaying different sets of gases or 

peripherals. See Section 4.6. 

TDCG: The Total Dissolved Combustible Gases (TDCG) chart displays a stacked chart 

containing the temporal values of each gas and the cumulative values for all gases. See 

Section 4.8. 

Key Gas: IEEE C57-104 offers diagnosis through calculating the relative proportions (in 

percent) of these key gases to the rest of the gases in the transformer. See Section 4.9. 

Gas Ratios: Displays the proportions of key gases on a three-dimensional cube lattice or 

table, using ratios defined by IEC 60599, IEEE C57.104, Rogers Ratio and Doernenburg 

Ratios. See Section 4.11. 

Ratios: Trends any gas ratios that have been set up for Transfix devices. You can also 

add your own custom gas ratio. See Section 4.12. 

ETRA: Japanese ETRA Analysis is an alternative visualisation and diagnostic tool. 

Diagrams A & B are available. See Section 4.13. 

Duval’s: Describes how the concentrations of dissolved gases or free gases may be 

interpreted to diagnose the condition of oil-filled electrical equipment in service and 

suggests future action. There is the choice of six different formats of Duval’s diagnostics: 
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four triangles — Classic, LTC (oil filled) and Duval’s 4 & 5 low temperature, —and two 

pentagons. See Section 4.14. 

Models: Provides diagnostics using state of the art mathematical transformer models 

based on IEEE or IEC standards. Calculated using monitored transformer characteristics 

taken by the Intellix MO150 and Hydran M2. See Section 4.15. 

Bushing Monitor: Intellix BMT devices only. Shows two polar plots with a choice of plot 

styles, C1 or PF% data, and Primary or Secondary input. See Section 4.16. 

Partial Discharge: Intellix BMT devices only. Shows three polar plots — PD Count, PD 

Average Apparent Charge and PD Index. See Section 4.17. 

PRPD: Intellix BMT 330 only. Shows the measured Phase Resolve Partial Discharge data. 

See Section 4.18. 

Inter-Phase Angle: Intellix BMT devices only. Shows a polar plot with the measured and 

expected inter-phase angles. See Section 4.19. 

Web Browser: MS 3000 and DGA 900 devices only. Shows web content as rendered on 

the remote HMI of the device. See Section 4.20. 

4.1.1 Worksheet Options 

Right click any worksheet tab to see the available options as shown in Figure 4-2. 

 
Figure 4-2: Worksheet options 

4.1.1.1 Rename a Worksheet 

To rename a worksheet, right click on the tab and select Rename. 

4.1.1.2 Save or Apply Templates 

Users can save worksheet settings as a template. The template contains the 

customizable features of a worksheet. For example, the selected measurement points, 

appearance settings, date range, selected charts etc. These settings are all stored in the 

template XML file and can be applied to another worksheet or the same worksheet in 

another instance of Perception. 

Right click on the relevant worksheet tab and select the relevant option. 
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4.2 Default Device Charts 

When a new device is added to Perception Desktop, a default set of charts as indicated 

in Table 4-1 will be enabled when the device is selected in the Asset Explorer. Additional 

charts can be added by the user (see Section 4.3.1). 

Table 4-1: Charts per device 
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MS 3000 ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫      ⚫  

DGA 500 ⚫ ⚫ ⚫ ⚫   ⚫ ⚫        ⚫ 
Transfix 1.6 ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫       ⚫ 
Transfix 1.5 ⚫ ⚫ ⚫ ⚫ ⚫ ⚫  ⚫ ⚫        

Taptrans ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫       ⚫ 
Dualtrans ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫       ⚫ 
Multitrans ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫       ⚫ 
Transfix PLUS ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫      ⚫ 

Minitrans  ⚫ ⚫ ⚫    ⚫         ⚫ 
Hydran M2 ⚫ ⚫ ⚫       ⚫       

Hydran 201Ti ⚫ ⚫ ⚫              

Intellix MO150 ⚫ ⚫ ⚫       ⚫       

Transformer ⚫ ⚫ ⚫ ⚫ ⚫ ⚫  ⚫ ⚫        

Intellix BMT 
300 

⚫ ⚫ ⚫        ⚫ ⚫  ⚫   

Intellix BMT 
330 

⚫ ⚫ ⚫        ⚫ ⚫ ⚫ ⚫   

DGA 900 ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫ ⚫       ⚫  

4.3 Trend Chart 

The trend chart is typical of all the diagnostic charts as shown in Figure 4-3. It can be 

configured to show groups of gases or other measurable parameters with multiple 

versions of the chart being open concurrently. 
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Figure 4-3: Dissolved gas trend analysis 

Key to the Chart areas: 

 X axis date(s): Select the date range for the X axis of the chart. Whenever you place 

your cursor within the grey plotting area, a vertical date line follows the cursor with 

the precise date and time reported in the yellow box. 

 Legend: The value next to each item is the value of the item at the yellow box date 

and time () time on the X axis. If the cursor is not within the plot area, the values 

are as at the right-hand extreme end of the plot lines. To change the plotted colour 

of an item, a double click on the legend colour launches a format dialog as shown in 

Figure 4-4. 

 
Figure 4-4: Format Plot 

 Y axis: The Y axis values for the selected item from the legend. Although all the 

parameters are plotted, they have, by default, individual scales. Other scaling 

methods are selectable. See Section 4.3.4. 

 Slider: The slider allows you to control the degree of ‘smoothing’ that is applied to 

the trend lines; the leftmost position (shown) has least smoothing and sliding it 

leftwards progressively applies more smoothing. This can be useful in removing 

spikes and revealing the overall trend of the parameters. 
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If you right click when your cursor is within the plot area, an options menu is displayed, 

as shown in Figure 4-5. 

 
Figure 4-5: Chart options 

▪ Chart: Changes the method of scaling the Y axis. See Section4.3.4. 

▪ Auto scale: Returns the Y axis scaling to default. 

▪ Appearance: Alters the appearance of details within the trend chart. 

▪ Reset Zoom: Returns the trend plot to display all points between the start and finish 
dates. 

▪ View: Alters whether the legend is displayed or not. 

▪ Annotations: Allow you to place notes on the trend chart. See Section 4.3.5 

▪ Print: Prints the trend graph to your printer. 

▪ Print Preview: Allows you to configure the print output and see the effects before 
printing. 

▪ Copy: Copies the trend chart to the Windows Clipboard, so that it can be pasted into 
another application, for instance a document. 

▪ Save: Creates a ‘png’ image of the trend chart that can be saved as a picture. 

▪ Add/Remove Measurement Points: Allows you to select/deselect which parameters 
are plotted on the trend graph. See Section 4.3.2. 

You can zoom into part of a plot as shown in Figure 4-6. To do so, place the cursor in the 

grey plotting area at the top left X-Y position of the desired zoom area and then left-

click-and-drag your mouse to the bottom right of the desired zoom area (as illustrated 

by the red arrow). When you release the mouse button, the plot range will be ‘zoomed’. 

The zoom can be reversed by left clicking and dragging back in the opposite direction to 

the red arrow. It can also be reset by right clicking and selecting Reset Zoom. 
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Figure 4-6: Zoom plot 

By default, the Appearance > Connect gaps option is enabled. This plots the trend line 

between two good measurements and omits any bad quality data with zero-value 

measurements effectively smoothing out the trend line. If disabled, Perception will plot 

all data points and any invalid zero-value measurements will appear as gaps in the chart. 

4.3.1 Create a new Trend Chart 

To create a new trend chart, select View > New and choose the type of chart, for 

example Trend Chart as shown in Figure 4-7. 

 
Figure 4-7: Create a new Trend Chart 

This action opens a new blank trend chart that can be configured to display groups of 

measurements. 
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4.3.2 Add Measurements to the Chart 

To add measurements to a trend chart, right click anywhere on the trend chart and 

select Add/Remove Measurement Points. Select the measurements to be trended in 

the chart as shown in Figure 4-8. 

 
Figure 4-8: Add measurements to the trend chart 

The measurement parameters offered are device specific: a Transfix will offer gas 

measurements, whereas an Intellix BMT device will offer discharge and phase 

measurements. The Total Dissolved Combustible Gases (TDCG) from the TDCG 

worksheet is also available as a parameter for trending. 

4.3.3 Remove Measurements from the Chart 

To remove measurements from a trend chart, right click anywhere on the trend chart 

and select Add/Remove Measurement Points. Uncheck the measurements not to be 

trended in the chart as shown in Figure 4-9. 

 
Figure 4-9: Remove measurements from the trend chart 

4.3.4 Change Y Scale method 

A number of Y scale methods are available for the trend chart. Right click anywhere 

within the trend chart and select Chart as shown in Figure 4-10. 
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Figure 4-10: Change Y Scale method 

The available options are as follows: 

▪ Common: All parameters are on a common Y scale. Small concentrations will be 
squeezed together at the bottom of the chart. 

▪ Individual: The default method. Each parameter is plotted with its own vertical scale, 
which gives some vertical separation to the trend lines. The parameter selected from 
the legend then has its Y scale indicated on the Y axis. 

▪ Log: All items plotted together, but the Y axis is logarithmic. This separates out the 
parameters at the lower end of the chart, but will have the effect of squashing the 
high value parameters. 

▪ Conditional: Only parameters that have alarmed during the selected time period are 
plotted on the graph. 

4.3.5 Add Annotations 

To add annotations to a trend chart, position the pointer on the X axis (time) where you 

wish to place the annotation, then right click and select Annotations > New... as shown 

in Figure 4-11. 

 
Figure 4-11: Add annotations 

Enter the desired text in the text box that appears on the X axis and click outside the 

text box when finished to commit the text as shown in Figure 4-12. 

Note: A time repeater at the top of the graph may assist in accurate placement of the 
annotation. 
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Figure 4-12: Example annotation 

Other available options as shown in Figure 4-11 are: 

▪ Show All: Reveal all annotations (if hidden). 

▪ Hide All: Hide all annotations allows you to see the chart without any annotations 
obscuring the data. 

To edit or delete an annotation, right click the annotation and choose Edit or Delete. 

Note: When used in conjunction with Perception Server, annotations appear on the 
trend chart of the device for all connected Perception Desktop clients. 

4.4 Data Table 

The Data Table Tab lists all received data, which can be filtered for the selected dates. 

You can add and remove measurement parameters by right clicking within the display 

area as shown in Figure 4-13. 
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Figure 4-13: Data Table with colour-coding – add / remove measurement points 

The selected parameters are colour-coded as follows: 

White Normal (data is within all limits). 

Amber Caution (i.e. data has exceeded a high or low threshold). 

Red Alarming (i.e. data has exceeded a high-high or low-low threshold). 

Pink Uncertainty in the measurement accuracy. 

Blue Erroneous data. 

Teal First measurement after a reboot 

Rest the mouse pointer on any measurement value to see the corresponding Data Table 

tooltip, an example of which is shown in Figure 4-14. The tool tip lists the PGA diagnostic 

error codes and offers a description below. Note: See Appendix D for an explanation of 

the PGA diagnostic details. 
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Figure 4-14: Data Table tooltip 

4.5 Status 

The Status worksheet shows the latest downloaded parameter values and is the 

suggested view to start with when investigating an alarm occurrence. The alarming 

parameters are highlighted with the latest downloaded data date. An example is shown 

in Figure 4-15. 

 
Figure 4-15: Status worksheet 
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The ‘High-High’ and ‘Low-Low’ alarms are highlighted in red, the ‘High’ and ‘Low’ alarms 

in amber. The ROC column indicates whether a Rate of Change alarm has been set for 

that item. If the ROC alarm is activated, the Status column will show ‘ROC’. 

Ratio alarm measurement points are also displayed if they are configured on the device. 

Right click anywhere in the status area to see further options to print or customise the 

display of columns as shown in Figure 4-16. 

 
Figure 4-16: Status area columns 

4.5.1 Event Point Type 

A new point type called ‘Event’ registers the occurrence of an event. No measurement 

value is stored with this point type, only the existence of the event and when it last 

occurred. For example, Figure 4-17 shows an MS 3000 Status worksheet with a last OLTC 

operation event listed as ‘Event triggered’ as the current value and a corresponding 

date/time stamp. 

 
Figure 4-17: Status > Event Point type 

Note: Available for MS 3000 and 869 Relay assets. 

Note: The event is listed as ‘Event triggered’ in the tabulated Status and Data Table 
worksheets, but in the Trend Chart it is rendered as a vertical line. 

4.5.2 Rename a Measurement Point 

Right click on a display name to edit or reset the names as shown in Figure 4-18. 
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Figure 4-18: Display names 

A measurement point display name can also be changed. Right click in the Measurement 

Point field, select Edit Display Name (or double click the Measurement Point field) and 

edit the text inline as shown in Figure 4-19. The renamed measurement point will be 

used for all occurrences of the measurement point throughout the application. 

 

 

 

Figure 4-19: Rename a measurement point 

Note: You can also reset a single display name or all display names back to the 
original in the same manner. 

4.6 Rate of Change 

The Rate of Change worksheet visually represents the rate of change for different sets 

of gases or peripherals on a trend chart. The ROC trend chart can be rendered for any 

Transfix-family device including Minitrans, and is based on the parameters 

configured on the device or as user-defined in Perception. 

Note: The ROC chart is manipulated in a similar way to other trend charts described 
in Section 4.3, but does not display alarm limits. 

 
Figure 4-20: Rate of Change chart 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 87 of 199 

4.6.1 Rate of Change Parameters 

The ROC chart is derived from either the ‘Caution’, ‘Alarm’ or ‘Custom’ option using two 

parameters, ‘Time Window’ and ‘Minimum Samples’. Selecting either ‘Caution’ or ‘Alarm’ 

means the parameters are downloaded from the respective Caution or Alarm limits on 

the relevant device as configured in TransConnect (see Figure 4-24). The ‘Custom’ option 

allows the user to manually define the values for the ROC parameters as shown in Figure 

4-21. Note: Both fields accept any value from 1 to 32767. 

 
Figure 4-21: Custom: Rate Of Change Parameters 

The parameters are also shown in the gas legend tooltip on the chart as shown in Figure 

4-22. 

 
Figure 4-22: ROC tooltip showing parameters 

The Custom option is useful for devices with multiple oil sources to ensure that the ROC 

parameters are consistent across all oil sources thereby allowing data to be reliably 

aggregated for plotting. 

A blank chart occurs where the supplied values are insufficient for any data to be 

plotted, the ‘Time Window’ is less than the set measurement period on the device, or if 

the number of measurements is less than the ‘Minimum Samples’ value within the ‘Time 

Window’ period. If the device is not configured with Caution or Alarm limits, or ROC 

parameters are not specified, then the chart on the ROC worksheet will be blank since 

there is nothing to plot. 

Note: A chart is not displayed for a gas or peripheral (including devices imported from 
a CSV file) without ROC parameters set for ‘Caution’ and ‘Alarm’ cases. Instead, 
a popup message states ‘ROC Parameters are not available’. 

4.7 Rate of Change Alarm 

The Rate of Change (ROC) alarm is designed to alert the user of a gradual change in the 

gas levels of the transformer over a set period. The user will receive notification in the 

Status worksheet. 

When used in conjunction with Perception Server, with e-mail notification configured 

(see Section 3.8.4.5), an alarm notification email similar to that shown in Figure 4-23 will 

be sent to the designated recipients. 
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Figure 4-23: Example Rate of Change e-mail alert 

To set up the ROC limits, launch the device setup option from the Asset Explorer. In the 

Alarms worksheet, you can set the maximum Rate of Change in ppm/hours for Caution 

and Alarm, as shown in the example in Figure 4-24. 
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Figure 4-24: ROC settings in TransConnect 

The ‘ROC Time Window’ and ‘ROC Minimum Samples’ must be defined for the alerts to 

operate. These values are important as they are used in the ROC calculation. The ‘ROC 

Time Window’ can be set between 1 and 96 hours. Over time, the initial measurements 

are discarded as they fall outside the boundaries of the measurement window and are 

replaced with more recent results. 

To avoid spurious values or dropped measurements (recorded as a zero) from raising an 

alert, an ‘ROC Minimum Samples’ parameter is set. When this parameter is met, the unit 

will calculate the ROC result and, if applicable, generate an alert. This allows the user to 

control whether an isolated measurement should raise an alert or whether a more 

persistent change is required to raise an alert. 
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4.8 Total Dissolved Combustible Gases (TDCG) Chart 

The Total Dissolved Combustible Gases (TDCG) Chart as shown in Figure 4-25 is a pre-

set chart with similar controls to the Trend chart for dissolved gases as discussed in 

Section 4.3. 

 
Figure 4-25: TDCG Chart 

The key differences are: 

▪ The selection of gases is fixed, so cannot be changed by the user 

▪ The values are stacked upon each other, so it is possible to judge the relative 
proportions of each gas. 

▪ A Compartment option exists to change the phase/compartment of the device being 
displayed (right click anywhere in the chart to see the option). 

Note: Once you have settled on your selection of parameters, it is advisable to 
rename the chart to indicate which compartment/phase is being displayed. 

You can modify the plot dates to identify spikes or adverse trends in the total gas 

concentrations, for example, as shown in Figure 4-26. 

Note: The new plot dates are carried over to the other views so that they are all 
displaying the same peaks. 
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Figure 4-26: TDCG Chart 

4.9 Key Gas 

The Key Gas worksheet compares the concentrations of key gases against thresholds for 

four deterioration conditions: 

▪ Arcing from load current 

▪ Corona, Partial discharge 

▪ Overheated oil 

▪ Overheated paper 

The set of readings for each condition are rendered graphically (one chart for each 

condition) using the specified plot dates as shown in the example of Figure 4-27. The 

date of the readings is also shown in the centre of the four graphs (denoted by the blue 

rectangle). 

Note: The first chart (top left) is replicated below for visibility and description. 
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Figure 4-27: Key Gas charts 

The bar graphs indicate the percentage of each gas as a proportion of the total of the six 

gases being presented. For each gas, the coloured bar (blue in this example) indicates 

the actual percentage and the ‘buff’ bar indicates the threshold percentage used in the 

fault condition indication. The numeric values for the percentages are located across the 

top of the chart, as denoted by the red rectangle, for example, for C2H2. 

The percentage figure in the centre of each graph (denoted by the green rectangle) 

represents the percentage of confidence that it is the most likely fault condition of the 

four. This is influenced by the number and extent of the parameters exceeding their 

thresholds. 
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4.10 Overvoltages 

The Overvoltages worksheet is unique to MS 3000 and 845 Relay devices and plots the 

characteristics of an overvoltage in Kilovolts over time with the user able to select any 

date range as shown in Figure 4-28. Any voltage in excess of the normal operating 

voltage is important to monitor as any surge can disturb electrical equipment. 

 
Figure 4-28: Overvoltages worksheet 
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4.11 Gas Ratios 

The Gas Ratios worksheet displays the concentrations of gases in a three-axis cube 

graph as shown in Figure 4-29. The position of the plot points is indicative of certain fault 

conditions. 

 
Figure 4-29: Gas Ratios worksheet 

The method of plotting the gas ratios can be selected in the Ratios dropdown, 

highlighted by the blue rectangle (top right). The choices are as follows: 

▪ IEC 60599 

▪ IEEE C57.104 

▪ Ratios Table 

The Gas Ratios worksheet automatically uses the last plot point in the timeline with the 

selected values listed in the Selected Point drop down. The trend range that is plotted 

from the main date range is shown in the time line bar (denoted by the red rectangle). 

The plot points (denoted by the green rectangle) are similarly coloured from cyan to dark 

blue along the time line. 

Note: The span of the timeline plotted is the latest available reading within the main 
date range and the last 50 readings prior to that. 

To rotate the cube, hold the left mouse button on one side of the cube and then drag the 

mouse. 

If you select another plot point on the timeline then black dotted lines project its 

position onto the cube surfaces and the Selected Point drop down is updated. The 

Selected Point information on the legend is also updated. A diagnosis for the Selected 

Point is displayed (as highlighted) in the Selected Point drop down. 

The IEEE C57.104 version of the Gas Ratios is shown in Figure 4-30. 
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Figure 4-30: IEEE C57.104 version of Gas Ratios 

In addition, the ‘Ratios Table’ option, an example of which is shown in Figure 4-31, 

indicates the IEC 57.104 Transformer Condition, Rogers Ratio and Doernenburg Ratio, 

with their resultant diagnoses for the selected point. 

 
Figure 4-31 Ratios Table display for Gas Ratios 
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4.12 Ratios 

The Ratios worksheet displays any gas ratio on a trend chart (for lab data, a Transfix or 

DGA 900 device) and the corresponding alarm limits set on the device as shown in Figure 

4-32. The fractional formula line showing how the ratio is calculated is shown below the 

chart. 

 
Figure 4-32: Ratios Trend Graph 

When displaying a preset ratio retrieved from the device, the fractional formula ratio line 

is greyed out, as these values are defined on the device and can only be edited via the 

device setup option. 

To create your own custom ratio, use the Ratios drop down to select Custom Ratio. 

Select the gases for the numerator and denominator on the fractional formula ratio line. 

When this is plotted, there are no appropriate alarm limits to plot, so only the ratio trend 

line is plotted, as shown in Figure 4-33. 
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Figure 4-33: Custom ratio trend plot 

4.13 ETRA.. 

The ETRA worksheet displays gas ratios according to the Japanese ETRA standards. The 

ETRA diagrams dropdown offers two choices: 

▪ Diagram A: classifies overheating and discharges. 

▪ Diagram B: categorises the discharges. 

The page layout follows the same display and control conventions as the Gas Ratios and 

Duval’s worksheets, namely that the: 

▪ type of diagram is selected from the ETRA diagrams dropdown. 

▪ plot points and time line have the earliest plot point represented by a cyan colour 
ranging to deep blue for the most recent plot point. 

▪ selected plot point has dotted lines to the axes to enable the ratio values to be read 
off. 

▪ Selected Point dropdown has the plot point source data values and the diagnosis. 

Figure 4-34 shows ETRA Diagram A for classification of overheating and discharges. The 

diagnosis in this example is D – Discharges. 
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Figure 4-34: ETRA Diagram A 

Figure 4-35 shows ETRA Diagram B details of discharges. The diagnosis in this example is 

PD – Partial Discharges (Low Energy). 

 
Figure 4-35: ETRA Diagram B 

4.14 Duval’s 

Duval’s diagnostics is an alternative method of mapping the gas concentrations to 

possible fault conditions. The Duval’s worksheet as shown in Figure 4-36 is laid out 
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similarly to the Gas Ratios worksheet described previously. The Duval’s Diagnostics 

dropdown offers six available charts: 

▪ Classic 

▪ LTC – the ‘Type 2’ for Load Tap Changer (mineral oil filled) 

▪ Type 4 – Low temperature faults, using different gases from the ‘Classic’ 

▪ Type 5 – Low temperature faults, using the same gases as the ‘Classic’ 

▪ Pentagon 1 – six electrical faults, PD, D1, D2, T3, T2, T1 and stray gassing of mineral oil 
S 

▪ Pentagon 2 –three electrical faults PD, D1, D2 and four thermal faults T3-H, C, O, and 
S 

Note: The ‘Low temperature faults’ Duval’s triangles should only be applied to faults 
identified by the Classic Duval triangle as possible faults PD, T1 or T2, and 
should be viewed only as a complement of information for the Classic Duval 
triangle. 

Figure 4-36 shows a Classic Duval’s Triangle. A data point can be selected either from the 

plot on the Duval’s Triangle or by sliding along the time line at the bottom of the display. 

Both the time line and the plot points are coloured with the earliest plot point 

represented by a cyan colour ranging to deep blue for the most recent plot point. The 

Selected Point dropdown reveals the plot data and the diagnosis for the selected point, 

in this example, an electrical and thermal fault. The other versions of the Duval’s Triangle 

for the same data point are shown below. 

 
Figure 4-36: Duval's Triangle – Classic 

Figure 4-37 shows an LTC example with a T2 diagnosis – severe thermal fault 

(300<T<700 °C, coking). 
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Figure 4-37: Duval's Triangle – LTC example 

Figure 4-38 is a Type 4 example – Low Temperature Faults using Hydrogen, Methane and 

Ethane. Diagnosis S – Stray gassing of mineral oil. 

 
Figure 4-38: Duval's Triangle – Type 4 example 

Figure 4-39 is a Type 5 example – Low Temperature Faults using Methane, Ethylene and 

Ethane. The diagnosis is C – hot spots with Carbonization of paper (T>300 °C). 
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Figure 4-39: Duval's Triangle – Type 5 example 
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Duval’s diagnostics also offers two pentagon representations for 5-gas ratios. 

Figure 4-40 is a Pentagon 1 example using hydrogen, acetylene, ethylene, methane and 

ethane. The diagnosis is S – Stray gassing S of mineral oil at 120 and 200 °C in the 

laboratory. 

 
Figure 4-40: Duval’s Pentagon 1 for 5 gases 

Figure 4-41 is a Pentagon 2 example using hydrogen, acetylene, ethylene, methane and 

ethane. The diagnosis is S – Stray gassing S of mineral oil at 120 and 200 °C in the 

laboratory. 

 
Figure 4-41: Duval’s Pentagon 2 for 5 gases 
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4.15 Models (Intellix MO150 and Hydran M2 devices only) 

The Models worksheet is for Intellix MO150 and Hydran M2 devices only. These devices 

measure an array of parameters (such as current, voltage, temperature and moisture 

etc) that Perception Desktop utilises in algorithms for graphical models to infer other 

transformer conditions. 

The available models are: 

▪ Dynamic Loading: This model provides the operator with a continuous estimation of 
the capacity of the transformer to continue safe operation under temporary 
overloading conditions. See Appendix E.2.1 for a brief description of the model. 

▪ Insulation Ageing: This model monitors the key parameters that lead to the 
breakdown of the insulation paper in the transformer windings. See Appendix E.2.2 
for a brief description of the model. 

▪ Moisture and Bubbling: This model monitors the water content in the oil and the 
current oil temperature compared to the temperature at which bubbles would form 
in the oil (dependent upon the atmospheric pressure). See Appendix E.2.3 for a brief 
description of the model. 

▪ Apparent Power in MVA: This model continuously monitors the load carried by the 
transformer. See Appendix E.2.4 for a brief description of the model. 

▪ Winding Hot-Spot Temperature (WHST): This model uses several parameters to 
estimate the temperature of the hottest spot in the winding, as opposed to the 
general winding temperature. See Appendix E.2.5 for a brief description of the model. 

▪ Cooling Status: This model allows identification of the cooling stage currently in 
service. This information is also essential to other cooling models, such as Cooling 
Efficiency and Cooling Control. See Appendix E.2.6 for a brief description of the model. 

▪ Cooling Efficiency: This model computes the top oil temperature that should be 
expected considering the load current, the ambient temperature, the cooling mode, 
the oil time constant and the altitude. See Appendix E.2.7 for a brief description of the 
model. 

▪ On-Load Tap Changer (OLTC) Tap Position: This model provides additional 
information for monitoring the tap changer driving mechanisms. See Appendix E.2.8 
for a brief description of the model. 

▪ OLTC Differential Temperature: This model continuously compares the top oil 
temperature in the main tank with the tap changer compartment. See Appendix E.2.9 
for a brief description of the model. 

In addition, there are device-specific sensor reading history graphs: 

Hydran M2 Only 

▪ Temperature: Displays the history of various key transformer temperatures: (see 
Appendix E.2.10 for a brief description of the model.) 

➢ RH sensor temperature. 

➢ Heater power (in % of full power). 

➢ Top oil temperature. 

➢ RH sensor hourly average temperature. 

➢ Hydran sensor temperature. 

➢ Base plate temperature. 
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▪ Hydran Readings: Displays the history of various key Hydran readings: (see Appendix 
E.2.11 for a brief description of the model.) 

➢ Hydran reading in ppm. 

➢ Hydran reading hourly trend, in ± ppm. 

➢ Hydran reading daily trend, in ± ppm. 

➢ Hydran sensor temperature. 

Intellix MO150 Only 

▪ Transformer Status: This model provides a display of the main sensors feeding the 
Intellix MO150. It can accommodate up to six analog and/or digital signals and/or 
model outputs. (see Appendix E.2.12 for a brief description of the model). 

➢ Temperature sensors 

➢ Current transformers (CT) for load current 

➢ Hydran® intelligent transmitter 

➢ Aquaoil® 400 relative-humidity-in-oil analyser 

➢ Electric or acoustic partial discharge (PD) detectors 

➢ Geomagnetically-induced current detectors. 

▪ Cooling Control: This model provides additional cooling control features to improve 
the performance of the cooling system. (see Appendix E.2.13 for a brief description of 
the model). 

Figure 4-42 shows a typical format for the Models worksheet for a Hydran device: a 

trending graph with gauges to indicate the spot values. The individual models are 

selected using the tabbed list at the top of the screen. In this example, the display is for 

Hydran Readings. 

 
Figure 4-42: Models > Hydran Readings 

4.15.1 Display Controls 

The Models Trend Graph can be manipulated as follows: 

▪ All the available parameters for a model are plotted on the trend graph, unless they 
are positively de-selected. 
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▪ To de-clutter the trend graph, individual parameters can be de-selected from the plot 
by clicking the relevant square in the colour-coded legend (it toggles to the large size 
to indicate deselection). For example, the upper graph in Figure 4-43 shows all 
parameters plotted, whereas the lower graph shows the purple plot de-selected. 

 
Figure 4-43: Example of deselecting a parameter 

Note: Rest the mouse over a square in the colour-coded legend to see a description of 
the parameter. 

▪ The respective parameter colour also underlines each gauge. The gauges indicate the 
most recent reading in the selected date range. If the cursor is within the graph area, 
then the gauges represent the value at the cursor position. 

▪ The gauges show an analogue reading on a dial with an appropriate scale. The value is 
also shown in digital form at the 6 o’clock position. If there is no digital number, then 
there are no values (as opposed to the value zero). 

▪ Some gauges may have green, yellow and red borders on their circumference as 
shown in Figure 4-44. This indicates that normal, low and high operating ranges are 
set on the Hydran M2 / Intellix MO150 device. 

 
Figure 4-44: Gauge Representation – examples 

▪ Some models have a user-selected averaging period (at the source device). If that is 
the case, the Text parameters between the Gauges and the Graph Plot show the 
settings for the averaging period. 

4.16 Bushing Monitor (Intellix BMT devices only) 

The Bushing Monitor and Partial Discharge (PD) worksheets use polar plots to better 

identify and quantify which bushing (C1 and PF%) or phase (PD) is being affected with 

respect to the others. External factors such as temperature affect all three bushings (and 

thus all three phases) equally. When data is plotted on the polar plots, variations due to 
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common effects are negated and have no effect on the output that is displayed on the 

polar plots. Each plot point represents the sum of all three phases. The radius of the plot 

gives its magnitude (e.g. % change) and the angle on the polar plot gives a visual 

indication of which bushing(s) are affected. 

The Bushing Monitor worksheet presents two polar plots by default displaying the 

following parameters as shown in Figure 4-45. 

▪ The relative change of Capacitance (C1) for a set of three bushings over time. 

▪ The relative change of Power Factor (PF%) for a set of three bushings over time. 

 
Figure 4-45: Bushing Monitor polar plot 

The Intellix BMT devices are shipped from the factory with default alarm settings. Note: 

Alarms are user configurable; refer to the relevant BMT User Manual. If the alarms are 

enabled on the BMT device, the alarms are displayed in the polar plot as colour-coded 

boundaries as shown in Figure 4-46. Green denotes that the amplitude of the polar plot 

is within the acceptable given limits; yellow a warning and red an alarm. 

 
Figure 4-46: Bushing Monitor polar plot — alarms 
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Rest the mouse pointer over any data point on the polar plot to display a tooltip with the 

data point information. 

Right click inside the pane for a shortcut menu with several graphing options as shown in 

Figure 4-47. 

▪ The Plot option offers a choice of a Polar or Histogram view. 

▪ The Bushings option offers a choice of Primary or Secondary bushings. 

▪ The Measurement option offers a choice of measurement parameter either 
percentage change in either Capacitance or Power Factor. 

  
Figure 4-47: Bushing Monitor graphing options 

4.16.1 Display Controls 

The worksheet offers several controls as shown in Figure 4-48. 

 
Figure 4-48: Bushing Monitor polar plot – controls 

4.16.1.1 Date controls 

The blue rectangle in Figure 4-48 highlights the Date controls. 

▪ The Date picker is used to set the date range to display. The range is also shown on 
the Timeline below with the earliest plot point represented by a cyan colour ranging 
to deep blue for the most recent plot point. 

▪ The Reset Dates button resets the date range to include all available data, ending in 
the most recent. 

4.16.1.2 Zoom and Range controls 

The red rectangle in Figure 4-48 highlights the Zoom and Range controls. 
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▪ The Zoom slider controls the radial scale to allow zooming in and out of the polar 
plot. When the polar plot is zoomed in, click and drag with the left mouse button to 
pan the zoomed region within the polar plot. 

▪ The Range selector within the timeline allows the user to display a subset of the 
available data filtered by time. Drag the black markers on the far left and right of the 
timeline accordingly to define a time-bound range of data. Drag the time-bound data 
range to update the polar plot in real time. 

The effects of zooming and restricting the date range are shown in Figure 4-49. Zooming 

in and restricting the date range makes tracking a parameter over time more visible. 

 
Figure 4-49: Bushing Monitor polar plot – zooming 

4.16.1.3 Other controls 

The green rectangle in Figure 4-48 highlights the other controls. These are also shown in 

Figure 4-50. 

 
Figure 4-50: Other controls 

▪ The ‘<<’ or ‘>>’ buttons hide and restore the graphs respectively. 

▪ The ‘graph’ button (left most) toggles the view between a trend chart and a polar plot. 

▪ The ‘?’ button gives a short description of the graph. 

The controls on one pane are independent of the other pane allowing the same dataset 

to be viewed differently alongside each other. For example in Figure 4-51, the left pane 

has been changed to a histogram view, while the right pane shows the same data 

selection and zoom, but using a plain polar view. 
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Figure 4-51: Histogram (left) and polar plot (right) using the same dataset 

The colour of the histogram pixels denote the density of measurements at that point. 

Resting the mouse pointer on a pixel opens a tooltip showing the numerical value 

associated with the pixel’s colour. This is useful when there are a large number of plot 

points: the plain polar view indicates the range of values, while the histogram indicates 

the commonality of the values. The histogram view can also be zoomed to give greater 

density detail. 

4.16.2 Multiple BMT devices 

The Asset Explorer allows multiple Intellix BMT 300/330 devices to be added to a single 

transformer to support the monitoring of multiple sets of bushings as shown in Figure 

4-52. This makes it possible to visualize the monitoring data for multiple sets of bushings 

and easily switch between devices within a single worksheet, such as the Bushing 

Monitor worksheet. Right click the plot area on the worksheet and select the relevant 

BMT device from the shortcut menu as shown in Figure 4-53. 

 

Figure 4-52: Asset Explorer 

 

Figure 4-53: Shortcut menu to choose BMT device 

4.17 Partial Discharge (Intellix BMT devices only) 

The Partial Discharge worksheet renders polar plots displaying the statistical partial 

discharge parameters as measured by the BMT device. The layout consists of three polar 

plots — one in a ‘major’ pane and two in ‘minor’ panes as shown in Figure 4-54. 
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Figure 4-54: Partial Discharge polar plots 

The three polar plots are as follows: 

▪ Partial Discharge Count. 

▪ Partial Discharge Index (PDI) – measured in mW. 

▪ Partial Discharge Value – measured in picocoulombs (pC). 

Rest the mouse pointer over any data point on the major polar plot to display a tooltip 

showing the data point information. 

Right click inside the major pane for a shortcut menu to change the Plot to either Polar 

or Histogram view as shown in Figure 4-55. 

 
Figure 4-55: Partial Discharge graphing options 

Either of the polar plots in the minor panes can be brought into focus by moving it to the 

major pane. Click the relevant ‘double arrow’ << button (denoted by the red circles on 

the top left corner of the minor panes in Figure 4-54) to move a minor polar plot to the 

major pane. 

The worksheet offers similar controls to the Bushing Monitor polar plot to define the 

date range and zoom as described previously in Section 4.16.1. 

Click the ‘trend graph’ button (left most on the major pane) to display a trend chart using 

the values with which the polar plot is built, an example of which is shown in Figure 4-57. 

 
Figure 4-56: Toggle charts 
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Figure 4-57: Partial Discharge trend chart 

The device “High” and “High-High” alarms thresholds are plotted as amber and red lines 

respectively. 

Click the ‘polar plot’ button as shown in Figure 4-58 to return to the polar plot view. 

 
Figure 4-58: Return to Polar view 

4.18 PRPD (Intellix BMT 330 only) 

The PRPD polar plot visualises the Phase Resolved Partial Discharge data patterns (if 

available). The (PRPD) worksheet shows the PD pattern of a grid voltage cycle. This 

pattern can be used to analyse and potentially identify the PD sources. The PRPD tab is 

only available for the Intellix BMT 330 device. The worksheet displays PRPD data from 

the device on a standard 2-D chart, which can also be configured as a histogram. 

Summary information as shown in Figure 4-63 and Figure 4-64 for the PRPD is displayed 

on the ‘PD event info’ panel (top right). If the 2D chart is active, the lower panel (‘Selected 

PD event’) lists the PRPD coordinates of the selected PD event (if selected); or the 

selected pixel density in the case of a histogram. 

4.18.1 Display Controls 

The worksheet offers similar controls e.g. to manipulate the date range as described 

previously in Sections 4.16 and 4.16.1. 

Rest the mouse pointer on any data point (or pixel) to display a tooltip with the data 

point (or pixel) information. 

Right-click inside the pane for a shortcut menu with several graphing options. 

▪ The Plot option offers a choice of a 2D chart or Histogram as shown in Figure 4-66. 
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Figure 4-59: Plot shortcut menu 

▪ The Timeframe option offers a choice of a single PRPD view (one record) or daily view 
as shown in Figure 4-67. 

 
Figure 4-60: Appearance shortcut menu 

▪ The Phase option offers a choice of phases A, B or C as shown in Figure 4-68. 

 
Figure 4-61: Phase shortcut menu 

The Zoom slider controls the scale and allows you to zoom in and out of the PRPD. When 

zoomed in, it is possible to drag the PRPD to pan across the chart. 

To set the PRPD vertical range and the histogram density range, double click the plot to 

open the PRPD Range dialog as shown in Figure 4-62. 

 
Figure 4-62: PRPD Range dialog 

4.18.2 2D Chart 

The standard 2D chart shown in Figure 4-63 plots the PD events as per the phase angle 

of the grid voltage in degrees (X-axis) and the apparent charge (pC) (Y-axis). 
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Figure 4-63: PRPD standard 2-D chart 

4.18.3 Histogram 

The histogram shown in Figure 4-64 uses the same axes as the 2D chart to plot the same 

data, but adds the PD event density as colour. The colour scheme for the histogram is 

shown in the legend at the bottom of Figure 4-64 where the density (the number of 

events per one thousand cycles) is depicted by a particular colour. 

 
Figure 4-64: PRPD histogram 

4.19 Inter-Phase Angle (Intellix BMT devices only) 

The Inter-Phase Angle worksheet as shown in Figure 4-65 uses an Inter-Phase Angle plot 

to display the temporal evolution of angles, with the time increasing radially. The Inter-

Phase Angle polar plot displays the measured angles in a more intuitive way than could 

otherwise be achieved with a trend chart. The worksheet displays the measured Angle 

A-B and Angle A-C against the expected respective angles. The Phase Angle Caution and 

Alarm limits as configured on the Intellix BMT 330 device are also shown. 
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Figure 4-65: Inter-Phase Angle 

4.19.1 Display Controls 

The worksheet offers similar controls e.g. to manipulate the date range as described 

previously in Sections 4.16 and 4.16.1. 

Move the mouse pointer on the plot area and a tooltip displays the date and timestamp 

of the Marker Line, while the legend (top right) displays the angle values. 

Right-click inside the pane for a shortcut menu with several graphing options. 

▪ The Bushings option offers a choice of Primary or Secondary Bushings as shown in 
Figure 4-66. 

 
Figure 4-66: Bushings shortcut menu 

▪ The Appearance option toggles the Marker Line On or Off as shown in Figure 4-67. 

 
Figure 4-67: Appearance shortcut menu 

▪ The View option toggles the Legend On or Off as shown in Figure 4-68. 
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Figure 4-68: View shortcut menu 

The Zoom slider allows you to change the magnification of the Inter-Phase Angle plot. 

The Phase Angle Caution and Alarm limits are also available on the Data Table 

worksheet as shown in Figure 4-69. Rest the mouse pointer on any Angle point value to 

obtain a tooltip that includes phase angle caution and alarm limits. 

 
Figure 4-69: Data Table with Caution and Alarm limits tooltip 

The Phase Angle Caution and Alarm limits are also available on the Status worksheet as 

shown in Figure 4-70. 

 
Figure 4-70: Status worksheet with Caution and Alarm limits 
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4.20 Web Browser (MS 3000 & DGA 900 only) 

The Web Browser worksheet displays web content as rendered on the remote HMI of an 

MS 3000 or DGA 900 device as shown in Figure 4-71. 

 
Figure 4-71: MS 3000 Log-in screen 

The HMI uses an integrated frameless browser for interacting with the products. To open 

the web browser, click the tab or select the Setup context menu item from the 

appropriate asset in the Perception fleet tree (left pane). The web browser state is saved 

while navigating between worktabs of the same asset, but is reset after switching to 

another asset. To access web content, ensure that a valid Host name or IP address for 

the product is specified in the Communications section of the Properties worksheet as 

shown in Figure 4-72. 

 
Figure 4-72: Properties – Communications – IP address 
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5 OTHER TOOLS & FUNCTIONALITY 

5.1 Downloading Data… 

5.1.1 …Via Perception 

To download data from a device, right click on the device in the Asset Explorer and select 

Download as shown in Figure 5-1. This starts the manual download. The device node in 

the Asset Explorer gains a spinning blue icon to show that the download is in progress. 

 
Figure 5-1: Download 

If the Properties worksheet is open, the progress bar in the Device Connection section 

will show the download progress as shown in Figure 5-2. 

 
Figure 5-2: Download progress 
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To cancel the download, right click on the device and select Cancel Download as shown 

in Figure 5-3. 

 
Figure 5-3: Cancel Download 

When used in conjunction with Perception Server, the download of data can also be 

scheduled to occur automatically (see Section 3.8.4.3). Note: Data can also be manually 

downloaded during scheduled download intervals. 

5.1.2 …Via USB 

Data download from a Transfix device using the USB communications support must be 

performed via the TransConnect application as shown in Figure 5-4. 

Note: The TransConnect application is automatically installed with Perception 
Desktop. The default location is ‘Programs/GE Energy’. 

The steps are as follows: 

▪ Close Perception Desktop. 

▪ Select Start > All Programs > GE Energy > Perception > TransConnect to open the 
TransConnect application. 
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Figure 5-4: TransConnect 

▪ Connect your PC to the Transfix via a USB port. 

▪ The Transfix device should be listed under Local Connections. Select this device, 
connect to it and then choose the option to download the latest records. 

Note: The data is stored in a temporary folder called “FileWatcher”. 

▪ Exit the TransConnect application. 

Upon next starting Perception Desktop, the downloaded data will be automatically 

imported from the FileWatcher folder to the database that Perception Desktop is 

connected to on launch. 

Note: If you have a copy of Perception Express on your PC and launch that before 
Perception Desktop, then the downloaded data will be imported to the 
Perception Express database. Since Perception Desktop already includes all the 
features of Perception Express, it is recommended that any prior copies of 
Perception Express be removed. 
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5.2 Exporting and Importing Data 

Perception provides several options for configuring the export and import of data using a 

CSV file. This includes alarm information for all device types, measurement diagnostics 

and quality status information. In addition, the Perception Server Configuration tool 

allows you to define any custom CSV format. However, Perception recognises three CSV 

formats out of the box: 

▪ Perception 

▪ TransConnect 

▪ TOA4 

5.2.1 Export 

You can export assets (transformers and/or devices) to a Perception format standalone 

CSV file at the database, parent or device-node level. This is useful if you want to copy 

data to another system to perform, for example, custom analysis. Other export options 

are listed in Table 5-1. 

Table 5-1: Export options 

Properties Export all the attributes specified on the Properties page along 
with the corresponding asset hierarchy. 

Measurements Export device measurement data plus the corresponding asset 
hierarchy only. 

‘Uncertain’ and ‘Bad data’ are attributed with diagnostic 
information for each data point. Uncertain data values are 
appended with ‘!U’. Bad data values are appended with ‘!B’. 

Ranking History Export the ranking history data as described in Section 3.10. 

All Data Export everything – all the Properties, Measurements and Alarms 
as defined above. 

Right click the asset in the Asset Hierarchy or select Actions > Export to see the 

available export options as shown in Figure 5-5. Select an option e.g. All Data. 
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Figure 5-5: Export options 

The ‘Save Exported File As’ dialog as shown in Figure 5-6 allows you to save the data to a 

Perception format CSV data file. To do this, navigate to a suitable location, specify a 

name for the CSV file or select an existing file to overwrite, and then click Save to export 

the data using this format. 

 
Figure 5-6: Save as a CSV file 

The parent-child relationship depicted in the Asset Hierarchy is also included as part of 

every export. During an import, this allows assets to be recreated on the recipient 

machine in the same structured way as the source machine. The metadata for the 

hierarchy of assets is represented in the CSV file in the following way: A parent column is 

created in the CSV file and that is used to store the value of the parent node against 
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each asset value in the ‘Equipnum’ column. If there is no parent node for an asset, then 

the value of the parent column is left blank against the respective asset value. On import, 

this asset will be created at the highest level in the asset hierarchy i.e. directly under the 

database node. 

5.2.2 Import 

You can import assets (transformers and/or devices) from a CSV file that adheres to one 

of the formats listed in Section 5.1. The CSV file may include asset properties, device 

measurement data, ranking history and the corresponding asset hierarchy, depending on 

the options chosen at the time of export. 

In Perception Desktop, select Actions > Import > Import File… as shown in Figure 5-7. 

 
Figure 5-7: Import a file 

The Open dialog allows you to select a CSV file. Click Open to import the contents of the 

file to the database as shown in Figure 5-8. 

 
Figure 5-8: Open a CSV file 

A progress bar is displayed during the import. The diagnostic information that 

accompanies ‘Uncertain’ and ‘Bad data’ is also included as part of the import, along with 

the metadata to reconstruct the parent-child node structure in the Asset Explorer. 

Note: The import may take several minutes (depending on the size of the file) during 
which time you cannot manipulate the asset hierarchy. 

Note: Alarms are also imported, including those from Transport X units that use 
firmware v1.12.6.567 or later. 
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Note: Nameplate information that is imported to the database is not time stamped. If 
a TOA file contains several rows of nameplate information for one device, only 
the first row for each compartment is imported. See Section 3.8.1. 

If the data values of the following fields in the CSV file match all the asset attributes on 

the Properties pages, then the asset already exists in the database and is updated 

accordingly with any new data from the CSV file. These fields are: 

➢ Equipnum: the name of the transformer 

➢ Serialnum: the serial number of the transformer 

➢ Apprtype: device type (TRN for transformer) 

If any one of the fields does not match, then the asset is considered to be new. A new 

asset node will then be created in the Asset Hierarchy at the desired level as per the 

data value listed in the parent column of the CSV file for the asset. The position of new 

assets can be rearranged as required. See Section 3.2.4. 

The import summary dialog is displayed, and if the import is problematic, it will also 

include a link to the corresponding log file. The log file records details of the import 

including any errors and is saved in the same location as the imported CSV file. 

5.3 Downloading Service Logs 

Service and factory logs can be downloaded from some devices, either remotely over a 

network, or directly from a Transfix via a USB connection. To configure the download, use 

the menu option Tools > Download Service Logs.... Note: You can also right click the 

device to access a shortcut menu option. 
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Figure 5-9: Download Service Logs - Network 

The Media field defaults to a Network source as shown in Figure 5-9. For a network 

source, you must supply the IP address and enter the secure POTM code. To obtain the 

POTM code, please contact GE. Finally, enter the destination folder on your PC or use the 

Browse (…) button to navigate to the destination folder. 

 
Figure 5-10: Download Service Logs - USB 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 125 of 199 

If you are onsite at the Transfix, select USB in the Media field. The dialog changes to 

reflect the setup as shown in Figure 5-10. For a USB direct connection, you need only 

supply the destination folder on your laptop. 

Note: You must use the USB port inside the Transfix (located behind the Control 
panel). 

This resulting file can then be sent to GE for analysis. 

5.4 Data Viewing Options 

Select Tools > Options > View to examine a couple of options for viewing the data as 

shown in Figure 5-11. 

 
Figure 5-11: Tools > Options > View 

▪ Show data points without measurements: By default, any data points without 
measurement values are excluded to aid the identification of trends and ensure a 
smooth plot. To include these data points irrespective of their null values, select 
Show data points without measurements. 

▪ Mark Calculated Values: Select Mark Calculated Values to identify all values that 
result from a calculation of other measurements. By default, this option is not 
selected since many values are obviously calculations e.g. TDCG, but not all are 
obvious, so it may on occasion be useful to explicitly identify them. For example, the 
nitrogen value comes not from a direct nitrogen measurement, but a calculation using 
other directly measured parameters. Calculated values are marked with an asterix ‘*’ 
at the end of the display name e.g. Nitrogen*. 

5.5 Transformer Report 

The Transformer Report is a multi-page report that contains key overview details of the 

transformer using Perception-based data. 

Note: The report is generated as a Microsoft Word document and can be found in the 
Documents folder of the local machine. 

To generate the report, right click on a Transformer asset in the asset tree as shown in 

Figure 5-12. 
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Figure 5-12: Transformer Status report context menu 

The Report option lists the selected transformer with any qualifying child assets below. 

Select an asset to launch the Report Configuration Wizard as shown in Figure 5-13. 

 
Figure 5-13: Report Configuration Wizard 

The Report Configuration Wizard allows the report content to be customized as follows: 

▪ The Date Range sets the range of dates that the report will span. 

▪ The Include section – choose from DGA, BMT and Fleet ranking. 
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▪ The Source dropdown allows you to select the relevant oil source. 

▪ The Gases dropdown allows you to select multiple variables. 

▪ The Duval’s Triangle dropdown allows you to select which of the six Duval’s 
diagnostics options to display on the report. 

▪ The Gas Ratio dropdown allows you to select which of the two gas ratio diagnostics 
to display on the report. 

Note: The diagnostic information provided by the Gas Ratio is displayed on the report 
(above the conclusion). However, the Gas Ratio diagram is not displayed. 

▪ The Select Trend Chart dropdown contains a list of the trend charts available for the 
report. If you have multiple trend charts in the device workbook area, these will 
appear here. You can choose to use one of the predefined trend charts or you can 
create a custom trend chart. To create a custom trend chart, select from the available 
variables to display as shown in Figure 5-13. 

▪ The Reset button resets all options back to the default settings. 

▪ The Report button generates the report on the local machine and the adjacent 
checkbox opens the report on completion. 

A sample first page of the Transformer report is shown in Figure 5-14. 

 
Figure 5-14: Transformer Status Report 

The first pages contain the: 

▪ Report Date and Date Range of the data contained in the report 

▪ Organisation Details 

▪ Transformer Details 
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▪ List of online DGA equipment and Status (in alarm or not) 

The following pages lists the DGA alarm information for each Source. The report also 

contains three free-text entry boxes – Introduction, Summary and Conclusion, which the 

user can populate before printing. 

The remaining pages relate to the DGA analysis with trend charts, DGA diagnostics 

(Duval, Key Gas, Gas Ratio, TDCG, CO2\CO with hot metal gases), Bushing analysis and 

Risk and Rank analysis (if selected in the Report Configuration Wizard). 

5.6 Workflow Scheduler 

Workflows can be scheduled from Perception Desktop via the Tools menu as shown in 

Figure 5-15. 

 
Figure 5-15: Tools menu 

Click the Workflow Scheduler option to launch the ‘Workflow Scheduler’ dialog as 

shown in Figure 5-16. 

 
Figure 5-16: Workflow Scheduler dialog 

To manually execute all workflows, click the Execute All Workflows button to instantly 

perform a data evaluation. 

To enable scheduling, select the Enabled checkbox and then specify when the workflow 

should run. For example, every 6 hours of every day is specified as shown in Figure 5-17. 
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Figure 5-17: Workflow Scheduler enabled 

5.7 Launching External Applications 

External applications can be launched from Perception Desktop via the Tools menu as 

shown in Figure 5-18. 

 
Figure 5-18: External Tools Menu Option 

Select the External Tools option to launch the ‘External Tools’ dialog as shown in Figure 

5-19. 

 
Figure 5-19: External Tools dialog 
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To create a new entry, click the Add button as shown in Figure 5-20. The Title and Path 

fields become available and must be populated. 

 
Figure 5-20: External Tools dialog – after clicking ‘Add’ 

Enter the name of the external tool and the path of the executable file in the respective 

fields. 

Note: A (…) browse button to the right of the path field allows you to browse to the 
executable location. 

Figure 5-21 shows an example of adding Windows ‘Notepad’ as a tool. 

 
Figure 5-21: External Tools – Notepad example 

You can also add an argument parameter to the external tool. The argument can be a 

command or file to open when the external application is launched. An example is shown 

in Figure 5-22. 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 131 of 199 

 
Figure 5-22: External Tools – Notepad example with an argument 

Click OK to add the configured external tool to the Tools menu as shown in Figure 5-23. 

 
Figure 5-23: Tools Menu option with Notepad added to external tools 

Any of the listed externals tools can be launched independently from Perception 

Desktop, if configured correctly. 

To delete an external tool: 

▪ Select Tools > External Tools to launch the ‘External Tools’ dialog. 

▪ Select the external tool entry to delete and click Delete. 

▪ Click Yes to the prompt as shown in Figure 5-24. 
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Figure 5-24: Deleting an External Tool 

The external tool is no longer listed on the Tools menu as shown in Figure 5-25. 

 
Figure 5-25: Tools Menu with Notepad removed 

5.8 Transport X2 Options 

The Transport X2 device is represented in the Asset Hierarchy and appears above the 

root node as shown in Figure 5-26. 

Note: The asset is automatically detected about 30 seconds after the device is 
connected to a PC with Perception Desktop. 

 
Figure 5-26: Transport X2 Asset hierarchy 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 133 of 199 

The Properties worksheet contains some basic information about the device, such as the 

serial number as shown in Figure 5-27. To establish communication with the device, the 

connection needs to be confirmed on the device side. From the Transport X2 touchscreen 

Main Menu, press PC Sync. 

 
Figure 5-27: Transport X2 Properties worksheet – before connection 

The Properties worksheet details additional sections (Statistics & Measurements) as 

shown in Figure 5-28. 

 
Figure 5-28: Transport X2 Properties tab – after connection 

If new measurements are detected after successful connection to a PC, the user is 

advised to download the data as shown in Figure 5-29 (or this action can be performed 

later as described below). 

 
Figure 5-29: Transport X2 Download measurements message 

Right click on the Transport X2 asset to see the available options as shown in Figure 5-30. 
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Figure 5-30: Transport X2 options 

▪ Download: retrieves all measurements stored on the device and creates appropriate 
transformer nodes in the asset tree (or adds additional information to existing nodes 
based on serialnum / equipnum id). 

▪ Download Logs: retrieves debugging and sustaining information from the device to 
be used by service engineers. 

▪ Export to CSV: export all Transport X2 data to a CSV file to maintain compatibility 
with a legacy requirement. Note: When exporting to CSV, the file is automatically 
adjusted to the regional settings on the local machine. 
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Appendix A Installing the Transport X driver in Windows 7 

Transport X is a portable device that can be used onsite to sample oil by direct 

connection to the assets. The Transport X device is then brought back to the office and 

connected via USB to your PC. The data collected from the assets is then transferred to 

your PC and Perception will then load the data into the server database. 

The Transport X device is installed in the same manner as any plug and play device 

attached to a PC. 

A.1 Installing Mobile Device Center 

The generic Microsoft Mobile Device Center must be downloaded from the Microsoft 

website. 

For Windows Vista/7 x86 (32-Bit): 

http://www.microsoft.com/download/en/details.aspx?displaying=en&id=14 

For Windows Vista/7 x86 (64-Bit): 

http://www.microsoft.com/en-us/download/details.aspx?id=3182 

As part of the download process, you will have to allow the Microsoft Validation to take 

place. More information about the Validation requirements can be obtained by a ‘click 

here’ link as shown in Figure A-1. 

 
Figure A-1: Validation 

After the validation process click Download as shown in Figure A-2. 
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Figure A-2: Download 

Then click Run on the File Download - Security Warning dialog as shown in Figure A-3. 

 
Figure A-3: Security Warning 

And click Run again on the Internet Explorer – Security Warning dialog as shown in 

Figure A-4. 

 
Figure A-4: Browser Security Warning 
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The software prepares to install and displays the following series of dialogs as shown in 

Figure A-5. 

 

 

 

 
Figure A-5: Installation dialogs 

If Figure A-6 appears during the process or at the end, then the installation has been 

unsuccessful. Click the Close button and install the Transport X device manually as 

outlined in Section A.2. 

 
Figure A-6: Unsuccessful device driver installation 
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A.2 Installing Transport X 

To connect the Transport X (running Windows CE 5.0 or 4.2) to a computer running 

Windows 7, follow the steps below: 

▪ Power up the device. 

▪ Connect the device to your computer with the supplied USB cable. 

▪ You will see a ‘Found New Hardware’ screen. 

▪ If you had already installed or attempted installing a driver, you can right-click 
Computer, choose Manage and go to Device Manager. 

▪ If the device appears under ‘Mobile Devices’, then use the ‘Update Device Driver’ 
utility. 

▪ Select the option to locate and install software as shown in Figure A-7. 

 
Figure A-7: Control Panel 

▪ Under Devices and Printers, select Device Manager as shown in Figure A-8. 
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Figure A-8: Devices and Printers 

▪ Expand Other devices to display Kelman Transport X as shown in Figure A-9. 

 
Figure A-9: Device Manager 

▪ Right-click Kelman Transport X and select Update Driver Software as shown in 
Figure A-10. 
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Figure A-10: Device Manager – Update Driver Software 

▪ On the Windows Permission Request screen, click Continue. 

▪ On the next screen, select Browse my computer for driver software as shown in 
Figure A-11. 

 
Figure A-11: Update Driver Software - Kelman Transport X 
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▪ Select Let me pick from a list of device drivers on my computer as shown in 
Figure A-12. 

 
Figure A-12: Browse for driver software 

▪ Select Mobile devices, then click Next as shown in Figure A-13. 

 
Figure A-13: Choose the device type 

▪ Clear the Show compatible hardware checkbox. 
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▪ In the Manufacturer column, choose Microsoft as shown in Figure A-14. 

▪ In the Model column, choose Microsoft USB Sync. 

▪ Click Next. 

 
Figure A-14: Select the device driver 

▪ Select Connect without setting up your device. 

▪ In the ‘Update Driver Warning’ dialog, click Yes as shown in Figure A-15. 

 
Figure A-15: Update driver warning 
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▪ The Installing Driver Software progress bar displays as shown in Figure A-16. 

 
Figure A-16: Installation progress bar 

▪ When the driver has successfully updated, the following screen as shown in Figure 
A-17 displays. 

 
Figure A-17: Driver update complete 
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▪ A successful connection is indicated by a green check mark and the word ‘Connected’ 
as shown in Figure A-18. 

 
Figure A-18: Successful connection 
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Appendix B Database Mappings for Import and Export 

During a Perception export, only the browse names get exported to the CSV file for oil source and 

peripheral measurements including their group names. For example, multiple oil sources, such as 

the Main, Selector and Diverter tanks, are represented in the software with the following browse 

names OilSourceA, OilSourceB and OilSourceC respectively. On export it is only these underlying 

browse names that get exported to the CSV file (not the user-defined names for multiple oil 

sources specified in the device setup). The reason for this is that Perception analytics (such as 

Duval, GasRatio, KeyGas) recognises only the browse name for the oil sources. Common browse 

names also allow Perception data to be imported into any other localised version of Perception. 

Table B-1 lists all the CSV headers, the corresponding field mappings in the Perception database 

and a brief description below (where required). When creating custom import and export 

mappings, refer to this table to ensure valid data exchange. 

Table B-1: Database Mappings 

CSV header Field mapping 

equipnum equipnum 

The name of the asset shown in the Asset Explorer on import. Data must contain an ‘equipnum’ or 
‘Serialnum’ field. 

assettype assettype 

The type of asset. Required, otherwise a transformer asset will be created on import (used for TOA and 
TransportX format files). 

assettype = HydranM2, MO150, Transfix1_6, MiniTrans, DGA500, MultiTrans, TapTrans, DualTrans, BMT300, 
Transfix1_5, Transformer, TransformerBank, Hydran201ti, SubStation, Area 

Serialnum SerialNumber 

The serial number of the asset. Data must contain an ‘equipnum’ or ‘Serialnum’ field. 

sampledate sampledate 

The data records. Required field if importing ‘measurement data’. If importing ‘properties’ only, this field can 
be omitted. 

Tank Tank 

The tanks listed under the transformer. Required for the import of TOA format files only. 

apprtype apprtype 

The type of asset. E.g. Transfix 1.6 (used for Perception and TransConnect format files). 

apprtype = HydranM2, MO150, Transfix1_6, MiniTrans, DGA500, MultiTrans, TapTrans, DualTrans, BMT300, 
Transfix1_5, Transformer, TransformerBank, Hydran201ti, SubStation, Area 

pgaerrorcodes pgaerrorcodes 

 

OilSourceA|H2 OilSourceA|H2 

The first value denotes the measurement group or oil source that gets created on import, the second value 
denotes a measurement point under that group or oil source. Required for all CSV headers, except the 
following: 

headers that represent property fields 

headers appended with the text ‘Diagnostic’. 

OilSourceA|H2|Diagnostic OilSourceA|H2|Diagnostic 

Any header format appended with the text ‘Diagnostic’, imports the diagnostic information for the 
measurement where the data is of bad or uncertain quality (!B or !U). 

OilSourceA|CH4 OilSourceA|CH4 
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OilSourceA|CH4|Diagnostic OilSourceA|CH4|Diagnostic 

 

OilSourceA|C2H2 OilSourceA|C2H2 

 

OilSourceA|C2H2|Diagnostic OilSourceA|C2H2|Diagnostic 

 

OilSourceA|C2H4 OilSourceA|C2H4 

 

OilSourceA|C2H4|Diagnostic OilSourceA|C2H4|Diagnostic 

 

OilSourceA|C2H6 OilSourceA|C2H6 

 

OilSourceA|C2H6|Diagnostic OilSourceA|C2H6|Diagnostic 

 

OilSourceA|CO OilSourceA|CO 

 

OilSourceA|CO|Diagnostic OilSourceA|CO|Diagnostic 

 

OilSourceA|CO2 OilSourceA|CO2 

 

OilSourceA|CO2|Diagnostic OilSourceA|CO2|Diagnostic 

 

OilSourceA|O2 OilSourceA|O2 

 

OilSourceA|O2|Diagnostic OilSourceA|O2|Diagnostic 

 

OilSourceA|TDCG OilSourceA|TDCG 

 

OilSourceA|TDCG|Diagnostic OilSourceA|TDCG|Diagnostic 

 

OilSourceA|H2O OilSourceA|H2O 

 

OilSourceA|H2O|Diagnostic OilSourceA|H2O|Diagnostic 

 

OilSourceA|AmbientTemp OilSourceA|AmbientTemp 

 

OilSourceA|AmbientTemp|Diagnostic OilSourceA|AmbientTemp|Diagnostic 

 

OilSourceA|NormalizationTemp OilSourceA|NormalizationTemp 

 

OilSourceA|NormalizationTemp|Diagnostic OilSourceA|NormalizationTemp|Diagnostic 

 

OilSourceA|OilPressure OilSourceA|OilPressure 

 

OilSourceA|OilPressure|Diagnostic OilSourceA|OilPressure|Diagnostic 

 

OilSourceA|OilTemp OilSourceA|OilTemp 
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OilSourceA|OilTemp|Diagnostic OilSourceA|OilTemp|Diagnostic 

 

OilSourceA|N2 OilSourceA|N2 

 

OilSourceA|N2|Diagnostic OilSourceA|N2|Diagnostic 

 

OilSourceA|TDG OilSourceA|TDG 

 

OilSourceA|TDG|Diagnostic OilSourceA|TDG|Diagnostic 

 

Peripherals|Analog|Analog Input-2 Peripherals|Analog|Analog Input-2 

On import of this header format, for example, a ‘Peripherals’ group is created with an ‘Analog’ subgroup. 
Input-2 is the measurement created under the Analog subgroup. This interpretation is similar for all 
peripheral inputs. 

Note: If the CSV header contains more than one attribute separated by a pipe character (|), it is the value 
after the last pipe character that is considered the measurement point. All preceding values are treated as 
subgroups. The only exceptions to this behavior are headers with the appendage ‘Diagnostic’. 

Peripherals|Analog|Analog Input-1 Peripherals|Analog|Analog Input-1 

 

Peripherals|Analog|Analog Input-6 Peripherals|Analog|Analog Input-6 

 

Peripherals|Analog|Analog Input-5 Peripherals|Analog|Analog Input-5 

 

Peripherals|Analog|Analog Input-4 Peripherals|Analog|Analog Input-4 

 

Peripherals|Analog|Analog Input-3 Peripherals|Analog|Analog Input-3 

 

Peripherals|TransOpto|Channel1 Peripherals|TransOpto|Channel1 

 

OilSourceB|H2 OilSourceB|H2 

 

OilSourceB|CH4 OilSourceB|CH4 

 

OilSourceB|C2H2 OilSourceB|C2H2 

 

OilSourceB|C2H4 OilSourceB|C2H4 

 

OilSourceB|C2H6 OilSourceB|C2H6 

 

OilSourceB|CO OilSourceB|CO 

 

OilSourceB|CO2 OilSourceB|CO2 

 

OilSourceB|O2 OilSourceB|O2 

 

OilSourceB|TDCG OilSourceB|TDCG 

 

OilSourceB|H2O OilSourceB|H2O 
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OilSourceB|AmbientTemp OilSourceB|AmbientTemp 

 

OilSourceB|NormalizationTemp OilSourceB|NormalizationTemp 

 

OilSourceB|OilPressure OilSourceB|OilPressure 

 

OilSourceB|OilTemp OilSourceB|OilTemp 

 

OilSourceB|N2 OilSourceB|N2 

 

OilSourceC|H2 OilSourceC|H2 

 

OilSourceC|CH4 OilSourceC|CH4 

 

OilSourceC|C2H2 OilSourceC|C2H2 

 

OilSourceC|C2H4 OilSourceC|C2H4 

 

OilSourceC|C2H6 OilSourceC|C2H6 

 

OilSourceC|CO OilSourceC|CO 

 

OilSourceC|CO2 OilSourceC|CO2 

 

OilSourceC|O2 OilSourceC|O2 

 

OilSourceC|TDCG OilSourceC|TDCG 

 

OilSourceC|H2O OilSourceC|H2O 

 

OilSourceC|AmbientTemp OilSourceC|AmbientTemp 

 

OilSourceC|NormalizationTemp OilSourceC|NormalizationTemp 

 

OilSourceC|OilPressure OilSourceC|OilPressure 

 

OilSourceC|OilTemp OilSourceC|OilTemp 

 

GasRatioFormulaContainer|OilSourceA|FormulaInfo1|Formula 

GasRatioFormulaContainer|OilSourceA|FormulaInfo2|Formula 

GasRatioFormulaContainer|OilSourceA|FormulaInfo3|Formula 

GasRatioFormulaContainer|OilSourceA|FormulaInfo4|Formula 

GasRatioFormulaContainer|OilSourceA|FormulaInfo5|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo1|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo2|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo3|Formula 
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GasRatioFormulaContainer|OilSourceB|FormulaInfo4|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo5|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo1|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo2|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo3|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo4|Formula 

GasRatioFormulaContainer|OilSourceB|FormulaInfo5|Formula 

GasRatioFormulaContainer|OilSourceC|FormulaInfo1|Formula 

GasRatioFormulaContainer|OilSourceC|FormulaInfo2|Formula 

GasRatioFormulaContainer|OilSourceC|FormulaInfo3|Formula 

GasRatioFormulaContainer|OilSourceC|FormulaInfo4|Formula 

GasRatioFormulaContainer|OilSourceC|FormulaInfo5|Formula 

 

GasRatioFormulaContainer|OilSourceA|FormulaInfo1|FormulaName 

GasRatioFormulaContainer|OilSourceA|FormulaInfo2|FormulaName 

GasRatioFormulaContainer|OilSourceA|FormulaInfo3|FormulaName 

GasRatioFormulaContainer|OilSourceA|FormulaInfo4|FormulaName 

GasRatioFormulaContainer|OilSourceA|FormulaInfo5|FormulaName 

GasRatioFormulaContainer|OilSourceB|FormulaInfo1|FormulaName 

GasRatioFormulaContainer|OilSourceB|FormulaInfo2|FormulaName 

GasRatioFormulaContainer|OilSourceB|FormulaInfo3|FormulaName 

GasRatioFormulaContainer|OilSourceB|FormulaInfo4|FormulaName 

GasRatioFormulaContainer|OilSourceB|FormulaInfo5|FormulaName 

GasRatioFormulaContainer|OilSourceC|FormulaInfo1|FormulaName 

GasRatioFormulaContainer|OilSourceC|FormulaInfo2|FormulaName 

GasRatioFormulaContainer|OilSourceC|FormulaInfo3|FormulaName 

GasRatioFormulaContainer|OilSourceC|FormulaInfo4|FormulaName 

GasRatioFormulaContainer|OilSourceC|FormulaInfo5|FormulaName 

 

Peripherals|Digital|Digital Input-1 Peripherals|Digital|Digital Input-1 

 

Peripherals|Digital|Digital Input-2 Peripherals|Digital|Digital Input-2 

 

Peripherals|Digital|Digital Input-3 Peripherals|Digital|Digital Input-3 

 

Hydran|Hydran Hourly Trend Period Hydran|Hydran Hourly Trend Period 

The first value denotes the measurement group that gets created on import e.g. Hydran, the second value 
denotes a measurement point under that group e.g. Hydran Hourly Trend Period. This interpretation is 
similar for all CSV headers of this format. 

Hydran|Hydran Daily Trend Period Hydran|Hydran Daily Trend Period 

 

System|Battery System|Battery 

 

System|Transformer Type System|Transformer Type 

 

Moisture|%RH Hourly Average Period Moisture|%RH Hourly Average Period 
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Moisture|Standard Temperature for RH Moisture|Standard Temperature for RH 

 

Temperature|Ambient Temperature Temperature|Ambient Temperature 

 

Temperature|Top Oil Temperature Temperature|Top Oil Temperature 

 

Temperature|Calculated Top Oil Temperature Temperature|Calculated Top Oil Temperature 

 

Temperature|Calculated Top Oil Difference Temperature|Calculated Top Oil Difference 

 

Temperature|Calculated Bottom Oil Temperature Temperature|Calculated Bottom Oil Temperature 

 

Power|Apparent Power from H Winding Power|Apparent Power from H Winding 

 

Power|Apparent Power from X Winding Power|Apparent Power from X Winding 

 

Power|Apparent Power from Y Winding Power|Apparent Power from Y Winding 

 

Current|Current Winding H Current|Current Winding H 

 

Current|Current Winding X Current|Current Winding X 

 

Current|Current Winding Y Current|Current Winding Y 

 

Winding Hot Spot|Per Unit load on the most loaded 
winding 

Winding Hot Spot|Per Unit load on the most loaded 
winding 

 

Winding Hot Spot|Winding Hot-Spot Temperature in 
Winding H 

Winding Hot Spot|Winding Hot-Spot Temperature 
in Winding H 

 

Winding Hot Spot|Winding Hot-Spot Temperature in 
Winding X 

Winding Hot Spot|Winding Hot-Spot Temperature 
in Winding X 

 

Winding Hot Spot|Winding Hot-Spot Temperature in 
Winding Y 

Winding Hot Spot|Winding Hot-Spot Temperature 
in Winding Y 

 

Winding Hot Spot|Highest Winding Hot-Spot 
Temperature 

Winding Hot Spot|Highest Winding Hot-Spot 
Temperature 

 

Winding Hot Spot|Per Unit load on the most loaded 
winding corrected for Ambient and Altitude 

Winding Hot Spot|Per Unit load on the most loaded 
winding corrected for Ambient and Altitude 

 

Winding Hot Spot|Highest Winding Hot-Spot 
Temperature Source Winding 

Winding Hot Spot|Highest Winding Hot-Spot 
Temperature Source Winding 

 

Winding Hot Spot|Per Unit load on the most loaded 
winding source 

Winding Hot Spot|Per Unit load on the most loaded 
winding source 

 

OLTC|OLTC Tank Temperature OLTC|OLTC Tank Temperature 
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OLTC|OLTC Differential Temperature OLTC|OLTC Differential Temperature 

 

OLTC|Short Term Average of Tap Changer 
Temperature Differential 

OLTC|Short Term Average of Tap Changer 
Temperature Differential 

 

OLTC|Short Term Filtering Value OLTC|Short Term Filtering Value 

 

OLTC|Long Term Average of Tap Changer Temperature 
Differential 

OLTC|Long Term Average of Tap Changer 
Temperature Differential 

 

OLTC|Long Term Filtering Value OLTC|Long Term Filtering Value 

 

Cooling|Cooling Efficiency Index Cooling|Cooling Efficiency Index 

 

Cooling|Cooling Stage 0 Total Activity Time Cooling|Cooling Stage 0 Total Activity Time 

 

Cooling|Cooling Bank1 Total Activity Time Cooling|Cooling Bank1 Total Activity Time 

 

Cooling|Cooling Bank2 Total Activity Time Cooling|Cooling Bank2 Total Activity Time 

 

Cooling|Cooling Bank 1 Current Cooling|Cooling Bank 1 Current 

 

Cooling|Cooling Bank 2 Current Cooling|Cooling Bank 2 Current 

 

Cooling|Cooling Bank1 Activated Cooling|Cooling Bank1 Activated 

 

Cooling|Cooling Bank2 Activated Cooling|Cooling Bank2 Activated 

 

Cooling|Cooling Stage Cooling|Cooling Stage 

 

Insulation Aging|Thermal Aging Acceleration Factor Insulation Aging|Thermal Aging Acceleration Factor 

 

Insulation Aging|Moisture Aging Acceleration Factor Insulation Aging|Moisture Aging Acceleration 
Factor 

 

Insulation Aging|Global Aging Acceleration Factor Insulation Aging|Global Aging Acceleration Factor 

 

Insulation Aging|Cumulative Aging Insulation Aging|Cumulative Aging 

 

Insulation Aging|Service Time Insulation Aging|Service Time 

 

Tap Position|Permanent Tap Position Transition Count Tap Position|Permanent Tap Position Transition 
Count 

 

Tap Position|Permanent Transition Count for Position 
1 

Tap Position|Permanent Transition Count for 
Position 1 
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Tap Position|Permanent Transition Count for Position 
2 

Tap Position|Permanent Transition Count for 
Position 2 

 

Tap Position|Permanent Transition Count for Position 
3 

Tap Position|Permanent Transition Count for 
Position 3 

 

Tap Position|Permanent Transition Count for Position 
4 

Tap Position|Permanent Transition Count for 
Position 4 

 

Tap Position|Permanent Transition Count for Position 
5 

Tap Position|Permanent Transition Count for 
Position 5 

 

Tap Position|Permanent Transition Count for Position 
6 

Tap Position|Permanent Transition Count for 
Position 6 

 

Tap Position|Permanent Transition Count for Position 
7 

Tap Position|Permanent Transition Count for 
Position 7 

 

Tap Position|Permanent Transition Count for Position 
8 

Tap Position|Permanent Transition Count for 
Position 8 

 

Tap Position|Permanent Transition Count for Position 
9 

Tap Position|Permanent Transition Count for 
Position 9 

 

Tap Position|Permanent Transition Count for Position 
10 

Tap Position|Permanent Transition Count for 
Position 10 

 

Tap Position|Permanent Transition Count for Position 
11 

Tap Position|Permanent Transition Count for 
Position 11 

 

Tap Position|Permanent Transition Count for Position 
12 

Tap Position|Permanent Transition Count for 
Position 12 

 

Tap Position|Permanent Transition Count for Position 
13 

Tap Position|Permanent Transition Count for 
Position 13 

 

Tap Position|Permanent Transition Count for Position 
14 

Tap Position|Permanent Transition Count for 
Position 14 

 

Tap Position|Permanent Transition Count for Position 
15 

Tap Position|Permanent Transition Count for 
Position 15 

 

Tap Position|Permanent Transition Count for Position 
16 

Tap Position|Permanent Transition Count for 
Position 16 

 

Tap Position|Permanent Transition Count for Position 
17 

Tap Position|Permanent Transition Count for 
Position 17 

 

Tap Position|Permanent Transition Count for Position 
18 

Tap Position|Permanent Transition Count for 
Position 18 
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Tap Position|Permanent Transition Count for Position 
19 

Tap Position|Permanent Transition Count for 
Position 19 

 

Tap Position|Permanent Transition Count for Position 
20 

Tap Position|Permanent Transition Count for 
Position 20 

 

Tap Position|Permanent Transition Count for Position 
21 

Tap Position|Permanent Transition Count for 
Position 21 

 

Tap Position|Permanent Transition Count for Position 
22 

Tap Position|Permanent Transition Count for 
Position 22 

 

Tap Position|Permanent Transition Count for Position 
23 

Tap Position|Permanent Transition Count for 
Position 23 

 

Tap Position|Permanent Transition Count for Position 
24 

Tap Position|Permanent Transition Count for 
Position 24 

 

Tap Position|Permanent Transition Count for Position 
25 

Tap Position|Permanent Transition Count for 
Position 25 

 

Tap Position|Permanent Transition Count for Position 
26 

Tap Position|Permanent Transition Count for 
Position 26 

 

Tap Position|Permanent Transition Count for Position 
27 

Tap Position|Permanent Transition Count for 
Position 27 

 

Tap Position|Permanent Transition Count for Position 
28 

Tap Position|Permanent Transition Count for 
Position 28 

 

Tap Position|Permanent Transition Count for Position 
29 

Tap Position|Permanent Transition Count for 
Position 29 

 

Tap Position|Permanent Transition Count for Position 
30 

Tap Position|Permanent Transition Count for 
Position 30 

 

Tap Position|Permanent Transition Count for Position 
31 

Tap Position|Permanent Transition Count for 
Position 31 

 

Tap Position|Permanent Transition Count for Position 
32 

Tap Position|Permanent Transition Count for 
Position 32 

 

Tap Position|Permanent Transition Count for Position 
33 

Tap Position|Permanent Transition Count for 
Position 33 

 

Tap Position|Permanent Transition Count for Position 
34 

Tap Position|Permanent Transition Count for 
Position 34 

 

Tap Position|Permanent Transition Count for Position 
35 

Tap Position|Permanent Transition Count for 
Position 35 
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Tap Position|Operator Tap Position Transition Count Tap Position|Operator Tap Position Transition 
Count 

 

Tap Position|Resettable Count for Position 1 Tap Position|Resettable Count for Position 1 

 

Tap Position|Resettable Count for Position 2 Tap Position|Resettable Count for Position 2 

 

Tap Position|Resettable Count for Position 3 Tap Position|Resettable Count for Position 3 

 

Tap Position|Resettable Count for Position 4 Tap Position|Resettable Count for Position 4 

 

Tap Position|Resettable Count for Position 5 Tap Position|Resettable Count for Position 5 

 

Tap Position|Resettable Count for Position 6 Tap Position|Resettable Count for Position 6 

 

Tap Position|Resettable Count for Position 7 Tap Position|Resettable Count for Position 7 

 

Tap Position|Resettable Count for Position 8 Tap Position|Resettable Count for Position 8 

 

Tap Position|Resettable Count for Position 9 Tap Position|Resettable Count for Position 9 

 

Tap Position|Resettable Count for Position 10 Tap Position|Resettable Count for Position 10 

 

Tap Position|Resettable Count for Position 11 Tap Position|Resettable Count for Position 11 

 

Tap Position|Resettable Count for Position 12 Tap Position|Resettable Count for Position 12 

 

Tap Position|Resettable Count for Position 13 Tap Position|Resettable Count for Position 13 

 

Tap Position|Resettable Count for Position 14 Tap Position|Resettable Count for Position 14 

 

Tap Position|Resettable Count for Position 15 Tap Position|Resettable Count for Position 15 

 

Tap Position|Resettable Count for Position 16 Tap Position|Resettable Count for Position 16 

 

Tap Position|Resettable Count for Position 17 Tap Position|Resettable Count for Position 17 

 

Tap Position|Resettable Count for Position 18 Tap Position|Resettable Count for Position 18 

 

Tap Position|Resettable Count for Position 19 Tap Position|Resettable Count for Position 19 

 

Tap Position|Resettable Count for Position 20 Tap Position|Resettable Count for Position 20 

 

Tap Position|Resettable Count for Position 21 Tap Position|Resettable Count for Position 21 

 

Tap Position|Resettable Count for Position 22 Tap Position|Resettable Count for Position 22 

 

Tap Position|Resettable Count for Position 23 Tap Position|Resettable Count for Position 23 
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Tap Position|Resettable Count for Position 24 Tap Position|Resettable Count for Position 24 

 

Tap Position|Resettable Count for Position 25 Tap Position|Resettable Count for Position 25 

 

Tap Position|Resettable Count for Position 26 Tap Position|Resettable Count for Position 26 

 

Tap Position|Resettable Count for Position 27 Tap Position|Resettable Count for Position 27 

 

Tap Position|Resettable Count for Position 28 Tap Position|Resettable Count for Position 28 

 

Tap Position|Resettable Count for Position 29 Tap Position|Resettable Count for Position 29 

 

Tap Position|Resettable Count for Position 30 Tap Position|Resettable Count for Position 30 

 

Tap Position|Resettable Count for Position 31 Tap Position|Resettable Count for Position 31 

 

Tap Position|Resettable Count for Position 32 Tap Position|Resettable Count for Position 32 

 

Tap Position|Resettable Count for Position 33 Tap Position|Resettable Count for Position 33 

 

Tap Position|Resettable Count for Position 34 Tap Position|Resettable Count for Position 34 

 

Tap Position|Resettable Count for Position 35 Tap Position|Resettable Count for Position 35 

 

Tap Position|Actual Tap Position Tap Position|Actual Tap Position 

 

DLG|Rated Voltage on LV side DLG|Rated Voltage on LV side 

 

DLG|Rated Voltage on HV side DLG|Rated Voltage on HV side 

 

DLG|Rated Power at Cooling Stage 0 DLG|Rated Power at Cooling Stage 0 

 

DLG|Rated Power at Cooling Stage 1 DLG|Rated Power at Cooling Stage 1 

 

DLG|Rated Power at Cooling Stage 2 DLG|Rated Power at Cooling Stage 2 

 

DLG|User estimated Water content in Winding 
insulation Paper 

DLG|User estimated Water content in Winding 
insulation Paper 

 

DLG|Number of Cooling Banks DLG|Number of Cooling Banks 

 

DLG|OverLoad Duration #1 DLG|OverLoad Duration #1 

 

DLG|Load Limiting Factor #1 DLG|Load Limiting Factor #1 

 

DLG|OverLoad Duration #2 DLG|OverLoad Duration #2 

 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 156 of 199 

DLG|Load Limiting Factor #2 DLG|Load Limiting Factor #2 

 

DLG|OverLoad Duration #3 DLG|OverLoad Duration #3 

 

DLG|Load Limiting Factor #3 DLG|Load Limiting Factor #3 

 

DLG|OverLoad Duration #4 DLG|OverLoad Duration #4 

 

DLG|Load Limiting Factor #4 DLG|Load Limiting Factor #4 

 

DLG|OverLoad Duration #5 DLG|OverLoad Duration #5 

 

DLG|Load Limiting Factor #5 DLG|Load Limiting Factor #5 

 

DLG|OverLoad Duration #6 DLG|OverLoad Duration #6 

 

DLG|Load Limiting Factor #6 DLG|Load Limiting Factor #6 

 

DLG|OverLoad Duration #7 DLG|OverLoad Duration #7 

 

DLG|Load Limiting Factor #7 DLG|Load Limiting Factor #7 

 

DLG|OverLoad Duration #8 DLG|OverLoad Duration #8 

 

DLG|Load Limiting Factor #8 DLG|Load Limiting Factor #8 

 

DLG|OverLoad Duration #9 DLG|OverLoad Duration #9 

 

DLG|Load Limiting Factor #9 DLG|Load Limiting Factor #9 

 

DLG|OverLoad Duration #10 DLG|OverLoad Duration #10 

 

DLG|Load Limiting Factor #10 DLG|Load Limiting Factor #10 

 

DLG|Max. Top Oil Temp. DLG|Max. Top Oil Temp. 

 

DLG|Max. Hot Spot Temp. DLG|Max. Hot Spot Temp. 

 

DLG|Min. Bubbling Margin Temp. DLG|Min. Bubbling Margin Temp. 

 

DLG|Max. Load Factor on HV Bushing DLG|Max. Load Factor on HV Bushing 

 

DLG|Max. Load Factor on LV Bushing DLG|Max. Load Factor on LV Bushing 

 

DLG|Max. Load Factor on Tap Changer DLG|Max. Load Factor on Tap Changer 

 

Communications|ConnectionString 

Communications|CronString 

Communications|ConnectionString 

Communications|CronString 
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Communications|IsScheduleEnabled 

Communications|NextScheduledDownload 

Communications|ServiceAlarmDescription 

Communications|NotificationEmail 

Communications|ExpertEmail 

Communications|IsAutoExportEnabled 

Communications|ExportCronString 

Communications|DownloadError 

Communications|ServiceAlarmDescription 

Communications|IsScheduleEnabled 

Communications|NextScheduledDownload 

Communications|ServiceAlarmDescription 

Communications|NotificationEmail 

Communications|ExpertEmail 

Communications|IsAutoExportEnabled 

Communications|ExportCronString 

Communications|DownloadError 

Communications|ServiceAlarmDescription 

These are all property fields. No mapping is required. 

Environmental|Ambient Humidity Environmental|Ambient Humidity 

 

Environmental|Ambient Temperature Environmental|Ambient Temperature 

 

Environmental|Bottom Oil Temperature Environmental|Bottom Oil Temperature 

 

Environmental|Top Oil Temperature Environmental|Top Oil Temperature 

 

PrimaryBushing|C1% A PrimaryBushing|C1% A 

 

PrimaryBushing|C1% B PrimaryBushing|C1% B 

 

PrimaryBushing|C1% C PrimaryBushing|C1% C 

 

PrimaryBushing|C1% Polar Plot Level PrimaryBushing|C1% Polar Plot Level 

 

PrimaryBushing|C1% Polar Plot Angle PrimaryBushing|C1% Polar Plot Angle 

 

PrimaryBushing|PF% A PrimaryBushing|PF% A 

 

PrimaryBushing|PF% B PrimaryBushing|PF% B 

 

PrimaryBushing|PF% C PrimaryBushing|PF% C 

 

PrimaryBushing|PF% Polar Plot Level PrimaryBushing|PF% Polar Plot Level 

 

PrimaryBushing|PF% Polar Plot Angle PrimaryBushing|PF% Polar Plot Angle 

 

PrimaryBushing|AngleACReferenceDiff PrimaryBushing|AngleACReferenceDiff 

 

PrimaryBushing|AngleABReferenceDiff PrimaryBushing|AngleABReferenceDiff 

 

PrimaryBushing|Current A PrimaryBushing|Current A 

 

PrimaryBushing|Current B PrimaryBushing|Current B 

 

PrimaryBushing|Current C PrimaryBushing|Current C 

 

PrimaryBushing|System Frequency PrimaryBushing|System Frequency 
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SecondaryBushing|C1% A SecondaryBushing|C1% A 

 

SecondaryBushing|C1% B SecondaryBushing|C1% B 

 

SecondaryBushing|C1% C SecondaryBushing|C1% C 

 

SecondaryBushing|C1% Polar Plot Level SecondaryBushing|C1% Polar Plot Level 

 

SecondaryBushing|PF% A SecondaryBushing|PF% A 

 

SecondaryBushing|PF% B SecondaryBushing|PF% B 

 

SecondaryBushing|PF% C SecondaryBushing|PF% C 

 

SecondaryBushing|PF% Polar Plot Level SecondaryBushing|PF% Polar Plot Level 

 

SecondaryBushing|PF% Polar Plot Angle SecondaryBushing|PF% Polar Plot Angle 

 

SecondaryBushing|AngleABReferenceDiff SecondaryBushing|AngleABReferenceDiff 

 

SecondaryBushing|AngleACReferenceDiff SecondaryBushing|AngleACReferenceDiff 

 

SecondaryBushing|Current A SecondaryBushing|Current A 

 

SecondaryBushing|Current B SecondaryBushing|Current B 

 

SecondaryBushing|Current C SecondaryBushing|Current C 

 

PD|PD Count Polar Plot Angle PD|PD Count Polar Plot Angle 

 

PD|PD Count Polar Plot Level PD|PD Count Polar Plot Level 

 

PD|PD Average Polar Plot Angle PD|PD Average Polar Plot Angle 

 

PD|PD Average Polar Plot Level PD|PD Average Polar Plot Level 

 

PD|PDI Polar Plot Angle PD|PDI Polar Plot Angle 

 

PD|PDI Polar Plot Level PD|PDI Polar Plot Level 

 

PD|PhaseA|Correlation PDi-RH PD|PhaseA|Correlation PDi-RH 

 

PD|PhaseA|PD Count PD|PhaseA|PD Count 

 

PD|PhaseA|PD Average Apparent Charge PD|PhaseA|PD Average Apparent Charge 

 

PD|PhaseA|PDI PD|PhaseA|PDI 
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PD|PhaseB|Correlation PDi-RH PD|PhaseB|Correlation PDi-RH 

 

PD|PhaseB|PD Count PD|PhaseB|PD Count 

 

PD|PhaseB|PD Average Apparent Charge PD|PhaseB|PD Average Apparent Charge 

 

PD|PhaseB|PDI PD|PhaseB|PDI 

 

PD|PhaseC|Correlation PDi-RH PD|PhaseC|Correlation PDi-RH 

 

PD|PhaseC|PD Count PD|PhaseC|PD Count 

 

PD|PhaseC|PD Average Apparent Charge PD|PhaseC|PD Average Apparent Charge 

 

PD|PhaseC|PDI PD|PhaseC|PDI 

 

Parent Parent 

This is used to maintain the parent-child hierarchy so that the asset can be created at the appropriate level. 
No mapping is required. 

 

An example hierarchy is as follows: 

 

Area 

Substation 

Transformer1 

Transfix 1.6 

HydranM2 

Transformer2 

TapTrans 

BMT300 

 

Perception data exported to CSV format adheres to the following rules: 

 

• The Parent header column against Transfix 1.6 and HydranM2 data rows will have the value 
‘Transformer1’. 

• The Parent header column against TapTrans and BMT 300 data rows will have the value 
‘Transformer2’. 

• The Transformer1 and Transformer2 data rows will have the value ‘Substation’ against their Parent 
header column. 

• The Substation data row will have the value ‘Area’ against its Parent header column. 

 

Data imported from a CSV file follows a three-step process for each asset to ensure that the same asset 
structure is maintained in the Asset Explorer. This is best explained as follows: 

 

1. Perception first checks the Parent value of the asset. If the Parent node doesn’t already exist in the 
database, Perception creates the Parent node and any associated child nodes in the hierarchy. If the 
Parent value in the CSV file is empty, then any child nodes are created at the top level of the 
hierarchy i.e. directly under the database node. 

2. If the Parent node already exists in the database, then it checks the ‘equipnum’ and ‘serialnum’ 
fields. If both the values match, then any child assets will be created under that parent. If any one of 
them doesn’t match, then a new Parent node will be created with the corresponding child assets. 
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3. The same logic of step 2 also applies to any child assets. If any asset already exists i.e. there is a 
match of the values ‘parent’, ‘equipnum’ and ‘serialnum’, then the data will be replaced for that asset 
on import. Otherwise if any one of them doesn’t match, a new asset will be created. 

Alarm Mappings 

During import and export, alarms are treated as attributes of measurement points. Measurement points 
have various attributes. The alarm-specific attributes are as follows: 

 

[OilSource] | [MeasurementType] | HighLimit (numeric) 

[OilSource] | [MeasurementType] | HighEnabled (boolean) 

[OilSource] | [MeasurementType] | HighHighLimit (numeric) 

[OilSource] | [MeasurementType] | HighHighEnabled (boolean) 

[OilSource] | [MeasurementType] | LowLimit (numeric) 

[OilSource] | [MeasurementType] | LowEnabled (boolean) 

[OilSource] | [MeasurementType] | LowLowLimit (numeric) 

[OilSource] | [MeasurementType] | LowLowEnabled (boolean) 

 

[OilSource] | [MeasurementType] | Formula (text) 

[OilSource] | [MeasurementType] | FormulaName (text) 

[OilSource] | [MeasurementType] | UpperAlarmValue (numeric) 

OilSource] | [MeasurementType] | LowerAlarmValue (numeric) 

OilSource] | [MeasurementType] | UpperRatioAlarmEnabled (Boolean) 

OilSource] | [MeasurementType] | LowerRatioAlarmEnabled (Boolean) 

 

The attributes required vary according to the measurement point. For example, the alarm for the O2 
measurement point is defined as follows: 

OilSourceA | 02 
(the measurement point) 

OilSourceA | 02 | EngineeringUnits 
(ppm for gases) 

OilSourceA | 02 | HighLimit 

(numeric value) 

OilSourceA | O2 | HighEnabled 
(boolean flag to mark the High limit enabled or disabled by setting as TRUE or FALSE) 

GasRatioFormulaContainer | OilSourceA | FormulaInfo1 | Formula  
(numeric formula) 

GasRatioFormulaContainer | OilSourceA | FormulaInfo1 | FormulaName 
(text value) 

GasRatioFormulaContainer | OilSourceA | FormulaInfo1 | UpperAlarmValue 

(numeric value) 

GasRatioFormulaContainer | OilSourceA | FormulaInfo1 | UpperRatioAlarmEnabled 
(boolean flag to mark the Upper limit enabled or disabled by setting as TRUE or FALSE) 

 

OilSourceA|O2 OilSourceA|O2|EngineeringUnits OilSourceA|O2|HighLimit OilSourceA|O2|HighEnabled 

15838 ppm 100 TRUE 

 

GasRatioFormulaContainer|OilSourceA|FormulaInfo1|Formula 

(H2+C2H4+C2H6+CH4)/(C2H4) 

 

GasRatioFormulaContainer|OilSourceA|FormulaInfo1|FormulaName 

Ratio 1 

 

GasRatioFormulaContainer|OilSourceA|FormulaInfo1|UpperAlarmValue 

15 
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GasRatioFormulaContainer|OilSourceA|FormulaInfo1|UpperRatioAlarmEnabled 

TRUE 
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Appendix C Troubleshooting 

Table C-1 lists several problems and resolutions. 

Table C-1: Problems & Resolutions 

Problem Resolution 

Anti-Virus software or firewall blocks 
Perception-related executables. 

Perception-related executables may need to be added to 
the host PC or corporate anti-virus and firewall software. 
The following executables are launched from Perception: 

 

C:\Program Files (x86)\KelmanDownload\ 
KelmanDownload.exe 

 

C:\Program Files (x86)\GE Digital Energy\Perception 1.20 \ 

 

TransconnectBootLoader.Exe 

CefSharp.BrowserSubprocess.exe 

MPDump.exe 

Perception.Database.Upgrade.Tool.exe 

Perception.Desktop.exe 

Perception.Devices.Provider.Host.exe 

Perception.Server.Configuration.Tool.exe 

Perception.Server.exe 

Transconnect.exe 

Perception.Workflow.Designer.exe 

C:\Program Files (x86)\GE Energy\BMT 330\BMT_330.exe 

 

Failure to Connect to the Server Server certificate not trusted. See Section 2.4.1.1 

Perception Service does not appear in 
Desktop Discovery wizard. 

This can be caused by several incorrect configurations. 

 

• Ensure IP Address or Hostname of Perception 
Server is correct. 

• If Perception Server is installed on a PC with 
another OPC service, ensure that the UA Discovery 
Server service is running. Verify in services.msc. 

• Ensure the Perception Server Service is running, 
check in services.msc. 

• Ensure the SQL Service is running, check in 
services.msc. 

• Ensure the Kelman database is configured in the 
Perception Server Config Tool. 

• Ensure the Microsoft Distributed Transaction 
Coordinator service (MS-DTC) has started on the 
PC running the Perception Server. If it was not 
running you may need to restart the Perception 
Server and UA Local Discovery Server services after 
starting. 

• Ensure MS-DTC is configured correctly: Windows 
Server 2008. See 
http://support.microsoft.com/kb/817064  

• Ensure the Perception Server and Discovery Server 
certificates exist in the trusted certificate folder 
and that they are configured correctly within the 
services configuration files. To correct 
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configuration, run the Perception Server installer 
and select the repair option. 

Security parameters not appearing at 
the end of the Perception Server 
discovery connection wizard. 

Ensure the ports required by the Perception applications 
are not blocked by a firewall (ports 4840 & 62541). 

The Gas Ratios 3D graph does not 
appear on the Gas Ratios workbook. 

Ensure you have the latest drivers for your graphics card. 

When you launch Perception Desktop 
the application or activation window 
is blank. 

Ensure you have the latest drivers for your graphics card. 

Users are no longer able to log in even 
though usernames and passwords 
are correct. 

This can occur if a new server certificate has been created 
on the Perception Server host. To correct the issue you 
need to delete and re-add the users. 

HydranM2: Exception raised when 
configuring HM2 via Perception Setup 

Intermittent issue. The workaround is to instead use the 
Multihost software to configure the device. 

While importing CSV files into a local 
KPD file, the browsing performance 
of Asset Explorer is slow. 

This may be hardware performance related. Wait until the 
KPD import completes. This is not an issue using SQL 
Server. 

Perception Desktop Freezes when 
you open a KPD database or try to 
connect to Perception Server. 

Delete the Perception folder located in: 

%APPDATA%\GE_Energy 

Note: ‘%APPDATA%’ points to the ‘Roaming’ application 
data folder 

Connecting to Perception Server 
Error - 'The requested key container 
was not found'. 

Intermittent issue. Close the 'The requested key container 
was not found' error by clicking OK. Close the Perception 
Desktop application and reopen it. 

Attempt connection to Perception Server again. 

Perception installer failure – ‘An 
internal error occurred’. 

Perception installers will fail if the following Microsoft 
Windows update is installed on the machine KB2918614. 
This is a known Microsoft Windows update issue; the 
update must be removed in order to install Perception 
successfully. 

Trouble importing CSV data in Non-
English windows environment. 

If the decimal and list separator symbols used in the CSV 
file to be imported into Perception Desktop do not match 
the environment variables set in Microsoft Windows, the 
import of the data into Perception will fail. Either the CSV 
file must be updated with the correct symbols or the 
environment variables should be changed to match the CSV 
file. 

Perception Desktop certificates error 
– ‘Perception Desktop certificate 
missing, reinstall/repair setup to 
connect’ reinstall/repair does not 
correct error. 

Intermittent issue. Perception Desktop installer fails to 
create certificates or certificate assignments can be missing 
after a Perception Desktop upgrade is performed. 

To resolve this issue (Windows 7): 

1. Browse to C:\ProgramData\ 

2. Delete the 'OPC Foundation' folder 

3. Browse to C:\Program Files (x86)\Common Files 
(on x64 OS) 

4. Delete the 'OPC Foundation' folder 

5. Browse to C:\Program Files\Common Files (on x86 
OS) 

6. Delete the 'OPC Foundation' folder 

7. Uninstall Perception Desktop 

8. Re-install Perception Desktop 

Unexpected or empty wallboards Clear wallboards cache – folder located in: C:\Documents 
and Settings\<User>\Local Settings\Temp\Wallboard, 
where <User> stands for a user logged in to the Windows 
system 
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When attempting to download from 
an MS 3000 device, the following 
message appears in the Response 
field: ”The remote certificate is 
invalid according to the validation 
procedure”. 

The MS 3000 is configured for HTTPS communication, but 
downloading data from the device requires a valid 
certificate to be added. See Appendix G: MS 3000: HTTPS & 
Self-signed Certificates. 
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Appendix D PGA Diagnostic Error codes and Status Flags 

The Data Table tooltip, an example of which is shown below, includes a Diagnostic row 

that lists PGA diagnostic information. E.g. PGA;0,0,6. The syntax for the PGA entry is: 

PGA;[errorState],[errorCodes],[flagNumber] 

 
Figure D-1: PGA diagnostic information 

Note: Perception displays the flag number in decimal, but this must be converted to 
binary in order to draw comparison with the bitmap outlined in Table D-3. E.g. a 
decimal status flag of 6 in the above example equates to binary 
0000000000000110. Using Table D-3, this would indicate that the PPM values 
are valid and that it is the first measurement after a reset. 

Table D-1 lists all Transfix-family PGA Diagnostic Error Codes. 
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Table D-1: Transfix-family PGA Error codes 

Error Codes 
(32-bit field) 

Description 

bit 0 1 = Missing mains input (obsoleted) 

bit 1 1 = PGA power supply voltage too low 

bit 2 1 = PGA chopper frequency outside range 

bit 3 1 = PGA IR-source outside range 

bit 4 1 = Gas flow lower than limit 

bit 5 1 = Background noise/vibration too high 

bit 6 1 = Microphone test failed 

bit 7 1 = Not Levelsensor1 pulses (level) 

bit 8 1 = Not Levelsensor3 (drain) 

bit 9 1 = Fill level shows oil 

bit 10 1 = Over Fill level shows Oil 

bit 11 1 = PGA Air temperature outside limits 

bit 12 1 = Bad communication with control PCB 

bit 13 1 = Gas leak test: Pump pressure too low 

bit 14 1 = Gas leak test: Pressure decay too high 

bit 15 1 = Unusual ambient gas measurements 

bit 16 1 = Oil temperature too low 

bit 17 1 = Oil temperature too high 

bit 18 1 = Oil pressure too low 

bit 19 1 = Oil pressure too high 

bit 20 1 = Oil pump tacho count too high 

bit 21 1 = Oil pump pressure too low 

bit 22 1 = Oil pump speed out of range 

bit 23 1 = Manual oil sampling switch 

bit 24 1 = Oil pump tacho count too low 

bit 25 1 = Oil pump not turning 

bit 26 {not used/defined} 

bit 27 1 = Temperature Sensor(s) 1 disconnected 

bit 28 1 = Temperature Sensor(s) 2 disconnected 

bit 29 1 = Drain level shows oil 

bit 30 1 = Conditioned oil temp. outside limits 

bit 31 {not used/defined} 

Table D-2 lists all Minitrans PGA Diagnostic Error Codes. 

Table D-2: Minitrans PGA Error codes 

Error Codes 
(32-bit field) 

Description 

bit 0 1 = Missing mains input (obsoleted) 

bit 1 1 = PGA power supply voltage too low 

bit 2 1 = PGA chopper frequency outside range 

bit 3 1 = PGA IR-source outside range 

bit 4 1 = Gas flow lower than limit 

bit 5 1 = Background noise/vibration too high 

bit 6 1 = Microphone test failed 

bit 7 1 = Not Levelsensor1 pulses (level) 

bit 8 1 = Not Levelsensor3 (drain) 

bit 9 1 = Levelsensor1 (level) 
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bit 10 1 = Levelsensor2 (level alert) 

bit 11 1 = PGA Air temperature outside limits 

bit 12 1 = Bad communication with control PCB 

bit 13 1 = Gas leak test: Pump pressure too low 

bit 14 1 = Gas leak test: Pressure decay too high 

bit 15 1 = Unusual ambient gas measurements 

bit 16 1 = Oil temperature too low 

bit 17 1 = Oil temperature too high 

bit 18 1 = Oil pressure too low 

bit 19 1 = Oil pressure too high 

bit 20 1 = Oil pump tacho count too high 

bit 21 1 = Oil pump pressure too low 

bit 22 1 = Oil pump speed out of range 

bit 23 1 = Manual oil sampling switch 

bit 24 1 = Oil pump tacho count too low 

bit 25 {not used/defined} 

bit 26 1 = 5 V supply below 4.5 V 

bit 27 1 = Temperature Sensor(s) 1 disconnected 

bit 28 1 = Temperature Sensor(s) 2 disconnected 

bit 29 1 = Drain level shows oil 

bit 30 {not used/defined} 

bit 31 {not used/defined} 

Table D-3 lists all PGA Status Flags. 

Table D-3: PGA Status flags 

Status Flag 

(bit field) 

Description 

bit 0 1 = ESHL Valid 

bit 1 1 = PPM values valid 

bit 2 1 = First measurement after reset 

bit 3 1 = Sampling Skipped 

bit 4 1 = Error checking disabled 

bit 5 1 = Nitrogen Valid 

bit 6 1 = TDG Valid 

bit 7 1 = Oil Switch failed 

bit 8 1 = Spurious alarm suspected 

bit 9 1 = Manual Sample 

bit 10 1 = Measurement Manually Stopped 

bit 11 1 = Weak NHC Indication 

bit 12 1 = Strong NHC Indication 

bit 13 1 = Measured with PreSens sensor 

bit 14 1 = External Alarm ON 

bit 15 1 = TDH Valid 
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Appendix E Model Descriptions 

E.1 Japanese ETRA Models 

Reference source: “Latest Diagnostic Methods of Gas-in-oil Analysis for Oil-filled 

Transformer in Japan; Proceedings of 13th International Conference on Dielectric Liquids 

(ICDL ’99), Nara Japan 20-25th July 1999.” 

An extract of the summary and introduction are reproduced below: 

DGA is one of the most widely used diagnostic techniques for detecting and evaluating 

types of faults in a transformer. The first edition of "Supervision and Maintenance by 

DGA” standardized by the ETRA in 1980, has been widely used for oil filled transformers 

in Japan. The standard, however, lacked diagnoses for some cases and had no detection 

limits nor precision requirements for DGA. Therefore, the ETRA started to investigate the 

actual status of conventional diagnosis by DGA in Japan and overseas. Also, DGA data 

have been investigated on about 1300 operating transformers which are now in service 

including some which have experienced inner faults. As a result, a new "Supervision and 

Maintenance by DGA" which is the second edition was released in February 1999. This 

paper summarizes that standard. 

Regarding gas analysis methods in oil which are used presently in Japan, torricelli, 

toepler pump, vacuum piston and stripping methods are used for the extraction of 

dissolved gases in oil and gas chromatography is used for analysis of the extracted gases. 

Review of the analysis sensitivity of each gas in 12 laboratories showed the detection 

and determination limits had some scattering among the laboratories. By considering 

the detection limits that were standardized in IEC 567 (1992) and the determination 

limits which are necessary to improve the precision of present diagnoses by DGA, the 

detection limit was defined as 3 times the noise level and the determination limit was 

defined as 5 times the detection limits. The repeatability and reproducibility were 

evaluated by the Round Robin Test with the three gas-in-oil-standard samples and the 

sample oils taken from transformers in service. By using the evaluation formula of 

repeatability which was prescribed by IEC 567 (1992) and the detection limit, it was 

found that the repeatability for each gas at each laboratory satisfied the evaluation 

formula at a 93.9% probability. It was found that the repeatability and reproducibility of 

the stripping method were better than those of the other extraction methods. 

The paper then defines some new gas correlations that have prognostic utility. 

E.2 Multi-Host Models 

Reference source: GE Multi-Host Manual, part# 18415 

E.2.1 Dynamic Loading Model 

The purpose of this model is to provide the transformer owner and operator with a 

continuous estimation of the capacity of the transformer (and its associated 

components) to continue safe operation under overloading conditions. Starting with 

current conditions of oil temperature and ambient temperature and using a steady load 

of a given magnitude, the model computes how long this load can be carried until a limit 
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condition is reached. The implementation of this model in the Hydran M2 with Models 

and Intellix MO150 Devices is also known as ‘Time vs Steady Load.’ 

The model’s Device Provider setup offers two choices for the Ambient Air Temperature 

and Top Oil Temperature — either to use manual input values or sensor-measured 

values. Manual input values are useful for simulation purposes and are used only in the 

calculations of the model. The device will still always gather sensor-measured values and 

render these in all other areas of the software where these values are used e.g. data 

view charts and dashboards. This feature is available only for the MO150 device with 

firmware version 3.06 or higher. 

This model is intended for short-duration overloads, as when a parallel transformer is 

removed from service for maintenance for a few hours or less. Model computations are 

made with the assumption that the transformer is operating on the top-cooling mode. 

Computations of the top oil and winding temperatures are carried out according to 

Section 7.2 of IEEE C57.91-1995, Guide for Loading Mineral-Oil-Immersed Transformers. 

A similar calculation method is described in Section 8.2.2 of IEC 60076-7, Loading Guide 

for Oil-Immersed Power Transformers. 

Calculation starts with a load of 1.1 p.u. and actual values for Ambient Temperature and 

Top Oil Temperature (from sensors). The ambient temperature is assumed to remain 

constant for the period of overload being considered. The actual top oil temperature will 

be used as a starting point for oil temperature calculation at each load level. Calculations 

are done with this load level (1.1 p.u.) and with a time increment of 0.1 hour (6 minutes) 

until one of the Limiting Factors (or Overload Limit) is exceeded or when the acceptable 

duration exceeds 12 hours (720 minutes). The calculation is then repeated with a load of 

1.2 p.u. and the acceptable duration is determined (less or equal to 720 minutes) again 

along with the Limiting Factor that was first reached. This calculation is repeated until a 

load of 2.0 p.u. is reached. 

For each Load level, the time duration to reach the limit is recorded along with the 

Limiting Factor that was first reached. If the 12 hours (720 minutes) were reached but no 

Limiting Factor was exceeded, the Limiting Factor is shown as “Duration.” If the Hydran 

M2 with Models and Intellix MO150 Devices are working in the on-line mode of 

operation, then the computation is repeated every 10 minutes using the actual sensor 

values. If the Hydran M2 with Models and Intellix MO150 Devices are working in the off-

line mode of operation, then the output screen reflects the values computed during the 

last on-line operation. 

E.2.2 Insulation Ageing Model 

Winding insulation is made of oil-impregnated cellulose material. In order to properly 

fulfil its function, this material must have a certain mechanical strength and flexibility. 

These properties depend on the length of the cellulose chain constituent of the paper 

and pressboard. With time and temperature, these long polymer chains break down into 

shorter segments, a process called depolymerisation. The practical effect is that the 

paper loses its flexibility and tensile strength to become a brittle material. The winding is 

continuously submitted to clamping forces and vibrations. Moreover, during short-circuit 

on the system, these forces are increased tremendously and if the insulating paper is too 

brittle, it may rupture under the pressure and create a weak point in the insulation that 
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will later allow flashover between adjacent turns when a voltage surge occurs on the 

transformer. 

This insulation aging process is irreversible. It is also the main factor determining the 

transformer’s end of life. The rate of aging of cellulose insulation material is a function of 

the following factors: 

▪ Insulation temperature at the hot spot: The effect of temperature is the most 
important, as described in the IEEE and IEC Loading Guides. The effect of temperature 
on aging is a function of the type of paper. It is therefore important to state in the 
configuration page the type of paper used for winding insulation. 

▪ Water content in the winding insulation paper: It is assumed that the aging 
acceleration factor is directly proportional to the water content with 0.5 % as 
reference value for dry paper. The water content in winding insulation is computed in 
the Moisture Content in Insulating Barrier model. The effect is more severe on normal 
Kraft paper than on thermally-upgraded paper and it can be practically neglected on 
Aramid paper. 

▪ Oxygen content of the insulating oil: This oxygen content can be inferred from the 
type of oil preservation system. The IEEE Loading Guide recommends using an aging 
acceleration factor of 2.5 for free-breathing conservators while the sealed-type 
transformers and those with a membrane in the conservator are practically oxygen-
free. 

The following Model Output Text Parameters are displayed in the Insulation Ageing 

Model:  

▪ Thermal Aging Acceleration Factor: It considers only the hot-spot current 
temperature. 

▪ Moisture Aging Acceleration Factor: It considers only the effect of moisture in paper. 

▪ Global Aging Acceleration Factor: This is the actual aging rate or aging acceleration 
factor, considering the cumulated effect of temperature, moisture and oxygen in oil. 

▪ Cumulative Aging: This field indicates the aging cumulated since the commissioning of 
the system, adding the “Previous Aging” if this value was configured on the Insulation 
Aging Model configuration page. The value is expressed in days of operation at rated 
temperature; for instance, a transformer with thermally upgraded paper operating 24 
hours at 117 °C will undergo 2 days of “normal aging at rated temperature.” 

▪ Service Time: This field indicates the number of days the transformer has been in 
service since the commissioning of the system, adding the “Previous Service Time” if 
this value has been configured. 

E.2.3 Moisture and Bubbling Model 

The moisture content of the oil and the solid insulation is a serious concern for power 

transformers, especially for aging units. Extensive drying procedures are applied at the 

manufacturing stage and sustained efforts are deployed in service to maintain a high 

level of dryness. However, with time, water can penetrate through various paths such as 

the air breather and leaky gaskets. Aging of cellulose also releases some water. Moisture 

tends to accumulate in the solid insulation and leads to several detrimental 

consequences, namely: 

▪ Acceleration of insulation aging. 

▪ Risk of water vapour bubbles being released from the winding insulation. 
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▪ Reductions of dielectric strength of insulating barriers. 

▪ Risk of water condensation in transformer oil at low temperatures. 

Moisture content assessment is too often derived from a single oil sample submitted to 

a Karl Fischer test in laboratory. This is a valid approach for oil evaluation but it does not 

allow evaluation of the moisture content in the solid insulation as the rate of water 

exchange between the oil and the paper has to be considered. On-line monitoring of 

moisture in oil allows the integration of temperature variations and the computation of a 

dependable value for moisture content in the various components of the solid insulation 

system, even if they are at different temperatures and characterized by different 

diffusion rates. 

The most critical part of the winding insulation is the top of the winding that operates at 

the hot-spot temperature. This is the area where the aging is most severe, and the effect 

of the water content can be computed. The determination of the critical temperature for 

bubble evolution takes into account the atmospheric pressure, the oil pressure above 

the hot-spot area, and the amount of gas dissolved in the oil. 

The moisture sensor continuously monitors the oil’s temperature and relative moisture 

saturation at the sensor location. A filtering is applied to remove the effect of cyclic 

heating created by the sensor to ensure oil circulation. This filtered value is used to 

calculate the absolute value of the water content in the oil, the temperature of water 

condensation, and the relative saturation at the reference temperature. 

Since the oil and winding temperature varies continuously, this moving target is used 

with an integrating algorithm taking into account the diffusion time constant and the 

temperature. The calculated value of the water content in the winding insulation allows 

prediction of the bubbling temperature. It is also used in the Insulation Aging model 

(described above). 

E.2.4 Apparent Power Model (MVA) 

The primary function of this model is to continuously monitor the load carried by the 

transformer in MVA (Mega Volt-Amperes). The Apparent Power can be computed on the 

primary, secondary, and tertiary windings, depending on the input configuration. The 

historic maximum MVA value is retained with a time stamp and can be reset. 

The current signal is a mandatory input, whereas the voltage signal is configured as a 

fixed value. Since voltage variations occurring in service and tap changer operations are 

not taken into consideration, the MVA is an approximate reading, and used only for 

display purposes. 

The model’s Device Provider setup offers two choices for the Apparent Power model 

computations — either to use manual input values or sensor-measured values. The 

former requires the user to assign three new types to the output models of an Analog 

input: 

▪ Rated Voltage on HV side 

▪ Rated Voltage on LV side 

▪ Rated Voltage on tertiary side 

When a new measurement sensor for voltage output is assigned to an Analog input, the 

Apparent power model is calculated based on this measured voltage instead of the one 
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manually configured on the device, and displayed in the appropriate worksheets in 

Perception. 

Manual input values are useful for simulation purposes and are used only in the 

calculations of the model. The device will still always gather sensor-measured values and 

render these in all other areas of the software where these values are used e.g. data 

view charts and dashboards. This feature is available only for the MO150 device with 

firmware version 3.06. 

E.2.5 Winding Hot-Spot Temperature Model (WHST) 

The rating of a transformer is closely linked to the winding temperature as it governs the 

insulation aging rate and bubbling release threshold (both estimated by other models 

described above). This winding temperature can also raise an alarm if excessively high 

values occur. In the industry standards, the winding temperature limit is defined as a 

temperature rise above the ambient air temperature. The cooling system is designed to 

ensure that at full load, the average winding temperature rise does not exceed the 

industry-accepted value (usually 65 °C). 

However, it is not the average winding temperature that is of most interest but rather 

the temperature in the hottest area (the ‘hot-spot temperature’). This temperature 

cannot be measured directly as it is not possible to insert thermocouples in a winding 

that is to be put in service. It is possible to use fibre optic temperature sensors that do 

not interfere with dielectric strength, but this procedure is costly and is usually limited to 

the validation of the manufacturer calculation methods. Therefore the traditional 

method was to use a Winding Temperature Indicator to fulfil that function. 

A more accurate and reliable evaluation of the hot-spot temperature can be provided, 

using the equations provided in the IEEE and IEC Loading Guides: 

▪ IEEE C57.91 - 1995, IEEE Guide for Loading Mineral-Oil-Immersed Transformers 

▪ IEC 60076-7 - 2005, Power Transformers - Part 7: Loading Guide for Oil-Immersed 
Power Transformers 

In the computation methods described in these Loading Guides, a key value is the 

temperature difference between the winding hot-spot and the top oil at rated 

conditions. This value is normally provided by the transformer manufacturer after 

suitable validation of their computation method. In the Winding Hot-Spot Temperature 

model, this rated value is corrected to account for actual load current and winding 

thermal time constant. The computed hot-spot temperature rise is then added to the 

measured top oil temperature to provide the actual winding hottest-spot temperature. 

The winding hot-spot temperature is computed separately for each winding. The highest 

value of winding hot-spot temperature is identified and used to raise an alarm signal on 

the transformer. The hottest winding might not always be the same, depending on the 

load on the tertiary winding and on the position of the tap changer. 

For autotransformers, the winding hot-spot temperature is calculated for the series 

winding (H), the common winding (C) and the tertiary winding (Y). The current in the 

common winding is calculated by subtracting the secondary load current minus the 

primary load current. 
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E.2.6 Cooling Status 

This model allows identification of the cooling stage currently in service. The cooling 

bank refers to the cooling device. A transformer can have several sets of fans and each 

one will be supplied by a feeder where the current can be measured. Information 

concerning the status of each cooling device (oil pumps, water pumps, fans) can be 

provided from several sources. The most common is a set of digital inputs giving the 

status (ON / OFF) of the relay supplying the cooling device. This information is adequate 

to allow determination of the cooling stage and the cumulative operating time for each 

device. A measurement of the current consumption by each cooling device can also be 

provided by AC RMS sensors or DC analog sensors. If this is the case, additional 

information can be developed such as detection of inoperative fans or bearing gripping. 

The digital indication of cooling bank status is to be used as the prime source of 

information. For determination of cooling bank status, cooling bank feeder current is to 

be used only if no digital information is available. The digital indication of cooling bank 

status is to be used as prime source of information. For determination of cooling bank 

status, cooling bank feeder current is to be used only if no digital information is available. 

E.2.7 Cooling Efficiency 

This model computes the top oil temperature that should be expected considering the 

load current, the ambient temperature, the cooling mode, the oil time constant and the 

altitude. 

The calculated value is then compared with the measured value and an alarm is raised if 

the transformer is found to be overheating. This calculation is used to detect 

obstructions, such as dirt on the coolers, which could be a limiting factor when the 

transformer is required to operate at full load or under overload conditions. 

During the initial model computation, the measured values of top oil temperature and 

ambient temperature are used to provide a starting point for the calculated value of top 

oil temperature rise. From then on, the calculated temperature at the end of the time 

interval is used as the initial temperature for the next time interval. This calculation is 

run with load current in the H winding only. The rated current for each cooling stage is 

calculated from the rated power on each stage and the rated current on the top cooling 

stage. The ultimate temperature rise and the current temperature rise are calculated 

considering the actual cooling stage and the actual oil time constant. This value is added 

to the ambient temperature to provide a calculated top oil temperature. This value is 

subtracted from the measured top oil temperature and the difference is averaged over a 

configurable period. An alarm is raised when the difference exceeds a configured value 

for a period of time that is also configurable. The model can accommodate a transformer 

with one, two or three cooling stages. 

E.2.8 OLTC Tap Position 

Tap changer driving mechanisms are always provided with a visual tap position indicator 

and a counter indicating the total number of operations. This model provides additional 

information that is useful to monitor the proper operation of this critical unit, such as: 

▪ The cumulative number of operations at each tap since commissioning 

▪ Resettable variables for operation and maintenance counts 
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▪ Warnings for excessive number of operations over a certain period 

▪ The time spent since the last operation of the reversing switch 

▪ A warning to avoid contact cooking because of insufficient operation 

A position transducer, driven by the visual indicator shaft (also called Geneva shaft), 

provides a 4–20 mA signal that is proportional to the tap changer mechanical position. 

The multi position switch can be equipped with jumpers (instead of resistors) in the 

“through positions” where the tap position indicator stays only momentarily during 

operation of the reversing switch. In this case, the potentiometer provides an indication 

of the electric position of the tap changer. When the tap changer operates, the signal 

should remain steady, until it changes to a new value without falling to zero. 

It is assumed that the Geneva shaft rotates by a fixed value for each step on the 

transducer. The signal from the Geneva shaft position transducer is read at regular 

intervals and is analyzed to determine the actual position of the visual position indicator. 

The position generated may refer to the mechanical position of the Geneva gear or the 

electrical position. In the first case, the mechanical position is converted into the 

electrical position considering the number of through positions specific to this tap 

changer when it moves to the neutral position. 

The number of operations on each tap position is presented by histograms using the tap 

position denomination configured. The system provides three separate registers to 

record the number of operations carried out by the tap changer: 

▪ The Permanent Tap Position Transition Count is intended to sum all operations since 
the commissioning of the system. However, if the monitoring system is moved to a 
different transformer, the System Administrator can reset this value to zero. This 
counter provides the number of operations on each tap position, the total number of 
operations, and the date when the system was put in service. The total number of 
operations performed prior to the commissioning of the system can also be taken 
into account. 

▪ The Operator Tap Position Transition Count can be reset by the Operator when there 
is a need to check the number of operations in one day, or several days, in order to 
demonstrate that the tap changer control unit is operating properly. This counter 
provides the number of operations on each tap position, the maximum and minimum 
positions visited by the tap changer since the last reset, and the date of the last reset. 

▪ The Maintenance Tap Position Transition Count is used by maintenance personnel to 
assess the need for maintenance and to plan maintenance schedules. It is typically 
reset every three or four years when an inspection activity is performed on the unit. 
This counter provides the number of operations on each tap position, the maximum 
and minimum positions visited by the tap changer since the last reset, and the date of 
the last reset. 

E.2.9 OLTC Differential Temperature 

The On-Load Tap Changer (OLTC) Temperature Differential model continuously 

compares the top oil temperature in the main tank with the tap changer compartment 

temperature. Monitoring of the tap changer temperature is a recognized method of 

detecting abnormal operating conditions in the tap changer. This monitoring method is 

intended for tap changers mounted on a separate compartment on the transformer 

tank. The tap changer temperature is normally lower than the main tank temperature 
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because no heat source is expected in the tap changer. If the tap changer temperature 

rises above the main tank temperature, it is indicative of an overheating contact. 

The temperature difference is calculated by subtracting the tap changer temperature 

minus the main tank temperature, thus yielding a negative value. This method allows to 

set the alarm on a positive threshold value rather than a negative value. This 

temperature difference is averaged with a low-pass filter to eliminate normal variations 

arising from sunshine and wind. 

A short-term averaged value is generated with a configurable filtering factor typically set 

at 60 minutes. This short-term average is intended to detect severe heat sources such as 

resistor overheating when the mechanical links break while the switches are between 

two contacts. 

A long-term averaged value is generated with a configurable filtering factor typically set 

at 7 days. This long-term average is intended to detect slow-evolving thermal problems 

such as contact overheating. The measured temperature difference is averaged over a 

round number of days to filter out the daily temperature variations. 

E.2.10 Temperature Model 

The Temperature Model is specific to the Hydran M2. It displays a trend for the 

temperature readings taken for the thermal sensors supported on the Hydran M2. 

The following values are displayed: 

▪ Tank #1 %RH Sensor Temperature °C (Relative Humidity) 

▪ Sensor #1 Heater Power in % 

▪ Top Oil Temperature °C 

▪ Tank #1 %RH Sensor Temperature °C Hourly Average (Relative Humidity) 

▪ Sensor #1 Hydran Sensor Temperature °C 

▪ Sensor #1 Base Plate Temperature °C 

E.2.11 Hydran Reading 

The Hydran Reading worksheet is specific to the Hydran M2. It displays the Hydran gas 

level readings taken from the device as well as the Hydran Sensor Temperature. 

The gas levels are displayed as actual level in PPM, Hourly Trend in PPM and Daily Trend 

in PPM. 

The Hydran Sensor Temperature is displayed in Degrees Celsius. 

E.2.12 Transformer Status Model 

The Transformer Status Model is specific to the Intellix MO150. It combines information 

from other models calculations into one worksheet. 

The following information is displayed: 

▪ Top Oil Temperature °C 

▪ Ambient Temperature °C 

▪ Tank #1 %RH Level (Relative Humidity) 

▪ Tank #1 Hydran Level 
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▪ Tank #1 H2O PPM Hourly Average 

▪ Highest Winding Hot Spot Temperature °C 

▪ Highest (P.U) (Per unit load on the most loaded winding) 

▪ % Moisture Content In Winding Paper 

▪ % Moisture Content in Insulating Barrier 

E.2.13 Cooling Control 

The transformer manufacturer usually provides a control system that offers several 

basic features that are not duplicated by this model and need to be maintained: 

▪ Individual thermal protection on each motor 

▪ Electrical protection as specified by local electrical code 

▪ Manual interruption of power to allow for maintenance activity (removal and 
replacement of a fan) 

▪ Temporization system to avoid the starting of two cooling banks simultaneously, 
especially if the Device monitoring system experiences a power failure 

However, taking advantage of a monitoring system to improve the performance of the 

cooling system extends the useful life of the transformer while reducing maintenance 

costs. Beyond the basic features provided by the transformer manufacturer control 

system, this model provides the following functions: 

▪ Beside input from top oil and winding temperature, it is now possible to link cooler 
initiation to the load current, thus providing an earlier start when a sudden overload 
occurs. 

▪ The transformer rating can be adjusted to the ambient temperature to have a more 
consistent cooler operation. For example, in winter, cooling stages 1 and 2 start at 
ahigher current. 

▪ The transformer rating can also be adjusted to the altitude. At higher altitude, the 
ratedcurrent is reduced to account for reduced air density, therefore the cooling 
system should be started at lower load current. 

▪ For transformers with two cooling banks, a duty-sharing function can be initiated. 
Many users prefer to alternate the usage of cooling banks to equalize the wear on 
bearings and extend the period between fan motor maintenance. 

▪ The cumulative operating time is computed for each cooling bank. 

▪ A temporization function is included to avoid the two cooling banks from starting at 
the same time. 

▪ The current drawn by the two cooling banks is monitored with two dedicated analog 
inputs. These values can be used to detect cooling bank status if no digital input is 
available for this purpose. 

▪ A cooler exercising routine can be used to run the units for a few minutes every week. 

▪ Continuous measurement of cooling bank current is also used to detect malfunction 
when the current is significantly below or significantly above the rated values. 

▪ A cooling discrepancy function will raise an alarm whenever the cooling status of one 
cooling bank is not reflecting the cooling control instruction that was issued. 
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The Cooling Control model is intended for transformers that have two or three ratings 

related to specific cooling modes. The lowest rating is defined as “cooling stage 0”, and it 

usually applies to the natural cooling of the transformer tank without any fan or pump. In 

other words, this mode is not controlled by the cooling control system. Some 

transformers (such as indoor generating units) have only one cooling mode, so that 

whenever the transformer is energized, the full cooling is automatically initiated. These 

units are treated as having only cooling stage 0, and several of the control features 

described below are not applicable. 
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Appendix F Offline DGA & Oil Quality Workflow 

Perception Fleet deploys the Offline DGA & Oil Quality workflow to evaluate transformer 

risk. The workflow evaluates DGA data including moisture and additional oil properties 

from laboratory analysis results to calculate the risk index for a transformer. 

F.1 Implement the offline risk workflow 

Follow these steps to implement the offline risk workflow in Perception Desktop. 

Note: Perception Server and Perception Workflow Designer must be installed. 

F.1.1 Prepare a CSV file with offline measurements data 

Use an editor to create or modify a CSV file with the necessary offline measurements 

data. The available parameters are listed in Table F-1. 

Specify the list of parameters, populate them with values and save the file. Note: A 

sample CSV file called “Offline_Oil_Analysis_Example.csv” is located on the installation 

CD in the “Example Files” folder. 

Table F-1: CSV fields 

Mandatory fields Comment 

equipnum TransformerID 

serialnum  

apprtype Always set to TRN 

tank Name of the compartment e.g. ‘MAIN’ in 
‘Offline_Oil_Analysis_Example.csv’ associated with the 
Offline Oil Quality measurements. 

sampledate Sample timestamp 

Oil property fields Comment 

visual Standardized oil appearance remarks 

color Fluid color index 

iec156 Dielectric breakdown - IEC 156 

fq_water Moisture concentration 

acidnum Acid number 

tan_delta Fluid dissipation factor 

resistivity Resistivity at 90 C (gigohm-meters) 

inhibitor Oxidation inhibitor concentration 

ift Interfacial tension (IFT) 

totalpcb Total PCB concentration 

d1275a, d1275b Corrosive sulfur test result 

passivator Passivator concentration 

d1816_1, d1816_2 Dielectric Breakdown Voltage VDE electrode-1mm and 
-2mm 

pf25 Fluid Power Factor at 25 C 

pf100 Fluid Power Factor at 100 C 

totalfuran Total furans 

resistivity_20 Resistivity at 20 C (gigohm-meters) 

sludge Sediment and sludge, % 

h2 Hydrogen concentration in PPM 
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ch4 Methane concentration in PPM 

c2h6 Ethane concentration in PPM 

c2h4 Ethylene concentration in PPM 

c2h2 Acetylene concentration in PPM 

co Carbon Monoxide concentration in PPM 

co2 Carbon Dioxide concentration in PPM 

Standard TOA4 field names are also supported. See Appendix F.2 for more details on 

supported parameters. 

F.1.2 Run the workflow 

Use Perception Desktop to run the workflow. 

 Start Perception Desktop. 

 Connect to the Perception Server. 

 Select Actions > Import > Import File and choose the CSV file created previously. 

A transformer instance appears in the asset tree using the CSV field value from 

"equipnum". 

 Select the transformer instance and then select the Properties tab. 

 In the Main Transformer Details section, complete the following as shown in Figure 

F-1 (see Appendix F.2 for configuration details): 

➢ Rated Voltage Max (kv) 

➢ Inhibited (check or uncheck) 

 
Figure F-1: Main Transformer Details 

 In the Workflow Associations section, complete the following as shown in Figure F-2 

(see Appendix F.2 for configuration details): 

➢ In the Offline Algorithm Standard, select either IEC or IEEE. 

➢ In the ‘Workflows’ dropdown, select Offline DGA and Oil Quality. 

 
Figure F-2: Workflow Associations 

 Select Tools > Workflow Scheduler, select Enabled and specify the period. 
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➢ An asterisk (*) in each time field signifies workflow calculation on a minute-by-
minute basis. 

 Wait the specified workflow calculation period e.g. 1 minute. 

 Select the transformer instance and then select the Dashboard tab. 

 Select the Ranking Graph. 

➢ The Risk Index and status message display. 

 In the Asset Explorer, select the Ranking tab and rest the mouse pointer over a 

transformer. 

➢ A popup displays with the Risk Score. 

F.2 Offline risk workflow configuration 

The following data is required for offline oil quality: 

▪ Transformer voltage class 

▪ Standard for oil quality tests: IEC or IEEE 

▪ Oil type: inhibited or uninhibited 

The voltage class is configured using the ‘Rated Voltage Max. (kV)’ property. 

The IEC standard defines 4 classes as follows: 

▪ O (RV > 400 kV) 

▪ A (170 kV < RV <= 400 kV) 

▪ B (72.5 kV < RV <= 170 kV) and  

▪ C (RV <= 72.5 kV) 

The IEEE standard doesn't define literal values and differentiates classes as follows: 

▪ >=230kV 

▪ >69kV - <230kV 

▪ <=69kV 

F.2.1 IEC Oil Quality Configuration Parameters 

F.2.1.1 Fluid Color Index 

ISO 2049 & ASTM D1500 specifies a method for the visual determination of the colour of 

a variety of petroleum products. 

Name Color 

Type Float 

Units 0-8 

Standard ISO 2049 

F.2.1.2 Standardized Oil Appearance Remarks 

A method of visually inspecting the appearance of the oil and categorising it as either 

‘Dark’ or ‘Clear’. 
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Name Visual 

Type Text(30) 

Units - 

Standard - 

F.2.1.3 Dielectric Breakdown Voltage 

IEC 60156 specifies the method for determining the dielectric breakdown voltage of 

insulating liquids at power frequency. 

Name iec156 

Type float 

Units kV 

Standard IEC60156 

F.2.1.4 Moisture Concentration 

IEC 60814 describes methods for the determination of water in insulating liquids and in 

oil-impregnated cellulosic insulation with coulometrically generated Karl Fischer 

reagent. 

Name fq_water 

Type float 

Units ppm 

Standard IEC60814 

F.2.1.5 Acid Number (acidity) 

IEC 62021-1 & 2 describes the procedure for the determination of the acidity of unused 

and used electrical mineral insulating oils. 

Name acidnum 

Type float 

Units mg KOH/g 

Standard IEC 62021-1 

Or 

IEC 62021-2 

F.2.1.6 Fluid Dissipation Factor (tan delta) 

IEC 60247 describes methods for the determination of the dielectric dissipation factor 

(tan δ), relative permittivity and d.c. resistivity of any insulating liquid material at the test 

temperature. 
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Name tan_delta 

Type float 

Units % 

Standard IEC 60247 

F.2.1.7 Resistivity at 20 °C 

Describes methods for the determination of the dielectric dissipation factor (tan δ), 

relative permittivity and d.c. resistivity of any insulating liquid material at the test 

temperature of 20 °C. 

Name resistivity_20 

Type float 

Units Gohm-m 

Standard IEC 60247 

F.2.1.8 Resistivity at 90 °C 

Describes methods for the determination of the dielectric dissipation factor (tan δ), 

relative permittivity and d.c. resistivity of any insulating liquid material at the test 

temperature of 90 °C. 

Name resistivity 

Type float 

Units Gohm-m 

Standard IEC 60247 

F.2.1.9 Oxidation Inhibitor Concentration 

IEC 60666 specifies the concentration of the oxidation inhibitor for the detection and 

determination of specified additives in unused and used mineral insulating oils. 

Name inhibitor 

Type float 

Units % 

Standard IEC 60666 

An Inhibitor value can be added at any time. However, Perception doesn’t automatically 

update the initial concentration value — this must be done manually by the user via the 

Transformer Properties as shown in Figure F-3. 
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Figure F-3: Inhibitor Concentration 

An offline measurement of the inhibitor concentration should reveal a drop from the 

initial inhibitor concentration. The user should calculate the percentage drop and record 

this percentage value in the Inhibitor field of the CSV file. Perception calculates the risk 

for the inhibitor component based on the rate of change from the initial concentration. 

If the initial inhibitor concentration is unknown, the user can specify the volume and 

then click Default to generate a reference point value (based on 0.3% of the oil volume). 

F.2.1.10 Sediment and Sludge 

Annex C of IEC 60422 describes a test method for the determination of sediment and 

sludge. 

Name sludge 

Type float 

Units % 

Standard Annex C of IEC 60422 

F.2.1.11 Interfacial Tension (IFT) 

ASTM D971 describes the measurement of the interfacial tension between mineral oil 

and water, under non-equilibrium conditions. 

Name ift 

Type float 

Units mN/m 

Standard ASTM D971, EN 14210 

Note: Risk is calculated in different ways for inhibited and uninhibited oil. 

F.2.1.12 Total PCB Concentration 

IEC 61619 specifies a method for the determination of polychlorinated biphenyl (PCB) 

concentration in non-halogenated insulating liquids by high-resolution capillary column 

gas chromatography using an electron capture detector (ECD). 
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Name totalpcb 

Type float 

Units ppm 

Standard IEC 61619 

Note: This parameter is specified in ppm (mg/kg) and recorded in the CSV file. The 
default value is 50 and is compared to the Total PCB Limit transformer property 
as shown in Figure F-4. Excluding a value (or any value less than 50) means the 
parameter does not factor in risk calculations. 

 
Figure F-4: Total PCB concentration 

F.2.1.13 Corrosive Sulfur Test Result 

IEC 62535 specifies a test method for the detection of potentially corrosive sulfur in used 

and unused mineral insulating oil. 

Name d1275a, d1275b 

Type text(30) 

Units - 

Standard IEC 62535 

F.2.1.14 Passivator 

IEC 60666 specifies the detection and determination of additives in unused and used 

mineral insulating oils. Annex B specifically defines the analysis method for 

determination of passivators in mineral oils by high performance liquid chromatography 

(HPLC) 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 185 of 199 

Name passivator 

Type float 

Units ppm 

Standard IEC 60666-2010 annex B 

If a passivator is added to the oil, the Passivator value should be modified accordingly. 

However, Perception doesn’t automatically update the Passivator value — this must be 

manually performed by the user via the CSV file. 

F.2.1.15 Total Furans 

IEC 61198 specifies test methods for the analysis of 2-furfural and related furan 

compounds resulting from the degradation of cellulosic insulation and found in mineral 

insulating oil samples taken from electrical equipment. 

Name totalfuran 

Type float 

Units ppb 

Standard IEC 61198 

F.2.2 IEEE Oil Quality Configuration Parameters 

F.2.2.1 Fluid Color Index 

ASTM D1500 & ISO 2049 specifies a method for the visual determination of the colour of 

a variety of petroleum products. 

Name color 

Type float 

Units - 

Standard ASTM D 1500 

F.2.2.2 Dielectric Breakdown Voltage VDE electrode-1 mm and -2 mm 

ASTM D1816 specifies the method for determining the dielectric breakdown voltage of 

insulating liquids at power frequency for a 1 mm gap and 2 mm gap. 

Name d1816_1, d1816_2 

Type float 

Units kV 

Standard ASTM D1816 1 mm gap, ASTM D1816 2 mm gap 

F.2.2.3 Moisture Concentration 

ASTM D1533 specifies methods for the determination of water in insulating liquids and 

in oil-impregnated cellulosic insulation with coulometrically generated Karl Fischer 

reagent. 
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Name fq_water 

Type float 

Units ppm 

Standard ASTM D 1533 

F.2.2.4 Acid Number (acidity) 

Name acidnum 

Type float 

Units mg KOH/g 

Standard ASTM D 664, ASTM D974 

F.2.2.5 Fluid Power Factor at 25 °C 

Describes methods for the determination of the dielectric dissipation factor (tan δ), 

relative permittivity and d.c. resistivity of any insulating liquid material at the test 

temperature of 25 °C. 

Name pf25 

Type float 

Units % 

Standard ASTM D924 25C 

F.2.2.6 Fluid Power Factor at 100 °C 

Describes methods for the determination of the dielectric dissipation factor (tan δ), 

relative permittivity and d.c. resistivity of any insulating liquid material at the test 

temperature of 100 °C. 

Name pf100 

Type float 

Units % 

Standard ASTM D924 100C 

F.2.2.7 Oxidation Inhibitor Concentration 

ASTM D2668 & ASTM D4768 specify the determination of 2,6-ditertiary-butyl para-cresol 

and 2,6- ditertiary-butyl phenol in new and used insulating liquids at concentrations up 

to 0.5 %. 

Name inhibitor 

Type float 

Units % 

Standard ASTM D2668, ASTM D4768 

Note: The calculation is based on the value provided in the CSV file according to the 
risk index table. The ‘Initial inhibitor concentration’ field is not used in the IEEE 
standard. 
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F.2.2.8 Interfacial Tension (IFT) 

ASTM D 971 & ASTM D2285 specified a test method covering the measurement of the 

interfacial tension between mineral oil and water, under non-equilibrium conditions. 

Name ift 

Type float 

Units mN/m 

Standard ASTM D 971, ASTM D2285 

F.2.2.9 Total PCB Concentration 

ASTM D4059 specifies a method for the determination of polychlorinated biphenyl (PCB) 

concentration in non-halogenated insulating liquids by high resolution capillary column 

gas chromatography using an electron capture detector (ECD). 

Name totalpcb 

Type float 

Units ppm 

Standard ASTM D4059 

Note: The calculation is performed in the same way as the IEC standard. 

F.2.2.10 Corrosive Sulfur Test Result 

ASTM D1275 method A & DIN 51353 method B describes the detection of corrosive 

sulfur compounds (both inorganic and organic) in electrical insulating oils of petroleum 

origin. 

Name d1275a, d1275b 

Type text(30) 

Units - 

Standard ASTM D1275 method A, B DIN 51353 

F.2.2.11 Passivator 

ASTM D3487 specifies properties for new mineral insulating oil of petroleum origin for 

use as an insulating and cooling medium in new and existing power and distribution 

electrical apparatus. 

Name passivator 

Type float 

Units ppm 

Standard ASTM D3487 

Note: The calculation is performed in the same way as the IEC standard. 

F.2.2.12 Total Furans 

ASTM D5837 specifies test methods for the analysis of 2-furfural and related furan 

compounds resulting from the degradation of cellulosic insulation and found in mineral 

insulating oil samples taken from electrical equipment. 
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Name totalfuran 

Type float 

Units ppb 

Standard ASTM D5837 

F.2.3 DGA Configuration Parameters 

IEEE C57.104 specifies condition levels for absolute dissolved gas concentration in 

transformer insulation oil. 

Name h2 

Type float 

Units ppm 

Standard C57.104 

 

Name ch4 

Type float 

Units ppm 

Standard C57.104 

 

Name c2h6 

Type float 

Units ppm 

Standard C57.104 

 

Name c2h4 

Type float 

Units ppm 

Standard C57.104 

 

Name c2h2 

Type float 

Units ppm 

Standard C57.104 
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Name co 

Type float 

Units ppm 

Standard C57.104 

 

Name co2 

Type float 

Units ppm 

Standard C57.104 
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Appendix G MS 3000: HTTPS & Self-signed Certificates 

To download data from the MS 3000 to Perception (or access the MS 3000 web HMI) 

over the HTTPS protocol, use a Secure Sockets Layer (SSL) certificate (rather than the 

default self-signed certificate) to prevent certificate security warnings. For example, with 

Windows 7 follows these steps in Internet Explorer to access the MS 3000 over HTTPS. 

Open Internet Explorer and in the address bar specify the IP address of the MS 3000 

device. For example, type https://192.168.10.1 and press <Enter>. 

A Certificate Error message displays as shown in Figure G-1. This confirms there is a 

problem with the website’s security certificate. On this occasion only, click Continue to 

this website… to continue. 

 
Figure G-1: Certificate Error 

The MS 3000 login page displays. Click on the ‘Certificate error’ icon in the address bar to 

display the ‘Untrusted Certificate’ notice shown in Figure G-2. To view the available 

certificates, click the View certificates… link at the bottom of the message. 
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Figure G-2: MS 3000 Untrusted Certificate 

The Windows Certificate Information displays as shown in Figure G-3. Click Install 

Certificate… to install the certificate and enable trust. 

 
Figure G-3: Certificate Information 

The ‘Certificate Import Wizard’ displays as shown in Figure G-4. Select Place all 

certificates in the following store and click Browse to choose the certificate. In the 

‘Select Certificate Store’ dialog, select Trusted Root Certificate Authorities. 
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Figure G-4: Certificate Import Wizard – Certificate Store 

A confirmation message displays as shown in Figure G-5. Click OK to continue. 

 
Figure G-5: Certificate Import Wizard – confirmation 

Restart Internet Explorer and select Tools > Internet Options > Content as shown in 

Figure G-6. Then click Certificates. 
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Figure G-6: Internet Options 

In the ‘Certificates’ dialog box, select the Trusted Root Certification Authorities tab 

and select the certificate previously installed and click Export as shown in Figure G-7. 

 
Figure G-7: Certificates: Trusted Root Certification Authorities 

The ‘Certificate Export Wizard’ dialog box opens. Use the default settings and specify a 

valid path and filename to save the certificate and click Next as shown in Figure G-8. 
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Figure G-8: Certificate Export Wizard – Certificate file name 

The ‘Certificate Export Wizard’ completes with a confirmation message as shown in 

Figure G-9. 

 
Figure G-9: Certificate Export Wizard – confirmation 

From the Windows Taskbar, click Start > Run and type mmc.exe to launch the 

Microsoft Management Console as shown in Figure G-10. 

 
Figure G-10: MMC main screen 
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In the MMC, select File > Add/Remove Snap-in. From the Available snap-ins, select 

Certificates and click Add as shown in Figure G-11. 

 
Figure G-11: MMC Add Certificates 

In the ‘Certificates snap-in’ dialog box, select the Computer account option and click 

Next as shown in Figure G-12. 

 
Figure G-12: MMC Certificates snap-in 

In the ‘Select Computer’ dialog box, select the Local computer option and click Finish 

as shown in Figure G-13. 



MA-020 – Perception Desktop 2.2.1 – Installation & User Guide – Rev 8.0 22-Jul-20 Page 196 of 199 

 
Figure G-13: MMC Select Computer 

Click OK to close the ‘Add or Remove Snap-ins’ dialog box as shown in Figure G-14 and 

return to the MMC main screen. 

 
Figure G-14: MMC Certificates added 

In the MMC main screen, select Certificates (Local computer) > Trusted Root 

Certification Authorities as shown in Figure G-15. 
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Figure G-15: MMC main screen – Certificates (Local Computer) 

On the MMC main menu, select Action > All Tasks > Import to launch the ‘Certificate 

Import Wizard’ as shown in Figure G-16. Click Next. 

 
Figure G-16: Certificate Import Wizard 

Specify the certificate file name and path (as exported previously) as shown in Figure 

G-17. Use the default settings and click Finish to complete the ‘Certificate Import 

Wizard’. 
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Figure G-17: Certificate Import Wizard – Certificate file name 

The ‘Certificate Import Wizard’ completes with a confirmation message as shown in 

Figure G-18. 

 
Figure G-18: Certificate Import Wizard – confirmation 

This allows you to use the default self-signed certificate and prevents the certificate 

security warnings when accessing the MS 3000 device. 
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Contact & Copyright Details 

 

 

GE Grid Solutions (UK) Ltd 

Lissue Industrial Estate East 

Unit 1, 7 Lissue Walk, Lisburn, Co. Antrim 

Northern Ireland, United Kingdom BT28 2LU 

www.gegridsolutions.com/md.htm 

For further assistance or queries please contact: 

Customer Service Centre (24 hours a day, 365 days a year) 

T +44 1785-250-070 (United Kingdom) 

T 1-800-361-3652 (United States and Canada) 

T +1 514-420-7460 (worldwide) 

GA.support@ge.com 
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